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PHẦN I:     BẢNG ĐIỆN TỬ

Ngày soạn:10/08/2019
Ngày giảng:…/08/2019			
Tiết: 01

CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ ?

I. Mục tiêu.
	1. Kiến thức.
      - Biết nhu cầu sử dụng của chương trình bảng tính trong đời sống và 
     trong học tập.
	- Biết được thế nào là bảng tính và một số chức năng của chương trình 
    bảng tính.
  2. Kỹ năng.
     - Biết được thế nào là bảng tính và một số chức năng của chương trình 
     bảng tính.
             3. Thái độ.
                - Học sinh có thái độ nghiêm túc trong giờ học.
II. Chuẩn bị của giáo viên và học sinh.
  1. Chuẩn bị của giáo viên.
	       - Giáo án, SGK, máy tính…
  	2. Chuẩn bị của học sinh.
	       - Đồ dùng học tập, sách, vở.
III. Tiến trình dạy học
    	1. Ổn định tổ chức.
  2. Kiểm tra bài cũ.
 	  3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1. 

GV: Nêu mục đích của việc sử dụng bảng tính và giới thiệu sơ lược về chương trình bảng tính Excel mà HS sẽ được học.
GV: Em có thể cho thầy biết một số ví dụ về việc trình bày văn bản bằng bảng?
HS: Danh bạ điện thoại, địa chỉ, báo cáo kết quả học tập cá nhân…
GV: Nhận xét câu trả lời của học HS và tổng kết lại.
GV: Vậy ngoài việc trình bày thông tin trực quan, cô đọng, dễ so sánh, chúng ta còn có nhu cầu sử dụng bảng để thực hiện các công việc xử lý thông tin như tính toán, tổng hợp, thống kê số liệu.
GV: Nêu ra các ví dụ minh hoạ trong SGK.
GV: Em hãy quan sát vào ví dụ 1,và có thể cho thầy biết em nào có điểm trung bình cao nhất và em nào có điểm trung bình cao nhất.
HS: Phạm Như Anh có điểm trung bình cao nhất là 9,8.  Đoàn Mạnh Hiệp có điểm trung bình thấp nhất là: 7.0
GV: Nhận xét câu trả lời của học sinh và góp ý bổ sung nếu còn thiều hoặc chưa chính xác.
GV: Vậy ngoài cách trình bày dữ liệu dạng bảng chúng ta có thể trình bày dữ liệu dưới dạng nào khác hay không? Đó là dạng nào?
- Có, chúng ta có thể trình dữ liệu dưới dạng biểu đồ.
GV: Vậy em nào có thể cho thầy và các bạn biết tác dụng của việc trình bày dữ liệu bạng bảng?
-Trình bày bảng có những công dụng như:
- Cô đọng, dễ hiểu và dễ so sánh.
- Thực hiện tính toán linh hoạt và chính xác.
- Có thể tạo các biểu đồ từ các số liệu trên bảng tính để đánh giá một cách trực quan, nhanh chóng.

GV: Vậy bảng tính là gì?
 
GV: Vậy em nào có thể nêu khái niệm chương trinh bảng tính là gì?
 
 
	1. Bảng và nhu cầu xử lý thông tin dạng bảng.











































- Bảng tính là tập hợp các ô tạo ra do sự giao nhau của cột và hàng.

- Chương trình bảng tính là phần mềm được thiết kế để giúp ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ một cách trực quan các số liệu có trong bảng.

	Hoạt động 2.  
GV: Hiện nay có rất nhiều chương trình bảng tính khác nhau như: Quattropro Microsoft Office Excel, Assco,… tuy nhiên chúng đều có một số đặc điểm chung.

GV: Để làm việc thuận tiện với bảng tính ta phải  hiểu màn hình làm việc của bảng tính.
?Hãy nhớ lại và cho biết màn hình làm việc của cửa sổ Word gồm các thành phần chính nào?
 
GV: Giới thiệu cửa sổ làm việc của chương trình bảng tính Excel – HS quan sát
 HS so sánh với màn hình làm việc của cửa sổ Word.
?Hãy cho biết màn hình làm việc của bảng tính có những đặc trưng gì?
 - Có thanh bảng chọn, thanh công cụ, cửa sổ làm việc chính

?Hãy cho biết có những dạng dữ liệu nào được sử dụng trong chương trình bảng tính?
HS: Dạng số, dạng văn bản.
GV: Đưa ra một số dạng dữ liệu – HS quan sát
?Hãy cho ví dụ về dạng số?
 Điểm kiểm tra, số liệu, số điện thoại…

?Hãy cho ví dụ về dạng văn bản?
Họ tên, bài thơ, bài hát, bài văn, thứ ngày,…

GV: Thực hiện một số thao tác  ví dụ: Tính điểm trung bình, thực hiện tính toán với số liệu lớn,…
HS: Quan sát
?Qua tìm hiểu về bảng tính em nào cho biết chương trình bảng tính có những khả năng nào?
 

GV: Chương trình bảng tính có khả năng tính toán tự động, tìm kiếm, sắp xếp, cập nhật tự động.

GV: Thực hiện một số thao tác lọc ra số học sinh giỏi có trong danh sách, sắp xếp danh sách theo điểm môn toán  giảm dần,…
 
GV: Chiếu lại bảng thống kê ở ví dụ 3 SGK trang 4
 
?Hãy cho biết làm thế nào để so sánh được tỉ lệ loại đất?
 Ta có thể sử dụng biểu đồ để so sánh.
? Tìm hiểu thực tế hãy cho biết biểu đồ có những dạng nào?
 Dạng cột, dạng vành khuyên,…
	2. Chương trình bảng tính.











a. Màn hình làm việc:
  - Các bảng chọn
  - Các nút lệnh thường dùng
  - Cửa sổ làm việc chính








b. Dữ liệu:
  - Gồm hai dạng dữ liệu cơ bản đó là: Dạng số, dạng văn bản.










 c. Khả năng tính toán và sử dụng
hàm có sẵn:
 - Khả năng thực hiện nhiều công việc tính toán từ đơn giản đến phức tạp.
 - Sử dụng hàm để tính toán rất thuận tiện.


d. Sắp xếp và lọc dữ liệu:













e. Tạo biểu đồ:

 


   	4. Củng cố.
	    - Yêu cầu HS tóm tắt lại nội dung bài học.
          5. Hướng dẫn học sinh học ở nhà.
	    - Về nhà làm bài tập 1, 2 SGK trang 9.
	    - Xem trước nội dung phần 3, 4 SGK trang 7, 8 để tiết sau học.
     	IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................


















Ngày soạn:  10/08/2019
Ngày giảng:…/08/2019			
Tiết: 02

 CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ ?

	I. Mục tiêu.
	1. Kiến thức.
   		- Biết được các thành phần chính của màn hình làm việc của Excel.
- Thực hiện được các thao tác nhập và sửa dữ liệu, di chuyển trên trang tính và  cách gõ chữ việt trên trang tính.
   2. Kỹ năng.
        - Thực hiện được các thao tác nhập và sửa dữ liệu, di chuyển trên 
	trang tính và cách gõ chữ việt trên trang tính.
   3. Thái độ.
       - Học sinh có thái độ nghiêm túc trong giờ học.
II. Chuẩn bị của giáo viên và học sinh.
    	  1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
    	  2. Chuẩn bị của học sinh.
	      - Đồ dùng học tập, sách, vở.
III. Tiến trình dạy học
   	  1. Ổn định tổ chức.
    	  2. Kiểm tra bài cũ.
     	  3. Bài mới.
		Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1. 

Để thực hiện công việc được trong bảng tính thì ta phải biết và hiểu rõ màn hình làm việc của chương trình bảng tính.
 
GV: Khởi động phần mềm bảng tính Excel
HS: Quan sát
?Hãy mô tả màn hình làm việc của bảng tính?
 
[image: ]Ô giao nhau giữa tên cột và tên hàng

 
 GV: Giới thiệu để học sinh rõ vùng soạn thảo của chương trình được gọi là “trang tính” gồm có cột. hàng, ô dùng cho công việc nhập dữ liệu, chỉnh sửa, tính toán dữ liệu.
GV: Hướng dẫn để HS phân biệt được cột có tiêu đề cột dòng có tiêu đề dòng  - HS: Quan sát

?Cho biết cột được đánh số tự như thế nào?

- Cột được đánh số thứ tự theo các chữ cái A, B, C, D,…, 

?Hàng được đánh số thứ tự như thế nào?
- Hàng được đánh số thứ tự là các chữ số 1, 2, 3, 4



GV: Hướng dẫn rõ đâu là ô tính (là vùng giao nhau giữa cột và hàng)
Ví dụ: ô A2 có nghĩa là ô nằm ở cột A hàng 2
HS: Quan sát.


?Nêu cách chọn khối ô ở Word? – HS: Trả lời
GV: Ở trang tính cách chọn khối ô cũng tương tự như vậy.
?Gọi hai em lên chọn khối ô – HS thao tác

GV: Các em đã được làm quen với màn hình làm việc của trang tính. Vậy cách nhập dữ liệu và sửa dữ liệu như thế nào? 
	3. Màn hình làm việc của 
 chương trình bảng tính.

- Thanh công thức: Được sử dụng để nhập, hiện thị dữ liệu hoặc công thức trong ô tính.

- Bảng chọn Data (Dữ liệu): Gồm các lệnh dùng để xử lý dữ liệu.












- Trang tính: là miền làm việc chính của bảng tính gồm có các cột, các hàng và các ô tính.

- Ô tính: Là vùng giao nhau giữa cột và hàng, dùng để chứa dữ liệu.


 + Tên cột được đánh số thứ tự A, B, C,…

  + Tên hàng được đánh số thứ tự là các chữ số 1, 2, 3, 4, …



  + Ô được đánh số tên cột trước hàng sau.
  Ví dụ: A5, B2, C9



  + Khối ô là tập hợp các ô tính liện kề nhau.

	Hoạt động 2.

Nhập dữ liệu ở trang tính khác với nhập dữ liệu ở Word vì muốn nhập dữ liệu vào ô nào ta phải chọn ô đó (kích hoạt ô đó) và dữ liệu sẽ được lưu ở ô tính đó còn các ô khác không nhập dữ liệu thì sẽ không có dữ liệu .
GV: Thao tác mẫu – HS quan sát

Gọi hai HS thao tác – HS thao tác.



GV: Thao tác mẫu cách sửa dữ liệu trên trang tính– HS quan sát.





Gọi hai HS thao tác – HS thao tác.





?Cho biết các cách di chuyển con trỏ đến các ô trong bảng ở Word? – HS trả lời
GV: Để di chuyển con trỏ đến các ô tính cũng tương tự như di chuyển con trỏ trong bảng ở Word.










GV: Thao tác mẫu – HS quan sát
Gọi hai em thao tác – HS thao tác


?Hãy cho biết cách chọn để gõ tiếng Việt mà em biết?
 
GV: Để gõ được chữ việt trên trang tính cách làm tương tự như ở Word

?Gọi 1 HS khởi động phần mềm Vietkey – HS thao tác

GV: Thao tác mẫu – HS quan sát
Gọi hai em thao tác lại
	4. Nhập dữ liệu vào trang tính.
   a.  Nhập và sửa dữ liệu:




 * Nhập dữ liệu:
 B1) Nháy chuột chọn ô cần nhập dữ liệu
B2) Gõ dữ liệu từ bàn phím.
B3) Gõ phím Enter để kết thúc nhập dữ liệu. 
* Sửa dữ liệu:
- C1. Nháy đúp chuột vào ô cần sửa → sửa → gõ phím Enter để kết thúc
- C2. Nháy chọn ô cần sửa → gõ F5 →  Sửa →  gõ phím Enter để kết thức
- C3. Nháy chọn ô cần sửa →  nháy chuột vào thanh công thức →  sửa →  gõ phím Enter để kết thúc.

 b. Di chuyển trên trang tính:
	Phím
	Chức năng

	- Con chuột
	- Nháy chuột vào ô cần đến.

	- →, , , 
	- Sang phải 1 ô, sang trái 1 ô, lên 1 ô, xuống 1 ô

	- Home
	- Về ô đầu tiên của hàng

	- End + 
	- Về hàng 1 của trang tính

	- End + 
	- Về hàng
cuối của trang tính

	Gõ địa chỉ ô vào hộp tên
	- Đến ô bất kì



c. Gõ chữ việt trên trang tính:
 - Sử dụng phần mềm Vietkey hoặc Unikey
* Chú ý:  Trước khi chọn phông tiếng việt cần chọn cả trang tính bằng cách nháy chuột vào ô giao nhau giữa tên cột và tên hàng ở góc trên bên trái


     	4. Củng cố. 
		Câu 1: Phân biệt bảng tính, trang tính, trang màn hình? 
		- Bảng tính: Là phần mềm dùng để tính toán, là tệp tin(File).
- Trang tính: Là vùng soạn thảo chính gọi là sheet gồm có cột, hàng, ô.Một bảng tính gồm có nhiều trang tính.
		- Trang màn hình: Là vùng soạn thao mà ta nhìn thấy ở màn hình 
                    làm việc.
Câu 5 (SGK trang 9)
Ô tính đang được kích hoạt có đường viền đen bao quanh, các nút 
tiêu đề cột, hàng hiện thị màu vàng, địa chỉ ô tính được hiển thị ở 
hộp tên.
   5. Hướng dẫn học ở nhà.
		- Về nhà xem lại toàn bộ nội dung bài học.
		- Xem trước nội dung bài thực hành 1 để tiết sau thực hành.
		- Làm các bài tập còn lại ở SGK trang 9.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
  Kiểm tra, ngày …. tháng ….. năm 201…
			Tổ trưởng 
		     



      


















Ngày soạn:  15/08/2019
Ngày giảng:.../…./2019
Tiết: 03

BÀI THỰC HÀNH 1: 
LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL


I. Mục tiêu.
1. Kiến thức.
· Biết cách khởi động và kết thúc Excel.
· Nhận biết được các ô, hàng, cột, thanh công thức trên trang tính.
· Biết cách di chuyển con trỏ chuột trên trang tính.
· Biết cách chọn khối ô.
· Biết cách di chuyển đến từng trang tính.
2. Kỹ năng.
· Biết cách di chuyển con trỏ chuột trên trang tính.
· Biết cách chọn khối ô.
· Biết cách di chuyển đến từng trang tính.
3. Thái độ.
     - Có thái độ tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
   - Giáo án, SGK, máy tính…
2. Chuẩn bị của học sinh.
    - Đồ dùng học tập, SGK.
III. Tiến trình dạy học
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
     Câu 1: Em hãy nêu cách di chuyển giữa các ô trên trang tính?
     Câu 2: Em hãy cho biết ô tính đang được kích hoạt có gì khác biệt nhau với các ô tính khác?
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Giới thiệu mục đích và yêu cầu bài thực hành.
GV: Nêu mục đích của bài thực hành.
HS: Tập trung nghe giảng


	1. Mục đích, yêu cầu. (SGK)

	Hoạt động 2: Nội dung.

GV: Hướng dẫn HS cách khởi động Excel. Thao tác mẫu trên máy.
( Start -> All Program -> Microsoft Excel) Hoặc nháy đúp chuột vào biểu tượng Excel trên màn hình nền.
HS: Tập trung chú ý quan sát.

GV: Hướng dẫn HS cách  lưu kết quả và thoát khỏi Excel.
- Để lưu kết quả làm việc, chọn File -> Save. Hoặc nháy nút lệnh Save [image: ] trên thanh công cụ.Sau đó chọn đường dẫn để lưu tệp tin, gõ tên tệp vào khung File Name và chọn Save.
- Để thoát khỏi Excel, chọn File -> Exit. Hoặc nháy nút  [image: ] trên thanh tiêu đề.
Thực hành mẫu trên máy tính – HS quan sát.
- Gọi 1- 2 HS lên thực hiện thao tác khởi động và thoát khỏi Excel.

GV: Nêu ra bài tập 1.
- Liệt kê các điểm giống và khác nhau giữa màn hình Word và Excel?


- Mở các bảng chọn và quan sát các lệnh trong các bảng chọn đó.
- Kích hoạt một ô tính và thực hiện di chuyển trên trang tính bằng chuột và bằng bàn phím. Quan sát sự thay đổi các nút tên hàng và tên cột
HS: Tham gia trả lời các câu hỏi bài tập 1.
	2. Nội dung.
a. Khởi động. (SGK)






b. Lưu kết quả và thoát khỏi Excel.














Bài tập 1:
· Điểm giống: Các bảng chọn, thanh công cụ và các nút lệnh.
· Điểm khác: Thanh công thức, bảng chọn Data, trang tính.


- Kích hoạt một ô tính thì ô tính đó có viền đậm xung quanh, nút tên hàng và tên cột của ô đang được kích hoạt có màu khác so với các ô tính không được kích hoạt.


4. Củng cố.
       	     - Gọi 1 – 2 HS lên thực hành lại bài thực hành.
      	     - Đánh giá và nhận xét tiết thực hành.
5. Hướng dẫn học sinh học ở nhà. 
   	     - Yêu cầu HS về nhà thực hành lại nội dung bài thực hành.
    - Xem trước nội dung bài tập 2, 3 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Ngày soạn: 15/08/2019
Ngày giảng:…/…../2019
Tiết: 4 

BÀI THỰC HÀNH 1: 
LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL

I. Mục tiêu.
1. Kiến thức.
- Biết cách khởi động và kết thúc Excel.
- Nhận biết được các ô, hàng, cột, thanh công thức trên trang tính.
- Biết cách di chuyển con trỏ chuột trên trang tính.
- Biết cách chọn khối ô.
- Biết cách di chuyển đến từng trang tính.
2. Kỹ năng.
- Biết cách di chuyển con trỏ chuột trên trang tính.
- Biết cách chọn khối ô.
- Biết cách di chuyển đến từng trang tính.
3. Thái độ.
     -  Có thái độ tích cực trong giờ thực hành.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK, máy tính…
2. Chuẩn bị của học sinh.
    - Đồ dùng học tập, SGK.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
     Câu 1: Em hãy thực hiện thao tác nhập dữ liệu trên trang tính?
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Thực hành (38  phút)

GV: Hướng dẫn HS thực hành bài tập 2. Chỉ ra những sai sót và khắc phục những vấn đề mà HS gặp phải.
HS: Thực hành bài tập 2.
B1) Chọn phông tiếng việt
B2) Nháy chuột vào ô giao nhau giữa tên cột và tên hàng để chọn cả trang tính.
B3) Chọn phông tiếng việt: Nháy chọn nút lệnh Font → chọn phông tương ứng với bảng mã.
B4) Nhập dữ liệu cho ô tính
- Thực hiện các thao tác.
 + Nhập dữ liệu vào một ô trên trang 
  tính, sử dụng Enter để kết thúc.
+ Sử dụng các phím múi tên để nhập dữ 
 liệu và di chuyển giữa các ô trên trang 
 tính.
+ Chọn 1 ô có dữ liệu và gõ phím Delete (VD: ô A3)
   + Chọn 1 ô khác có dữ liệu và gõ nội dung mới. (VD: ô B5)
· Nhận xét:
  + Ô A3 dữ liệu được xóa  sạch
   + Ô B5: dữ liệu cũ cũng bị xóa sạch và được thay thế bằng dữ liệu mới vừa nhập vào.

GV: Yêu cầu HS thực hành bài tập 3 theo SGK trang 11.



HS: Thực hành bài tập 3.
GV: quan sát HS thực hành và hướng dẫn HS thực hành đúng và sửa sai (nếu có).
	2. Nội dung.
Bài tập 2:
· Nhập dữ liệu vào một ô trên trang tính, sử dụng Enter để kết thúc.
· Sử dụng các phím múi tên để nhập dữ liệu và di chuyển giữa các ô trên trang tính.
· Chọn ô có dữ liệu và gõ phím Delete để xoá.
· Chọn ô khác có dữ liệu và gõ nội dung mới, cho nhận xet về các kết quả.
· Thoát khỏi Excel.















Bài tâp 3: 
· Nhập dữ liệu số thứ tự, họ và tên theo SGK.
· Tập chỉnh sửa Họ và tên.
· Tập di chuyển trên các ô trên trang tính.
· Lưu bảng tính vừa chỉnh sửa vào máy.
     -    Thoát khỏi Excel.


4. Củng cố. 
       	     - Gọi 1 – 2 HS lên thực hành lại bài thực hành.
      	     - Đánh giá và nhận xét tiết thực hành.
5. Hướng dẫn học sinh học ở nhà.
   	     - Yêu cầu HS về nhà thực hành lại nội dung bài thực hành.
    - Về nhà đọc bài đọc thêm “Chuyện cổ tích về Visicalc”.
    - Chuẩn bị bài 2: “ Các thành phần chính và dữ liệu trên trang tính” 
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
 Kiểm tra, ngày …. tháng …. năm 201..
						               Tổ trưởng



							

Ngày soạn: 21/08/2019
Ngày giảng:…./08/2019				
Tiết: 05

CÁC THÀNH PHẦN CHÍNH VÀ DỮ LIỆU 
TRÊN TRANG TÍNH

 	I. Mục tiêu.
	1. Kiến thức.
- Biết được bảng tính gồm nhiều trang tính và cách kích hoạt trang tính 
	trên bảng tính.
- Biết các thành phần chính trên trang tính gồm: Hộp tên, khối, hàng,
cột, ô, thanh công thức, địa chỉ ô.
	2. Kỹ năng.
	       - Biết được bảng tính gồm nhiều trang tính và cách kích hoạt trang 
		tính trên bảng tính.
- Biết các thành phần chính trên trang tính gồm: Hộp tên, khối, hàng,
cột, ô, thanh công thức, địa chỉ ô.
	3. Thái độ.
 	         - Tích cực tham gia xây dựng bài.
	II. Chuẩn bị của giáo viên và học sinh.
    	  1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
     	2. Chuẩn bị của học sinh.
	      - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
   	  1. Ổn định tổ chức. 
	  2. Kiểm tra bài cũ. 
		Câu 1: 
- Khởi động Excel và gõ dữ liệu sau vào ô tính B5 “ Hôm nay 
		em được điểm 10” sau đó sửa lại với nội dung sau “Lớp em được đi 
		chơi”.
		- Lưu tên tệp tin vừa tạo theo đường dẫn “D:\lop 7\bai2”.
   	  	3. Bài mới.
· Để làm việc thuận tiện với Excel ta cần phải hiểu rõ và nắm vững 
các thành phần của bảng tính. Vậy các thành phần chính của bảng tính là gì? Để hiểu rõ vấn đề này ta tìm hiểu bài mới. “Các thành phần chính và dữ liệu trên trang tính”.

	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Tìm hiểu bảng tính. 


GV: Bảng tính điện tử lâu nay ta vẫn gọi là phần mềm Excel gồm ba trang tính ngầm định (Sheets1, Sheets2, Sheets3)
?Nhìn ở đâu ta thấy được Sheets1, ..?

 Nhìn ở cuối màn hình

GV: Mở cửa sổ Excel giới thiệu cho HS rõ bảng tính chính là một cửa sổ để ta làm việc nó gồm nhiều cột, hàng, ô.

?Hãy cho biết bảng tính có những đặc trưng nào?
- Có thanh công thức và bảng chọn Data

?Thế nào là bảng tính? 


GV: Thao tác chuyển đổi giữa trang tính này với trang tính khác – HS quan sát.
?Nhìn vào màn hình hãy cho biết hiện tại trang tính nào đang được kích hoạt? Vì sao em biết?
HS: Nhìn vào tên nhãn có màu trắng và chữ đậm
?Ta có thể đổi tên nhãn được không?
HS: Ta có thể đổi tên nhãn như đổi tên tệp.


GV: Di chuyển thanh cuộn cho học sinh quan sát trang tính để thấy rõ một trang tính có thể có nhiều trang màn hình – HS quan sát.

Gọi hai em lên thao tác kích hoạt trang tính – HS thao tác.
GV: Mở thêm khoảng 5 trang tính – HS quan sát
?Hiện tại bảng tính có mấy trang tính?
HS: Hiện tại bảng tính có 5 trang tính

	1. Bảng tính.

 














 - Bảng tính là một tệp tin gồm có nhiều trang tính, mỗi trang được phân biệt bởi tên nhãn.



 

Đổi tên nhãn: Nháy phải chuột tại tên nhãn cần đổi → chọn Rename → gõ tên mới → Gõ phím Enter.


  + Mỗi trang tính có thể có nhiều trang màn hình.

	Hoạt động 2: Các thành phần chính trên  trang tính.

  Trao đổi theo cặp bằng cách quan sát hình ảnh ở SGK kết hợp với bài mẫu trên máy tính.

?Hãy cho biết trang tính có những thành phần nào giống cửa sổ Word. – HS trả lời

?Hãy cho biết em nhìn thấy những gì trên trang tính?
 
GV: Ở bài trước các em đã biết được trang tính có ô, cột, hàng, bây giờ các em sẽ được tìm hiểu thêm một số thành phần cơ bản khác như hộp tên, khối, thanh công thức, tên cột, tên hàng – HS quan sát.
GV: Thao tác nháy chọn một ô tính – HS quan sát
?Hãy cho biết ô đang được kích hoạt nằm ở vị trí nào? Nhìn vào đâu để biết được? 
HS:  Trả lời nhìn vào hộp tên để biết địa chỉ ô đang được kích hoạt.
?Hãy chỉ ra đâu là hộp tên – HS lên máy chỉ ra

GV: Chỉ lại đâu là hộp tên để cả lớp quan sát lại – HS quan sát.
Gọi hai em lên (tùy ý nháy chọn ô) cho biết ô tính nào đang được kích hoạt?
HS: Thao tác và trả lời
?Các em đã học ở Word về khối ô hãy cho biết thế nào là 1 khối ô? – HS trả lời
GV: Ở trang tính khối cũng là một hình chữ nhật được chọn có màu đen


?Hãy cho biết các cách chọn khối? – HS trả lời
GV: Nháy chọn một ô, một hàng, một cột, một khối ô,…
?Đó có phải là các khối không?
HS: Đó chính là các khối vừa được chọn
?Vậy khối có thể là? – HS trả lời

* Gọi 1 - 2 em lên thao tác chọn khối 


? Ngoài các đặc trưng trên trang tính còn có đặc trưng gì? – HS: Thanh công thức
GV: Gõ dữ liệu để học sinh quan sát trên thanh công thức.
?Thanh công thức có vai trò đặc biệt gì?  
	
2. Các thành phần chính trên trang tính.










 
- Hộp tên: Hiện thị địa chỉ ô được kích hoạt.













 Khối: - Là một nhóm các ô được chọn liền kề tạo thành hình chữ nhật, có màu đen.


- Cách chọn khối:
  C1) Di chuyển chuột để chọn.
  C2) Nháy chọn ô đầu + giữ phím   Shift + nháy chọn ô cuối cần chọn
   C3) Nháy vào tên cột, tên hàng cần chọn .
- Khối có thể là: 
      + 1 ô
      + 1 hàng, 1 cột
      + 1 phần hàng, cột (nhiều ô liền kề)
 




- Thanh công thức:
- Vai trò đặc bịêt của thanh công thức dùng để nhập, hiển thị dữ liệu và công thức, sửa nội dung trong ô tính


4. Củng cố. 
	       - Yêu cầu học sinh tóm tắt lại kiến thức của bài học.
- Phận biệt rõ bảng tính, trang tính và các thành phần trên trang tinh như  hộp tên, khối, thanh công thức.
             5. Hướng dẫn học sinh học ở nhà.
	    - Về nhà xem lại toàn bộ nội dung bài học.
	    - Làm các bài tập 1, 2, 3 ở SGK trang 18.
	    - Xem trước nội dung phần 23 và 4 để tiết sau học.
IV. Rút  kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………


























Ngày soạn: 21/08/2019
Ngày giảng:…/08/2019
Tiết: 06

CÁC THÀNH PHẦN CHÍNH VÀ DỮ LIỆU 
TRÊN TRANG TÍNH
 

I. Mục tiêu.
	1. Kiến thức.
    - Biết được cách chọn ô, chọn hàng, chọn khối, chọn cột trên bảng tính.
               - Phân biệt được kiểu dữ liệu số, kiểu dữ liệu kí tự.
		2. Kỹ năng.
    	     - Biết được cách chọn ô, chọn hàng, chọn khối, chọn cột trên bảng 
                tính.
                - Phân biệt được kiểu dữ liệu số, kiểu dữ liệu kí tự.
		3. Thái độ.
		    - Tích cực tham gia xây dựng bài.
	II. Chuẩn bị của giáo viên và học sinh.
            1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
            2. Chuẩn bị của học sinh.
	     - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học
 	 1. Ổn định tổ chức.
           2. Kiểm tra bài cũ. 
                 Câu 1: Hãy chỉ rõ đâu là bảng tính, trang tính.
 	       Câu 2: Hãy cho biết chức năng của hộp tên và vai trò của thanh công 
		thức.
	       Câu 3: Hãy chỉ tên nhãn trang tính và đổi tên nhãn trang tính thành 
		“bai2”.
           3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Tìm hiểu cách chọn các đối tượng trên trang tính. 

Để thao tác được trên trang tính ta phải kích hoạt đối tượng (thao tác chọn).
?Hãy nêu cách chọn khối ở chương trình bảng tính? 

GV: Thao tác chọn ở trang tính cũng như thế. 
?Gọi 1 - 2 em học sinh lên thao tác.
?Hãy cho biết các đối tượng trên trang tính?
- Các đối tượng gồm: ô, hàng, cột.



Gọi 1 - 2 em học sinh thao tác.
GV: Chiếu một bảng dữ liệu  bao gồm có chữ cái, chữ số, kiểu ngày.
 
	3.  Chọn  các đối tượng trên trang tính.




- Chọn 1 ô: Nháy chuột vào ô cần chọn.
- Chọn 1 hàng: Nháy chuột vào nút tên hàng.
- Chọn 1 cột: Nháy chuột vào nút tên cột.
- Chọn 1 trang tính: Nháy chuột vào nút tên nhãn 
- Chọn 1 khối:  Di chuyển chuột để chọn.

	Hoạt động 2: Dữ liệu trên trang tính

?Hãy cho biết có những kiểu dữ liệu nào?
  Dữ liệu gồm có kiểu: số, kí tự

GV: Các em đã học ở Word có các loại dữ liệu chữ cái, chữ số, các kí hiệu đặc biệt, âm thanh, hình ảnh. Thì ở bảng tính cũng vậy.

Ví dụ: 157, -35, +10, 45%, 12,5
 Gọi 1 HS lên nhập dữ liệu vào ô tính – HS nhập dữ liệu
	
	A
	B
	C

	1
	157
	-85
	+10

	2
	35%
	15.8
	Đi

	3
	20/10/2011
	Học
	


?Hãy quan sát và cho biết dữ liệu số nằm ở vị trí nào?
- Dữ liệu kiểu số nằm căn thẳng lề phải.

?Hãy cho biết dữ liệu kí tự gồm có những ký tự nào?

GV: Chiếu 1 trang màn hình về kiểu dữ liệu kí tự
VD: Hôm nay, lớp 7A đi học môn tin thời gian 8h 30’
?Hãy nhận xét dữ liệu kiểu kí tự nằm ở vị trí nào trong ô?
* Gọi hai em lên nhập dữ liệu (Dữ liệu tùy ý) 
	4.  Dữ liệu trên trang tính:


 a) Dữ liệu số:
- Là các số từ:  0→9,  tỉ lệ phần trăm (%)





- Kiểu số được ngầm định căn thẳng lề phải trong ô tính.


 b) Dữ liệu kí tự:
 - Là dãy các chữ cái từ A → Z, a  → z.
 - Các chữ số từ 0  →  9
 - Các kí hiệu: . , ? \ / ? * > < } ], 


- Dữ liệu kí tự được ngầm định căn thẳng lề trái trong ô tính.






Bài tập.
	Câu 2: SGK trang 18.
 Thanh công thức của Excel có vai trò đặc biệt. Vai trò đó là gì?    
Trả lời
· Vai trò đặc biệt của thanh công thức là dùng để nhập dữ liệu, hiển thị công thức và sửa nội dung của ô tính.
	Câu 3: SGK trang 18. 
Biết rằng trên trang tính chỉ có một ô được kích hoạt. Giả sử ta chọn một khối. Ô tính nào được kích hoạt trong các ô của khối đó.
Trả lời:
· Trong o khối được chọn ô nào có nền màu trắng là được kích hoạt (có thể là 1 trong 4 ô ở 4 góc của khối được chọn), nghĩa là ô được chọn đầu tiên của khối.
Câu 5: SGK trang 18.
	Nhìn vào trang tính, ta có thể biết các ô chứa dữ liệu kiểu gì không, 
	nếu như sau 	khi nhập dữ liệu không thực hiện bất kì thao tác nào 
	khác?
Trả lời:
· Nhìn vào trang tính ta có thể nhận biết được các ô  chứa dữ liệu kiểu gì, nếu ta chưa định dạng vì các kiểu dữ liệu đã được ngầm định trong ô.
 4. Củng cố. 
		- Yêu cầu học sinh tóm tắt lại kiến thức của bài học.
- Phận biệt rõ được cá kiểu dữ liệu sử dụng trên trang tính.  thanh công thức.
    	   5. Hướng dẫn học sinh học ở nhà.
		- Về nhà xem lại toàn bộ nội dung bài học.
		- Xem trước nội dung bài thực hành 2: “Làm quen với các kiểu dữ 
		liệu trên trang tính” để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………					       Kiểm tra, ngày …. tháng ….. năm 201..
	 Tổ chuyên môn




	





Ngày soạn: 06/09/2019
Ngày giảng: …/09/2019			
Tiết: 07

BÀI THỰC HÀNH 2: 
LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH
 

I. Mục tiêu.
1. Kiến thức.
- Phân biệt được bảng tính, trang tính và các thành phần chính của trang tính
- Biết cách mở và lưu bảng tính trên trang tính.
- Biết cách chọn các đối tượng trên trang tính.
- Phân biệt và nhập các kiểu dữ liệu khác vào ô tính.
2. Kỹ năng.
- Biết cách mở và lưu bảng tính trên trang tính.
- Biết cách chọn các đối tượng trên trang tính.
- Phân biệt và nhập các kiểu dữ liệu khác vào ô tính.
3. Thái độ.
     - Có thái độ nghiêm túc trong giờ thực hành.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
   - Giáo án, SGK, máy tính…
2. Chuẩn bị của học sinh.
    - Đồ dùng học tập, SGK.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
    - Kết hợp xen kẽ trong giờ thực hành.
 3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Giới thiệu mục đích và yêu cầu bài thực hành. 

GV: Nêu mục đích của bài thực hành.
 
	1. Mục đích, yêu cầu. (SGK)

	Hoạt động 2: Nội dung.
GV: Hướng dẫn HS cách mở bảng tính. Thao tác mẫu trên máy.
 

GV: Hướng dẫn HS cách  lưu bảng tính với một tên khác.
- Để lưu kết quả làm việc với một tên khác,bằng cách dùng lệnh  File -> Save As. Sau đó chọn đường dẫn để lưu tệp tin, gõ tên tệp vào khung File Name và chọn Save.
GV: Thực hành mẫu trên máy tính – HS quan sát.
- Gọi 1- 2 HS lên thực hiện thao tác.

GV: Nêu ra bài tập 1.

Bài tập 1. Tìm hiểu các thành phần               
                  chính của trang tính.

- Em hãy nhận biết các thành phần chính trên trang tính: ô, hàng, cột, hộp tên, thanh công thức?
HS: Nhận biết các ô, hàng, cột, tên hộp...

- Nháy chuột để kích hoạt các ô khác nhau và quan sát sự thay đổi nội dung trong hộp tên.
- Nhập dữ liệu tuỳ ý vào các ô và quan sát sự thay đổi nội dung trên thanh công thức. So sánh nội dung dữ liệu trong ô và trên thanh công thức.
- Gõ = 5+7 vào một ô tuỳ ý và nhấn phím Enter. Chọn lại ô đó và so sánh nội dung dữ liệu trong ô và trên thanh công thức.
HS: Thực hành.

Bài tập 2: Chọn các đối tượng trên                  
                   trang tính.
- Thực hiện các thao tác chọn một ô, một cột, một hàng và một khối trên trang tính. Quan sát sự  thay đổi nội dung của hộp tên trong quá trình chọn.
- Giả sử cần chọn cả ba cột A, B và C. Khi đó em cần thực hiện thao tác gì? Hãy thực hiện thao tác đó và nhận xét.






- Nháy chuột ở hộp tên và nhập dãy B100 vào hộp tên, cuối cùng nhấn phím Enter. Cho nhận xét về kết quả nhận được. Tương tự, nhập các dãy sau vào hộp tên (nhấn phím Enter sau mỗi lần nhập) A:A,   A:C,   2:2,    2:4,   B2:D6. Quan sát kết quả nhận được và cho nhận xét.
	2. Nội dung.
a. Mở bảng tính. (SGK)





b. Lưu bảng tính với một tên khác. 








Bài tập 1: Tìm hiểu các thành phần chính của trang tính. 





- Hộp tên hiển thị tên ô tính đang được kích hoạt.





- Nội dung trong ô công thức = 5+7, trong ô tính là:12





Bài tập 2: Chọn các đối tượng trên trang tính. 

- Chọn nhiều khối ô không liền kề: Chọn khối đầu  + Ctrl + lần lượt chọn các khối tiếp theo.
* Nhận xét: Khi chọn các đối tượng khác nhau không liền kề, ta giữ phím Ctrl kết hợp lần lượt chọn thì các đối tượng đó đều được chọn, còn nếu không giữ phím Ctrl thì chỉ khối ô vừa được chọn là được chọn.

-Ô B100 được chọn

Cột A được chọn; Cột A,B,C được chọn; Hàng 2 được chọn; Hàng 2,3,4 được chọn; Khối B2:D6 được chọn.



4. Củng cố.
       	    - Gọi 1 – 2 HS lên thực hành lại bài thực hành.
      	     - Đánh giá và nhận xét tiết thực hành.
5. Hướng dẫn học sinh học ở nhà. 
   	     - Yêu cầu HS về nhà thực hành lại nội dung bài thực hành.
    - Xem trước nội dung bài tập 3, 4 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………..…………………………………………………………………………………………………………………………………………………




Ngày soạn: 06/09/2019
Ngày giảng: …/09/2019
Tiết: 08


BÀI THỰC HÀNH 2: 
LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH

I. Mục tiêu.
1. Kiến thức.
- Phân biệt được bảng tính, trang tính và các thành phần chính của trang tính
- Biết cách mở và lưu bảng tính trên trang tính.
- Biết cách chọn các đối tượng trên trang tính.
- Phân biệt và nhập các kiểu dữ liệu khác vào ô tính.
2. Kỹ năng.
- Biết cách mở và lưu bảng tính trên trang tính.
- Biết cách chọn các đối tượng trên trang tính.
- Phân biệt và nhập các kiểu dữ liệu khác vào ô tính.
3. Thái độ.
     - Có thái độ nghiêm túc trong giờ thực hành.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
   - Giáo án, SGK, máy tính…
2. Chuẩn bị của học sinh.
    - Đồ dùng học tập, SGK.
III. Tiến trình dạy học.
 1. Ổn định tổ chức.
 2. Kiểm tra bài cũ.
    - Kết hợp xen kẽ trong giờ thực hành.
 3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	 Bài tập 3: Mở bảng tính. 

· Mở một bảng tính mới.
· Mở bảng tính BTH1 đã lưu trên máy
HS: Thực hành thao tác.

GV: Hướng dẫn học sinh thực hành , sửa sai (nếu có).

GV hướng dẫn học sinh cách mở các trang tính bằng các cách khác nhau để học sinh thao tác linh hoạt hơn.
 - Có thể mở trang tính bằng cách sử dụng nút lệnh trên thanh công cụ.
- Có thể mở bằng cách gõ tổ hợp phím Ctrl + O để mở trang tính.



Bài tập 4: Nhập dữ liệu vào trang tính.

- Nhập các dữ liệu về danh sách lớp vào bảng tính.

Lưu ý: Học sinh có thể nhập trực tiếp tên của nhóm mình trên danh sách, thay tên Danh sách lớp bằng tên là Danh sách nhóm của mình được phân.

- Lưu bảng tính với tên So theo doi the luc.

- Hướng dẫn học sinh cách lưu trang tính
   + Chọn biểu tượng lưu trên thanh công cụ, . Hộp thoại xuất hiện, gõ nội dung tên bài tập vào ô File Name và chọn nút lệnh Save.

GV: Ngoài cách lưu trên chúng ta còn có thể sử dụng tổ hợp phím Ctrl + S, hoặc lưu bằng cách sử dụng nút lệnh Save As trên thanh bảng chọn File

- Hãy cho biết các kiểu dữ liệu có trong bảng tính?

- Thoát khỏi bảng tính.

GV: Hướng dẫn học sinh thực hành, sửa sai (nếu có).
	Bài tập 3: Mở bảng tính.


















Bài tập 4: Nhập dữ liệu vào trang tính.







[image: ]








 - Có 2 kiểu dữ liệu trên bảng đó là: Dạng số và dạng kí tự.


4. Củng cố.
       	     - Nhận xét ưu khuyết điểm trong quá trình thực hành của HS.
5. Hướng dẫn học sinh học ở nhà.
   	     - Yêu cầu HS về nhà thực hành lại nội dung bài thực hành.
    - Xem trước nội dung bài “Luyện gõ phím bằng Typing Test” để tiết 
    sau học.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………					      Kiểm tra, ngày … tháng …. năm 201…
      Tổ  chuyên môn









 






Ngày soạn: 61209/2019
Ngày giảng:…/09/2019
Tiết: 09

  THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH

	I. Mục tiêu.
		1. Kiến thức.
   	       - Biết được cách nhập công thức vào ô tính.
  	       - Viết đúng được các công thức tính toán theo các kí hiệu phép toán 
	      của bảng tính.
		2. Kỹ năng.
   	       - Biết được cách nhập công thức vào ô tính.
                 - Viết đúng được các công thức tính toán theo các kí hiệu phép toán 
                của bảng tính.
		3. Thái độ.
        - Có thái độ nghiêm túc, tích cực phát biểu xây dựng bài.
	II. Chuẩn bị của giáo viên và học sinh.
      	1. Chuẩn bị của giáo viên.
	       - Giáo án, SGK, máy tính…
    	2. Chuẩn bị của học sinh.
	- Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
  	   1. Ổn định tổ chức.
		- Kiểm tra sĩ số:
 	2. Kiểm tra bài cũ. 
		Câu 1: Khởi động Excel và nhập dữ liệu sau vào trang tính.
	A1
	A2
	A3
	A4

	            15
	                              20
	Son thuy
	Lop 6


		? Cho biết các ô tính chứa những dữ liệu dạng nào? Vì sao em biết.
 		Câu 2: Chọn một khối ô và cho biết ô nào được kích hoạt?
     	3. Bài mới.
Các em đã được làm quen với các dữ liệu trên trang tính
?Hãy cho biết có những kiểu dữ liệu nào trên trang tính? 
HS: Dữ liệu dạng số, dữ liệu dạng kí tự.
?Cho biết chương trình bảng tính là gì?
HS: Chương trình bảng tính là một phần mềm được thiết kế để ghi lại và trình bày thông tin dưới dạng bảng, tính toán cũng như xây dựng biểu đồ một cách trực quan.
GV: Chương trình bảng tính được thiết kế để ghi lại và trình bày thông tin dưới dạng bảng, tính toán. Đây chính là một tính năng ưu việt hỗ trợ nhanh cho tính toán.
?Làm thế nào để tính toán được dữ liệu số?
HS: Sử dụng công thức để tính toán. 
GV: Vậy sử dụng công thức như thế nào cho đúng? Để hiểu rõ vấn đề này ta tìm hiểu bài mới.Bài 3 “Thực hiện tính toán trên trang tính”.	
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1   

GV: Để sử dụng công thức đúng ta phải hiểu rõ các kí hiệu dùng cho phép toán trên trang tính.
?Hãy cho biết các phép toán thường sử dụng trong toán học?
HS: Phép toán +, -, x, :, luỹ thừa, phần trăm.
GV: - Các phép toán này trên trang tính sử dụng các kí hiệu trên bàn phím thay thế phép toán
- GV hướng dẫn để HS rõ các phím thay thế phép toán trực tiếp trên bàn phím: +, -, nhân (*), chia ( )/, luỹ thừa (^), phần trăm (%) – HS quan sát
Gọi 1 - 2 em lên chỉ lại – HS thao tác.
?Khi tính toán một biểu thức các em phải thực hiện theo một thứ tự nào?
HS: Thực hiện trong ngoặc trước, tiếp đến nhân, chia,cuối cùng là cộng, trừ.

GV: Hướng dẫn HS cách thực hiện phép toán trên trang tính – HS quan sát.
Gọi 1 - 2 em lên viết phép toán trên bảng và 1 – 2 em lên nhập phép toán trên máy tính – HS thao tác.
GV: Nhập biểu thức =5+12-7 vào ô A2
?Hãy quan sát ô tính và nhận xét – HS có dấu bằng trước biểu thức.
GV: Enter – HS quan sát ô tính và nhận xét 
HS: Lúc này ô tính không còn thấy biểu thức nữa mà thay vào đó là kết quả đã được tính toán.
	1. Sử dụng công thức để tính toán.


Các kí hiệu dùng cho các phép toán:
  Cộng (+), trừ (- ),  nhân (*), chia (/), lũy thừa (^ ),  phần trăm (%).



 

	Hoạt động 2  
GV: Để thực hiện tính toán trên trang tính thì khi nhập biếu thức vào ô tính trước tiên ta phải nhập dấu bằng trước tiếp đến mới nhập dữ liệu.
Ví dụ: =(18+3)/7+(4-2)^2*3
HS: Quan sát.
GV: Gõ phím Enter, hãy nhận xét ô tính?
HS: Kết quả tính toán hiện ra.
GV: Để thực hiện được tính toán các em cần thực hiện theo các bước sau







Gọi 2 - 3 em lên nhập biểu thức và cho biết kết quả tính được.
- { [5 + 10(6-4+9)+7]-9:5}
- 12:6.4+3x2
- (15:5)42 + 15
- 6+8.9-12:6-9+20
HS: thao tác
	2. Nhập công thức.





B1) Nháy chọn ô cần nhập công thức.
B2) Nhập dấu =
B3) Nhập biểu thức cần → gõ Enter
B4) Xem kết quả tính toán
 - Kết quả sẽ hiển thị ở ô nhập công thức.
 - Công thức được hiển thị trên thanh công thức.


	4. Củng cố. 
			- HS cần nắm vững các kí hiệu phép toán *, /, ^, %.
			- Hiểu và biết cách nhập công thức bắt đầu bằng dấu bằng (=).
			- Thực hiện tính toán được một số biểu thức đơn giản.
		5. Hướng dẫn học sinh học ở nhà. 
- Về nhà lấy sách số học ra tập nhập và tính toán các phép toán trong sách giáo khoa trên trang tính.
			- Làm các bài tập 1, 2, 3, 4 SGK trang 24
			- Xem trước nội dung phần 3. “Sử dụng địa chỉ trong công thức”  
			để tiết sau học.
	IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………












			
Ngày soạn:  12/09/2019
Ngày giảng: …/09/2019
Tiết: 10


  THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH

	I. Mục tiêu.
		1. Kiến thức.
  	       - Biết được cách nhập công thức vào ô tính.
- Viết đúng được các công thức tính toán theo các kí hiệu phép toán của bảng tính.
		2. Kỹ năng.
   	       - Biết được cách nhập công thức vào ô tính.
- Viết đúng được các công thức tính toán theo các kí hiệu phép toán của bảng tính.
		3. Thái độ.
        - Có thái độ nghiêm túc, tích cực phát biểu xây dựng bài.
	II. Chuẩn bị của giáo viên và học sinh.
      	1. Chuẩn bị của giáo viên.
	       - Giáo án, SGK, máy tính…
    	2. Chuẩn bị của học sinh.
	- Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
  	   1. Ổn định tổ chức.
		- Kiểm tra sĩ số:
 	2. Kiểm tra bài cũ. 
		Câu 1: Khởi động Excel và nhập dữ liệu sau vào trang tính.
		Hãy nhập biểu thức sau theo công thức vào ô tính:
		(15+5) - (30-5)+42(40+5)
     	3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1
GV: Đưa ra một bài mẫu trong đó có dữ liệu kiểu số, ô tính kết quả được nhập theo điạ chỉ ô – HS quan sát.
- Ta không chỉ nhập biểu thức cụ thể giá trị mà có thể thông qua địa chỉ ô để nhận dữ liệu cho việc tính toán
- GV thao tác mâuc – HS quan sát
Gọi 1 - 2 em thao tác – HS thao tác
GV: Để thuận tiện cho việc chỉnh sửa dữ liệu trong ô tính, khi nhập công thức người ta sử dụng địa chỉ ô để thay thế.

GV cho HS quan sát dữ liệu vừa nhập ở kiểm tra bài cũ và dữ liệu ở bài mẫu – HS quan sát.
GV: Khi ta nhập dữ liệu vào ô tính thì dữ liệu đó sẽ được lưu ở ô tính đó.




GV:  Thao tác nhập công thức – HS quan sát thanh công thức.
?Nếu ta đang nhập công thức hoặc dữ liệu thì thanh công thức có dạng như thế nào? – HS trả lời


Ví dụ 1: GV thao tác theo hai cách nhập công thức.
A1=20; B1=27; C1=32;D1=60

C1  =Sum(A1:D2)/10   Kết quả = 13.9
C2  =(A1+C1+Đ1+A2+B2+D2+E2)/10
HS: Quan sát
?Nhận xét hai cách nhập? 
HS: Kết quả tính toán là như nhau, xong C1 nhập nhanh lại chính xác hơn
Cũng ví dụ 1 GV nhập theo công thức 
= (20+27+32+60)/10  13.9
?So sánh kết quả - HS trả lời.
GV: Thay đổi dữ liệu ở ô tính.
?Hãy so sánh kết quả ở ba cách nhập tính toán ở trên


GV: Nhập một dãy số sao cho dãy số lớn mà địa chỉ ô tính đó không chứa hết – HS quan sát.
?Hãy cho biết địa chỉ ô này như thế nào?
HS: Địa chỉ có dạng ##########.
GV: Nếu các em nhìn thấy ô tính có dạng ###### nghĩa là dữ liệu số quá dài nên không hiển thị hết, ta chỉ việc nháy đúp chuụot tại nút tên cột.

Gọi 1 - 2 em thao tác – HS thao tác.
 Khi nhập dữ liệu đôi khi có sai sót hoặc muốn sửa chữa dữ liệu khác ta phải chính sửa dữ liệu.
?Chỉnh sửa bằng cách nào? – HS trả lời.
GV thao tác mẫu – HS quan sát.
?Nêu cách chỉnh sửa dữ liệu? – HS trả lời



Gọi hai em thao tác – HS thao tác
GV: Nháy chuột vào một ô có dữ liệu và gõ dữ liệu mới. – HS quan sát.
?Nhận xét ô tính?
HS: Dữ liệu cũ bị xóa sạch thay vào đó là dữ liệu mới vừa nhập.
	3. Sử dụng địa chỉ ô trong công thức.


- Nếu nhập dữ liệu vào ô tính thì thanh công thức có dạng.
[image: ]



 * Trong đó:  + X (Cancel): Hủy dữ liệu vừa nhập.
  + (Enter): Kết thúc thao tác nhập.
  + fx: Chọn hàm.











 - Để kết quả tính toán được cập nhật tự động, chính xác ta nên sử dụng địa chỉ ô thay cho dữ liệu.
Ví dụ: =A1+B2














* Chú ý: - Nếu dữ liệu là số nhập vào ô quá dài thì khi hiển thị ô sẽ có dạng #######, chỉ việc nháy đúp chuột vào ô đó sẽ hiển thị đầy đủ.









- Chỉnh sửa dữ liệu trong ô tính:
B1) Nháy chọn ô cần chỉnh sửa
B2) C1: Nháy chuột lên thanh công thức → sửa → gõ phím Enter
  C2: Gõ F2 → sửa → Gõ phím Enter



 Chú ý: Nếu muốn nhập dữ liệu mới vào ô đã có dữ liệu ta chỉ việc chọn ô đó và nhập dữ liệu mới, dữ liệu cũ lập tức bị xóa sạch.

	Hoạt động 2 
Câu 1: (SGK trang 24).
	Bạn Hằng gõ vào một ô tính nội dung 8+2*3 với mong muốn tính được giá trị công thức vừa nhập. Nhưng trên ô tính vẫn chỉ hiện thị nội dung 8+2*3 thay vì giá trị 14 mà bạn hằng mong đợi. Em có biết tại sao không?

Câu 3: (SGK trang 24)
     Hãy nêu lợi ích của việc sử dụng địa chỉ ô trong công thức?

Câu 4: (SGK trang 24) 
     Giả sử cần tính tổng giá trị các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Công thức nào trong số các công thức sau đây là đúng?
a) (D2+C2)*B2;	b) D4+C2*B2;
c) =(D4+C2)*B2;d) =(B2*(D4+C2);
e) =(D4+C2)B2;	g) (D4+C2)B2;

	 Bài tập. 
Câu 1
                    Trả lời
- Bạn Hằng đã nhập thiếu dấu (=) ở công thức.



Câu 3
                     Trả lời 
- Lợi ích của việc sử dụng địa chỉ ô tính trong công thức là cập nhật tự động kết quả tính toán.



Câu 4
Trả lời

 	c) =(D2+C2)*B2;



	4. Củng cố.
· Biết cách nhập công thức bằng hai cách đó là nhập trực tiếp giá trị và nhập theo địa chỉ ô.		
		5. Hướng dẫn học sinh học ở nhà. 
			- Về nhà nhập dữ liệu số vào ô tính (dữ liệu tùy ý) → thực hiện tính 
			toán theo địa chỉ ô.
			- Xem trước bài thực hành 3 để tiết sau thực hành.
	IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………			              Kiểm tra , ngày …. tháng ….. năm 201..
						 Tổ chuyên môn


						

































Ngày soạn: 19/9/2019
Ngày dạy:  …./9/2019
Tiết: 11

BẢNG ĐIỂM CỦA EM
I.  Mục tiêu.
1. Kiến thức.
	- Học sinh thực hiện được các phép toán với chương trình bảng tính.
2. Kỹ năng.
     - Học sinh biết cách nhập và sử dụng công thức trên trang tính.
     - Biết cách sử dụng địa chỉ ô trong khi thực hiện các phép toán.
3. Thái độ.
- Có thái độ nghiêm túc trong giờ thực hành.
   	II. Chuẩn bị của giáo viên và học sinh.
	1. Chuẩn bị của giáo viên.
	    - Giáo án, SGK, máy tính.
	2. Chuẩn bị của học sinh.
	    - Đồ dùng học tập, SGK, vở ghi, chuẩn bị bài trước ở nhà.
    	III. Tiến trình dạy học.
	1. Ổn định lớp.
	   2. Kiểm tra bài cũ.
              Câu 1: Nhập dữ liệu vào các ô sau:
	A1
	B2
	C1
	D3

	8
	6
	4
	9


		-  Hãy nhập công thức vào ô tính theo bảng sau:
	=A1+B2
	= B2-C1
	= C1*D3
	= (D3/A1)-(B2+C1)

	=A1*C1
	=B2*C1+A1
	= (C1-D1)*A1
	= D3-A1


	III. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1  
- GV giới thiệu mục đích và yêu cầu của bài học.
- HS chú ý nghe
	1. Mục đích, yêu cầu.
    

	
Hoạt động 2 
GV yêu cầu HS thực hành bài tập 1: Nhập công thức.            (sgk – trang 25)
- Sử dụng công thức để tính các giá trị sau đây vào trang tính.
HS thực hành trên máy.
GVhướng dẫn HS nhập công thức – sửa sai (nếu có).
	2. Nội dung.
   Bài tập 1: Nhập công thức 






	
	A
	B
	C
	D
	E

	1
	=20+15
	=20-15
	=20*5
	=20/5
	=20^5

	2
	=20+15*4
	=(20+15)*4
	=(20-15)*4
	=20-(15*4)
	

	3
	=144/6-3*5
	=144/(6-3)*5
	=(144/6-3)*5
	=144/(6+3)*5
	

	4
	=15^2/4
	=(2+7)^2/7
	=(32-7)^2-(6+3)^3
	
	



	Hoạt động 3 

GV hướng dẫn HS cách tạo trang tính và cách nhập công thức vào trang tính, sửa sai (nếu có).
- Mở trang tính mới (sheet 2, sheet3) để thực hành.
- Nhập các dữ liệu vào ô tính như hình 25 (SGK trang 25).
HS thực hành trên máy tính.
- Nhập các công thức vào ô tính tương ứng vào bảng sau:
	Bài tập 2: Tạo trang tính và nhập công thức.




	       
	E
	F
	G
	H
	I

	1
	= A1+5
	=A1*5
	=A1+B2
	=A1*B2
	=(1+B2)C4

	2
	=A1*C4
	=B2-A1
	=(A1+B2)-C4
	=(A1+B2)/C4
	=B2^A1-C4

	3
	=B2*C4
	=(C4-A1)/B2
	(A1+B2)/2
	=(B2+C4)/2
	=(A1+B2+C4)/3


    	   4. Củng cố. 
	- Nhận xét ưu khuyết điểm của HS trong quá trình thực hành.
    	5. Hướng dẫn học sinh học ở nhà. 
· Yêu cầu HS về nhà xem trước phần bài tập 3, 4 của bài thực hành 
“Bảng điểm lớp em” để tiết sau học thực hành.	
	IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….……………







Ngày soạn: 19/9/2019
Ngày dạy:  …./9/2019
Tiết: 12

BẢNG ĐIỂM CỦA EM

I. Mục tiêu.
1. Kiến thức.
	- Học sinh thực hiện được các phép toán với chương trình bảng tính.
2. Kỹ năng.
     - Học sinh biết cách nhập và sử dụng công thức trên trang tính.
     - Biết cách sử dụng địa chỉ ô trong khi thực hiện các phép toán.
3. Thái độ.
- Có thái độ nghiêm túc trong giờ thực hành.
   	II. Chuẩn bị của giáo viên và học sinh.
	1. Chuẩn bị của giáo viên.
	    - Giáo án, SGK, máy tính.
	2. Chuẩn bị của học sinh.
	    - Đồ dùng học tập, SGK, vở ghi, chuẩn bị bài trước ở nhà.
    	III. Tiến trình dạy học.
	1. Ổn định tổ chức.
	  2. Kiểm tra bài cũ. 
	    Câu 1: Nhập dữ liệu vào các ô sau:	
	A1
	B2
	C1
	D3

	8
	6
	4
	9


		-  Hãy nhập công thức vào ô tính theo bảng sau:
	=A1+B2
	= B2-C1
	= C1*D3
	= (D3/A1)-(B2+C1)

	=A1*C1
	=B2*C1+A1
	= (C1-D1)*A1
	= D3-A1


	3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1 .

- Giả sử em có 500.000 đồng gửi tiết kiệm không kì hạn với lãi xuất 0.3%/tháng. Hãy sử dụng công thức để tính xem trong vòng một năm, hàng tháng em có bao nhiêu tiền trong sổ tiết kiệm? Hãy lập trang tính như hinh 26 đẻ sao cho khi thay đổi số tiền gửi ban đầu và lãi suất thì không cần phải nhập lại công thức.Lưu bảng tính với So tiet kiem.
GV hướng dẫn HS thực hiện sửa sai (nếu có).HS thực hiện trên máy tính.
	Bài tập 3: Thực hành lập và sử dụng công thức.




	TiÒn göi
	5000000
	th¸ng
	Sè tiÒn trong sæ

	L·i  suÊt
	0.3%
	1
	15000

	
	
	2
	30000

	
	
	3
	45000

	
	
	4
	60000

	
	
	5
	75000

	
	
	6
	90000

	
	
	7
	105000

	
	
	8
	120000

	
	
	9
	135000

	
	
	10
	150000

	
	
	11
	165000

	
	
	12
	180000



		Hoạt động 2 
- Mở bảng tính mới và lập bảng điểm của em như hình 27 dưới đây. Lập công thức để tính điểm tổng kết của em theo từng môn học và các ô tương ứng trong cột G. (Chú ý: Điểm tổng kết là trung binh cộng của các điểm kiểm tra sau khi đã nhân hệ số).
GV hướng dẫn HS thực hiện thao tác trên máy tính, sửa sai (nếu có).
- Chú ý: Ta có thể sao chép các công thức tính toán bằng cách, 
ưa con chuột vào ô màu đen góc dưới bên phải ô điểm tổng kết sao cho có dấu (+) nháy chuột để sao chép đến vị trí của ô chứa giá trị cần 
ính.



		Bài tập 4: Thực hành lập bảng tính và sử dụng công thức.






	
B¶ng ®iÓm cña em

	stt
	M«n häc
	KT 15 phót
	KT 1 tiÕt lÇn 1
	KT 1 tiÕt lÇn 2
	KT häc k×
	§iÓm tæng kÕt

	1
	To¸n
	8
	7
	9
	10
	8.8

	2
	VËt lÝ
	8
	8
	9
	9
	8.6

	3
	LÞch sö
	8
	8
	9
	7
	7.9

	4
	Sinh häc
	9
	10
	9
	10
	9.6

	5
	C«ngnghÖ
	8
	6
	8
	8
	7.5

	6
	Tin häc
	8
	9
	9
	9
	8.9

	7
	Ng÷ v¨n
	7
	6
	8
	8
	7.4

	8
	GDCD
	8
	9
	9
	9
	8.9


  	
	4. Củng cố. 
	- Nhận xét ưu khuyết điểm của HS trong quá trình thực hành.
    	5. Hướng dẫn học sinh học ở nhà. 
	       - Yêu cầu HS về nhà xem trước bài 4: “Sử dụng các hàm để tính 
	      toán”, phần 1,2 SGK trang 28, 29 để tiết sau học.
	IV. Rút kinh nghiệm sau tiết dạy
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….………………
					Kiểm tra, ngày .. tháng .. năm 201..
              					Tổ chuyên môn



			
						
	

 







		














Ngày soạn:26/9/2019
Ngày giảng:…/10/2019
Tiết: 13
						BÀI TẬP

	I. Mục tiêu.
	1. Kiến thức.
	- Củng cố kiến thức đã học của học sinh, hướng dẫn học sinh làm 
     thêm một số bài tập.
     - Học sinh biết cách nhập công thức và sử dụng hàm đúng quy định.
     - Biết cách sử dụng hàm đã học để tính toán.
	2. Kỹ năng.
	- Củng cố kiến thức đã học của học sinh, hướng dẫn học sinh làm 
     thêm một số bài tập.
     - Học sinh biết cách nhập công thức và sử dụng hàm đúng quy định.
     - Biết cách sử dụng hàm đã học để tính toán.
	3. Thái độ.
    - Có thái độ tích cực trong giờ học.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin quyển 2, chuẩn bị nội dung câu hỏi ôn tập.
2. Chuẩn bị của học sinh.
   - Vở ghi, SGK, đồ dùng học tập.
III. Tiến trình dạy học.
	1. Ổ định tổ chức.
	   2. Kiểm tra bài cũ.
     - Kết hợp trong bài ôn tập
	3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1   

GV tóm tắt chương trình của nội dung ôn tập.
- Yêu cầu về nhà xem lại toàn bộ nội dung của 4 bài học và cùng với đó là 4 bài thực hành.
HS chú ý và ghi nhớ.


- GV đưa ra một số câu hỏi và bài tập trong SGK.
HS nghiên cứu câu hỏi và tham gia trả lời.
Câu 1: Hãy nêu tính năng chung của các chương trình bảng tính?








Câu 2: Ô tính đang được kích hoạt có gì khác biệt so với ô tính khác?


Câu 3: Liệt kê các thành phần chính của trang tính?



Câu 4: Nêu các cách chọn đối tượng trên trang tính?














Câu 5: Vùng giao nhau của một cột và một hàng gọi là?







Câu 6: Cho biết ý nghĩa của kí hiệu sau ####


Câu 7: Cho biết ý nghĩa các kí hiệu sau:
· A1:D6
· A3;B5;D6
· 2;4;F8:H12


	I. Phần lý thuyết.
- Chương trình bảng tính.
- Các thành phần chính và dữ liệu trên trang tính.
- Thực hiện các tính toán trên trang tính.
 - Sử dụng các hàm để tính toán.







Câu 1:
- Chương trình bảng tính là phần mềm được thiết kế để giúp ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ biểu diễn một cách trực quan các số liệu có trong bảng.




Câu 2: 
Ô tính được kích hoạt có viềm đậm xung quanh.

Câu 3: Các thành phần chính của trang tính là: Các hàng, cột, ô tính, hộp tên, khối, thanh công thức.

Câu 4: Các cách chọn đối tượng trên trang tính là:
- Chọn 1 ô: Nháy chuột vào ô cần chọn.
- Chọn 1 hàng:: Nháy chuột vào nút tên hàng.
- Chọn 1 cột: Nháy chuột vào nút tên cột.
- Chọn một khối:Kðo thả chuột từ một ô góc đến ô góc đối diện.
- Chọn nhiều khối ô không liền kề nhau: Chọn khối đầu + giữ phím Ctrl + lần lượt chọn các khối tiếp theo.




Câu 5: Vùng giao nhau giữa một cột và một hàng gọi là ô tính.



Câu 6:
· Ô tính có độ rộng hẹp nên không hiển thị hết dữ liệu kiểu số có trong ô.

Câu 7:

· A1:D6 chọn khối từ ô A1 đến D6.
· A3;B5;D6 Chọn các ô A3, B5, D6.
· Chọn hàng 2, hàng 4, chọn khối từ F8 đến H12.

	Hoạt động 2 (20 phút)

GV đưa ra một số bài tập để củng cố kiến thức.

Bài tập 1: Hoá đơn bán hàng.
	Stt
	Tên hàng
	SL
	Đơn giá
	Thành tiền

	
	Sá
h Tin
	2
	10.000
	

	2
	S

h
Toán
	3
	12.000
	

	3
	Sách Lý
	5
	14.000
	

	4
	Sách Hoá
	9
	12.500
	

	5
	Sách Sinh
	8
	13.000
	

	6
	Sách Sử
	2
	19.500
	



a) Tính cột thành tiền theo công thức là số lượng nhân với đơn giá.
b) Tính tổng số tiền bằng tổng cột thành tiền.
GV hướng dẫn HS.
HS thực hành trên máy.

Bài tập 2: 

	Stt
	Tên
	Toán
	Lý
	Văn
	ĐTB

	1
	Hoa
	8
	7
	9
	

	2
	Đại
	8
	8
	6
	

	3
	Văn
	8
	5
	9
	

	4
	Lê
	8
	7
	8
	

	5
	Thoa
	8
	5
	6
	

	6
	Mai
	8
	7
	8
	


a) Tính điểm trung bình cộng.
b) Tìm giá trị điểm trung bình lớn nhất.
c) Tìm giá trị điểm trung bình thấp nhất.

	Bài tập
Bài tập 1:

a)

	Stt
	Tên hàng
	SL
	Đơn giá
	Thành tiền

	1
	Sách Tin
	2
	10.000
	20.000

	2
	Sách Toán
	3
	12.000
	36.000

	3
	Sách
Lý
	5
	14.000
	70.0
0

	4
	Sách Hoá
	9
	12.500
	112.
00

	5
	Sách Sinh
	8
	13.000
	104.000

	6
	Sách Sử
	2
	19.500
	39.000



b) Tổng số tiền là: 381.500đ






Bài tập 2:
a) 
	Stt
	Tên
	Toán
	Lý
	Văn 
	ĐTB

	1
	Hoa
	8
	7
	9
	8.0

	2
	Đại
	8
	8
	6
	7.3

	3
	Văn
	8
	5
	9
	7.3

	4
	Lê
	8
	7
	8
	7.7

	5
	Tho
	8
	5
	6
	6.3

	6
	Ma
	8
	7
	8
	7.7



b) Giá trị điểm trung bình lớn nhất là: 8.0
c) Giá trị điểm trung bình nhỏ nhất là: 6.3



4. Củng cố. 
	- Hướng dẫn học sinh thực hành, sửa sai nếu học sinh mắc phải.
5. Hướng dẫn học sinh học ở nhà. 
     - Nhắc học sinh về nhà xem lại toàn bộ kiến thức đã học, để tiết sau 
     kiểm tra 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………




Ngày soạn : 26/9/2019
Ngày dạy: …../10/2019
Tiết: 14

BÀI TẬP

	I. Mục tiêu.
	1. Kiến thức.
	- Củng cố kiến thức đã học của học sinh, hướng dẫn học sinh làm 
     thêm một số bài tập.
     - Học sinh biết cách nhập công thức và sử dụng hàm đúng quy định.
     - Biết cách sử dụng hàm đã học để tính toán.
	2. Kỹ năng.
	- Củng cố kiến thức đã học của học sinh, hướng dẫn học sinh làm 
     thêm một số bài tập.
     - Học sinh biết cách nhập công thức và sử dụng hàm đúng quy định.
     - Biết cách sử dụng hàm đã học để tính toán.
	3. Thái độ.
    - Có thái độ tích cực trong giờ học.
III. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin quyển 2, chuẩn bị nội dung câu hỏi ôn tập.
2. Chuẩn bị của học sinh.
   - Vở ghi, SGK, đồ dùng học tập.
III. Tiến trình dạy học.
	1. Ổ định tổ chức.
	   2. Kiểm tra bài cũ.
     - Kết hợp trong bài ôn tập
	3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1   

GV tóm tắt chương trình của nội dung ôn tập.
- Yêu cầu về nhà xem lại toàn bộ nội dung của 4 bài học và cùng với đó là 4 bài thực hành.
HS chú ý và ghi nhớ.


- GV đưa ra một số câu hỏi và bài tập trong SGK.
HS nghiên cứu câu hỏi và tham gia trả lời.
Câu 1: Hãy nêu tính năng chung của các chương trình bảng tính?








Câu 2: Ô tính đang được kích hoạt có gì khác biệt so với ô tính khác?


Câu 3: Liệt kê các thành phần chính của trang tính?



Câu 4: Nêu các cách chọn đối tượng trên trang tính?














Câu 5: Vùng giao nhau của một cột và một hàng gọi là?







Câu 6: Cho biết ý nghĩa của kí hiệu sau ####


Câu 7: Cho biết ý nghĩa các kí hiệu sau:
· A1:D6
· A3;B5;D6
· 2;4;F8:H12


	I. Phần lý thuyết.
- Chương trình bảng tính.
- Các thành phần chính và dữ liệu trên trang tính.
- Thực hiện các tính toán trên trang tính.
 - Sử dụng các hàm để tính toán.







Câu 1:
- Chương trình bảng tính là phần mềm được thiết kế để giúp ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ biểu diễn một cách trực quan các số liệu có trong bảng.




Câu 2: 
Ô tính được kích hoạt có viềm đậm xung quanh.

Câu 3: Các thành phần chính của trang tính là: Các hàng, cột, ô tính, hộp tên, khối, thanh công thức.

Câu 4: Các cách chọn đối tượng trên trang tính là:
- Chọn 1 ô: Nháy chuột vào ô cần chọn.
- Chọn 1 hàng:: Nháy chuột vào nút tên hàng.
- Chọn 1 cột: Nháy chuột vào nút tên cột.
- Chọn một khối:Kðo thả chuột từ một ô góc đến ô góc đối diện.
- Chọn nhiều khối ô không liền kề nhau: Chọn khối đầu + giữ phím Ctrl + lần lượt chọn các khối tiếp theo.




Câu 5: Vùng giao nhau giữa một cột và một hàng gọi là ô tính.



Câu 6:
· Ô tính có độ rộng hẹp nên không hiển thị hết dữ liệu kiểu số có trong ô.

Câu 7:

· A1:D6 chọn khối từ ô A1 đến D6.
· A3;B5;D6 Chọn các ô A3, B5, D6.
· Chọn hàng 2, hàng 4, chọn khối từ F8 đến H12.

	Hoạt động 2 (20 phút)

GV đưa ra một số bài tập để củng cố kiến thức.

Bài tập 1: Hoá đơn bán hàng.
	Stt
	Tên hàng
	SL
	Đơn giá
	Thành tiền

	
	Sá
h Tin
	2
	10.000
	

	2
	S


 Toán
	3
	12.000
	

	3
	Sách Lý
	5
	14.000
	

	4
	Sách Hoá
	9
	12.500
	

	5
	Sách Sinh
	8
	13.000
	

	6
	Sách Sử
	2
	19.500
	



a) Tính cột thành tiền theo công thức là số lượng nhân với đơn giá.
b) Tính tổng số tiền bằng tổng cột thành tiền.
GV hướng dẫn HS.
HS thực hành trên máy.

Bài tập 2: 

	Stt
	Tên
	Toán
	Lý
	Văn
	ĐTB

	1
	Hoa
	8
	7
	9
	

	2
	Đại
	8
	8
	6
	

	3
	Văn
	8
	5
	9
	

	4
	Lê
	8
	7
	8
	

	5
	Thoa
	8
	5
	6
	

	6
	Mai
	8
	7
	8
	


a) Tính điểm trung bình cộng.
b) Tìm giá trị điểm trung bình lớn nhất.
c) Tìm giá trị điểm trung bình thấp nhất.

	Bài tập
Bài tập 1:

a)

	Stt
	Tên hàng
	SL
	Đơn giá
	Thành tiền

	1
	Sách Tin
	2
	10.000
	20.000

	2
	Sách Toán
	3
	12.000
	36.000

	3
	Sách
Lý
	5
	14.000
	70.0
0

	4
	Sách Hoá
	9
	12.500
	112.
00

	5
	Sách Sinh
	8
	13.000
	104.000

	6
	Sách Sử
	2
	19.500
	39.000



b) Tổng số tiền là: 381.500đ






Bài tập 2:
a) 
	Stt
	Tên
	Toán
	Lý
	Văn 
	ĐTB

	1
	Hoa
	8
	7
	9
	8.0

	2
	Đại
	8
	8
	6
	7.3

	3
	Văn
	8
	5
	9
	7.3

	4
	Lê
	8
	7
	8
	7.7

	5
	Tho
	8
	5
	6
	6.3

	6
	Ma
	8
	7
	8
	7.7



b) Giá trị điểm trung bình lớn nhất là: 8.0
c) Giá trị điểm trung bình nhỏ nhất là: 6.3


4. Củng cố. 
	- Hướng dẫn học sinh thực hành, sửa sai nếu học sinh mắc phải.
5. Hướng dẫn học sinh học ở nhà. 
     - Nhắc học sinh về nhà xem lại toàn bộ kiến thức đã học, để tiết sau 
     kiểm tra 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
Kiểm tra, ngày … tháng … năm 201..
						        Tổ chuyên môn
Ngày soạn: 3/10/2019
Ngày day:
Lớp 7a:…/10/2019
Lớp 7b:…/10/2019
Tiết:15
KIỂM TRA 1 TIẾT


	I. Mục tiêu.
		1. Kiến thức.
     	-  Kiểm tra đánh giá lại toàn bộ kiến thức đã học.
      	- Học sinh biết được bảng tính là gì? Chức năng chủ yếu của các thành 
	phần chính trong bảng tính Excel, Biết được các thành phần chính và 
  	dữ liệu trên trang tính
            2. Kỹ năng.
     - Học sinh biết được bảng tính là gì? Chức năng chủ yếu của các thành 
	phần chính trong bảng tính Excel, Biết được các thành phần chính và 
     dữ 	liệu trên trang tính
           3. Thái độ.
 	- Có thái độ ngiêm túc trong giờ kiểm tra.
	II. Chuẩn bị của giáo viên và học sinh.
    	1. Chuẩn bị của giáo viên.
	- Chuẩn bị giáo án, đề kiểm tra.
   	 2. Chuẩn bị của học sinh.
	- Giấy kiểm tra, bút.
	III. Tiến trình dạy  học.
    	1. Ổn định lớp.
	2. Kiểm tra bài cũ.
	- Nhắc nhở học sinh không sử dụng tài liệu.
   	3. Bài mới.
Ma trận đề
	Mục tiêu

Nội dung
	Biết
	Hiểu
	Vận dụng
	TỔNG

	
	TN
	TL
	TN
	TL
	TN
	TL
	

	Bài 1. Chương trình bảng tính là gì?
	Câu 1, 2, 8

1.5đ
	
	
	
	
	
	3 Câu


1.5 đ

	Bài 2: Các thành phần chính và dữ liệu trên trang tính
	Câu 3


0.5 đ
	
	Câu 4, 5

1 đ 
	Câu 11

5đ
	
	
	4 Câu


6.5 đ

	Bài 3: Thực hiện tính toán trên trang tính.
	Câu 9, 10 

1 đ
	
	Câu  6, 7

1 đ
	
	
	
	4 Câu


2 đ

	TỔNG
	6 Câu

3 đ
	
	4 Câu

2 đ
	1 câu

5đ
	 
	 
	11 Câu

10đ




	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Phần I.   Trắc nghiệm  (5 điểm)
Khoanh tròn vào chữ cái của câu trả lời đúng nhất.





Câu 1.Địa chỉ ô B3 nằm ở:
a) Cột B, dòng 3.	      b) Dòng B, cột 3.
c) Dòng B, dòng 3.          d) Cột B, cột 3.
Câu 2. Để thoát khỏi màn hình Excel ta chọn cách nào sau đây?
    a) File -> Open.		  b) File -> Exit.
    c) File -> Save.		 d) File -> Print.
Câu 3. Giao của một hàng và một cột được gọi là:
    a) Dữ liệu.			    b) Trường.
    c) Ô.				   d) Công thức.
Câu 4. Biết rằng trên trang tính chỉ có một ô được kích hoạt. Giả sử khi ta chọn một khối. Ô tính nào được kích hoạt trong các ô của khối đó.
    a) Ô ở giữa khối sẽ được kích hoạt.
    b) Ô cuối cùng của khối sẽ là ô được kích hoạt.
   c) Ô chọn đầu tiên của khối sẽ là ô được kích hoạt.
   d) Toàn bộ các ô của khối được chọn sẽ  được kích hoạt.
Câu 5. Dữ liệu số trên trang tính ở chế độ ngầm định được căn lề như thế nào?
    a) Căn thẳng lề phải.    b) Căn thẳng lề trái.
    c) Căn thẳng lề giữa.    d) Căn thẳng hai lề.
Câu 6. Dữ liệu kí tự trên trang tính ở chế độ ngầm định được căn lề như thế nào?
a) Căn thẳng lề phải.	     b) Căn thẳng lề trái.
c) Căn thẳng lề giữa.	     d) Căn thẳng hai lề.
Câu 7. Giả sử cần tính tổng các giá trị trong các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Công thức nào sau đây là đúng?
a) (C2+D4)*B2;		b) =C2+D4*B2;
c) =(C2+D4)*B2;		d)=(C2+D4)B2;
Câu 8. Trong chương trình bảng tính gồm mấy trang tính được đặt ngầm định sẵn. 
a) 3			b) 1
     c) 5				d) 4
Câu 9. Trong các phép toán dưới đây, phép tính nào kí hiệu đúng trong Excel.
       a) 47 x 3		       b) 47*3
       c) =47x3		      d) = 47*3
Câu 10. Khi gõ công thức vào một ô, kí hiệu đầu tiên phải là:
  a) Tên của ô đầu tiên. b) Dấu ngoặc đơn.
  c) Dấu cộng               d) Dấu bằng
Phần II. Tự luận (5 điểm)
Câu 11. Em hãy trình bày cách chọn các đối tượng trên trang tính?

	 Đáp án – biểu điểm


Phần I: Trắc nghiệm 
( 5 điểm)
Khoanh trong vào chữ cái của câu trả lời đúng nhất.
Câu 1.  
a) Cột B, dòng 3.

Câu 2.  
   
   b) File -> Exit.
Câu 3.  

    c) Ô.

Câu 4.  

   c) Ô chọn đầu tiên của khối sẽ là ô được kích hoạt.





Câu 5.  

a) Căn thẳng lề phải.

Câu 6.  

b) Căn thẳng lề trái.

Câu 7.

c) =(C2+D4)*B2;
Câu 8.

a) 3

Câu 9.  

d) = 47*3
Câu 10.

 d) Dấu bằng.

Phần II: Tự luận (3 điểm)
Câu 11.
- Chọn 1 ô: Đưa con trỏ chuột tới ô cần chọn và nháy chuột.
- Chọn 1 hàng: Nháy chuột vào tên hàng cần chọn.
- Chọn 1 cột: Nháy chuột vào tên cột cần chọn.
- Chọn một khối: Kéo thả chuột từ một ô góc (ô góc trái) đến ô góc đối diện (ô góc phải).

	
 Hoạt động 2: Thu bài kiểm tra.







HS nộp bài kiểm tra.
GV kiểm tra số bài kiểm tra HS nộp.
	


4. Củng cố.
5. Hướng dẫn học sinh học ở nhà.
- Yêu cầu học sinh về nhà xem trước nội dung bài 5: “Sử dụng để tính toán” để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
					


Ngày soạn: 3/10/2019
Ngày dạy:
Lớp 7a:…/10/2019
Lớp 7b:…/10/2019
Tiết: 16
SỬ DỤNG CÁC HÀM ĐỂ TÍNH TOÁN


	I. Mục tiêu
		1. Kiến thức.
	- Hiểu được khái niệm hàm là gì, cách sử dụng hàm.
	- Biết cách sử dụng một số hàm cơ bản như: Hàm tính tổng (Sum).
	- Viết đúng cú pháp của hàm.
		2. Kỹ năng.
     - Hiểu được khái niệm hàm là gì, cách sử dụng hàm.
     - Biết cách sử dụng một số hàm cơ bản như: Hàm tính tổng (Sum).
                - Viết đúng cú pháp của hàm.
		3. Thái độ.
	- Có thái độ nghiêm túc trong giờ học.
	II. Chuẩn bị của giáo viên và học sinh.
     	1. Chuẩn bị của giáo viên.
		- Giáo án, SGK tin 7, máy tính.
     	2. Chuẩn bị của học sinh.
	- Vở ghi, SGK tin 7, đồ dùng học tập.
	III. Tiến trình dạy học.
1. Ổn đinh tổ chức.
	2. Kiểm tra bài cũ.
		Câu 1: Thực hiện nhập các công thức sau:
			a) (5+2)2 + 10;
			b) (20/7) – (5*6);
			c) 12*33+6-4+3/2;
     	3. Bài mới.
· Các em đã được học cách thực hiện các phép tính toán trên trang tính, 
bằng cách nhập công thức trực tiếp hoặc tính toán theo địa chỉ ô tính. Vậy có cách nào giúp tính toán nhanh hơn và lại chính xác cao hơn không? Và có những hàm nào để tính toán trong bảng tính Excel hay không và nếu có thì thực hiện như thế nào? Thầy và các em cùng tìm hiểu sang nội dung bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1 
GV đưa ra một ví dụ.
10, 3, 6, 20, 29, 90. 47
Gọi 1 HS lên nhập các giá trị trên vào các ô của một trang tính bất kì - HS thao tác.
Gọi 1 HS lên thực hiện tính tổng giá trị của số liệu vừa nhập – HS thực hiện thao tác.
GV giả sử nếu như có 100 ô chứa dữ liệu nếu thực hiện tính toán thì sẽ như thế nào?
HS  nếu thực hiện lần lượt nhập từng địa chỉ ô sẽ rất dài, khó khăn, dễ nhầm lẫn và có khi bị sai sót.

GV để tính toán nhanh và không bị nhầm lẫn bảng tính cho phép ta sử dụng các hàm để tính toán thay cho các phép toán.
?HS: Hàm là gì? Hàm được sử dụng để làm gì?


GV giới thiệu một số hàm thường dùng trong bảng tính Excel.
· Hàm tính tổng.
· Hàm tính trung bình cộng.
· Hàm tìm giá trị nhỏ nhất, lớn nhất.

GV thực hiện mẫu về cách sử dụng hàm trong bảng tính Excel.
VD: Tính tổng của các ô từ A1 đến D4.
= SUM(A1:D4)
HS quan sát và nhận xét kết quả.

Gọi 1 HS thao tác tính tổng của các ô từ A1 đến G4 – HS thực hành.
GV nếu tính trung bình cộng của ba số: 5, 8 , 9 các em thực hiện như nào?
HS ta có thể cộng ba số lại và chia cho 3
(5+8+9)/3
GV ta có thể sử dụng hàm thay cho các phép toán cộng và chia đó là hàm Average.
=Average(5,8,8)
 

GV ngoài ra chúng ta còn có thể thực hiện bằng cách nhập địa chỉ của ô tính vào trực tiếp trong công thức.
=Average(A1,B3)
GV giải thích ý nghĩa của hàm.
- Average: Được gọi là tên hàm.
- A1, B3: Được gọi là các biến.
? Cách sử dụng hàm trong chương trình bảng tính Excel như thế nào chúng ta sang phần 2 
	1. Hàm trong chương trình bảng tính.














· Hàm là công thức được định
nghĩa sẵn của bảng tính.
· Hàm được sử dụng để tính toán theo công thức dễ dàng và nhanh chóng.




· Cách viết: = Tên hàm(tham số của hàm)
· Mỗi tham số được viết cách nhau bởi dấu (,) phẩy.


 




	

















	
Hoạt động 2 
GV để sử dụng hàm ta cần nhập hàm vào ô tính bằng cách nhập tương tự như đối với nhập công thức.
Ví dụ: = Average(15,20,30)
Gọi 1 HS lên thực hành thao tác tính trung bình cộng của các ô A1, B1, C1,D1,E1
HS = Average(A1,B1,C1,D1,E1)
? Em hãy nêu các bước thực hiện việc sử dụng hàm.
	2. Cách sử dụng hàm.
- Các bước thực hiện khi nhập hàm.
 + Bước 1: Chọn ô cần nhập hàm.
 + Bước 2: Gõ dấu =
 + Bước 3: Nhập hàm
 + Bước 4: Nhập tham số cho hàm (Nhập giá trị)
 + Bước 5: Gõ phím Enter để thực hiện kết thúc thao tác.  

	
Hoạt động 3  
GV để thực hiện tính toán nhanh các câu hỏi và bài tập, ta có thể thay đổi các phép toán bằng dùng hàm Sum. Như vậy sẽ nhanh hơn rất nhiều và chính xác cao.
GV giới thiệu cách nhập công thức tính có sử dụng hàm Sum.
· Hàm Sum dùng để tính tổng của một dãy các số.
GV chúng ta có thể sử dụng lệnh Sum để tính tổng theo 3 cách sau:
- Tính tổng của các giá trị nhập trực tiếp.
 = Sum(a,b,c……) 
- Tính tổng các giá trị sử sụng địa chỉ ô.
= Sum(A1,B2,C3,D2)
- Tính tổng các giá trị của các ô, từ địa chỉ ô đầu đến địa chỉ của ô cuối.
= Sum(A1:F3)
HS chú ý nghe giảng.
GV ngoài ra chúng ta có thể kết hợp sử dụng địa chỉ ô và giá trị nhập trực tiếp.
Ví dụ: =Sum(A2,B4,67)
GV gọi 1 - 2 HS lên thực hành.
Ví dụ: Tính tổng của các giá trị sau:
a) 12+36+9+52+78
b) 25+8+7+63+45+29
	3. Một số hàm trong chương trình bảng tính.
 a) Hàm tính tổng.
 


- Hàm Sum dùng để tính tổng một dãy các số.
- Các cách thực hiện:
Cách 1: 
=Sum(Giá trị1,giá trị 2…,giá trị n)
Cách 2: 
=Sum(Địa chỉ ô 1, địa chỉ ô 2,…..,địa chỉ ô n)
Cách 3:
=Sum(Địa chỉ ô đầu:địa chỉ ô cuối)


  	4. Củng cố. 
	- Gọi 1 - 2 em HS lên thực hiện tính tổng của các giá trị sau:
		a) 102+150+72+45			b) 5+76+13+25
   	5. Hướng dẫn học sinh học ở nhà.
	- Yêu cầu về nhà học bài cũ, chuẩn bị trước các nội dung của phần 3.
	- Về nhà làm bài tập 1, 2 trong SGK trang 31.
	IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
	Kiểm tra, ngày ... tháng 10 năm 2019
				Tổ chuyên môn

































Ngày soạn: 10/10/2019
Ngày giảng:
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 SỬ DỤNG CÁC HÀM ĐỂ TÍNH TOÁN


	I. Mục tiêu.
		1. Kiến thức.
	- Biết cách sử dụng một số hàm cơ bản như: Hàm tính trung bình 
	cộng (Average), hàm tìm giá trị lớn nhất (Max), hàm tìm giá trị nhỏ 
	nhất (Min).
	- Biết cách sử dụng hàm để tính kết hợp các số với địa chỉ ô tính 
	cũng như các khối trong công thức
		2. Kỹ năng.
	- Biết cách sử dụng một số hàm cơ bản như: Hàm tính trung bình 
	cộng (Average), hàm tìm giá trị lớn nhất (Max), hàm tìm giá trị nhỏ 
	nhất (Min).
- Biết cách sử dụng hàm để tính kết hợp các số với địa chỉ ô tính cũng như các khối trong công thức
		3. Thái độ.
	- Có thái độ nghiêm túc trong giờ học.
	II. Chuẩn bị của giáo viên và học sinh.
     	1. Chuẩn bị của giáo viên.
	- Giáo án, SGK tin 7, máy tính.
     	2. Chuẩn bị của học sinh.
	- Vở ghi, SGK tin 7, đồ dùng học tập.
	III. Tiến trình dạy học.
     	1. ổn đinh tổ chức.
	2. Kiểm tra bài cũ. 
Câu 1: Thực hiện tính tổng của các giá trị sau bằng cách sử dụng hàm:
		a) 15+11+100+30+60
		b) 120+5+6+87
		c) 15+20+4+9
     	3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung  chính

	
Hoạt động 1  
 

GV để tính trung bình cộng ta cũng thực hiện như đối với thao tác tính tổng, tuy nhiên để thực hiện được ta phải sử dụng hàm tính trung bình cộng.
?HS: Để tính trung bình cộng ta sử dụng hàm nào?
HS ta sử dụng hàm Average.
GV hướng dẫn HS cách thực hiện phép tính bằng sử dụng lệnh tính trung bình cộng.

GV chúng ta có thể sử dụng lệnh Average để tính trung bình cộng theo 3 cách sau:
- Tính trung bình cộng của các giá trị bằng cách nhập trực tiếp.
 = Average(a,b,c……) 
Trong đó:
+ Average: là tên hàm tính trung bình cộng
+ a,b,c: là các số hay địa chỉ của ô cần tính.
- Tính trung bình cộng các giá trị sử sụng địa chỉ ô.
= Average(A1,B2,C3,D2)
- Tính trung bình cộng các giá trị của các ô, từ địa chỉ ô đầu đến địa chỉ của ô cuối.
= Average(A1:F3)
HS chú ý nghe giảng.

GV ngoài ra chúng ta có thể kết hợp sử dụng địa chỉ ô và giá trị nhập trực tiếp.
Ví dụ: 
=Average(B3,D4,8)
Lưu ý: Hàm tính trung bình cộng nghĩa là Excel tự động cộng tất cả các giá trị có trong các ô sau đó tự động chia cho tổng các giá trị.

GV gọi 1 – 2 em HS lên thực hành thao tác tính trung bình cộng của các giá trị sau:
a) 5+9+6+8+7
b) 8+9+7+8+6
HS lên thực hành.
GV nhận xét phần thực hành của HS

GV đưa ra một bảng
	
	A
	
	C

	1
	15
	60
	189

	2
	20
	57
	20

	3
	10
	89
	6

	4
	150
	26
	8



?Hãy quan sát bảng dữ liệu trên và cho biết giá trị nào lớn nhất?
HS trả lời.
? Làm thế nào để tìm nhanh địa chỉ ô có giá trị lớn nhất?
Gọi 1 – 2 em HS lên thực hành.
HS thực hành.
?Nêu các cách tìm giá trị lớn nhất?
HS trả lời.
GV nhận xét câu trả lời, bổ sung nếu thiếu (sai).

GV gọi 1 – 2 em HS lên thực hành.
HS lên thực hành.

Tương tự để tìm giá trị nhỏ nhất ta làm như thế nào?
HS trả lời.
Gọi 1 – 2 em HS lên thực hành.
HS thực hành trên máy tính giáo viên.

	3. Một số hàm trong chương trình bảng tính.
b) Hàm tính trung bình cộng.

- Hàm tính trung bình cộng dùng để tính một dãy các số. Có tên là Average







Cách 1: 
= Average(Giá trị 1, giá trị 2,……,giá trị n) 
Cách 2:
= Average(Địa chỉ ô 1, địa chỉ ô 2,…, địa chỉ ô n)
Cách 3: 
=Average(Địa chỉ ô đầu:địa chỉ ô cuối)































c) Hàm xác định giá trị lớn nhất.
- Hàm xác định giá trị lớn nhất của một dãy có tên là Max.
- Các cách thực hiện
Cách 1: 
= Max(Giá trị 1, giá trị 2,……… ,giá trị n) 
Cách 2:
= Max(Địa chỉ ô 1, địa chỉ ô 2, ……, địa chỉ ô n)
Cách 3: 
=Max(Địa chỉ ô đầu:địa chỉ ô cuối)




d) Hàm xác định giá trị nhỏ nhất.
- Hàm xác định giá trị nhỏ nhất của một dãy số là: Min.

- Các cách thực hiện:
+ Cách 1: 
= Min(Giá trị 1, giá trị 2,……… ,giá trị n) 
+ Cách 2:
= Min(Địa chỉ ô 1, địa chỉ ô 2, ……, địa chỉ ô n)
+ Cách 3: 
=Min(Địa chỉ ô đầu:địa chỉ ô cuối)

	Hoạt động 2: Bài tập 
GV hướng dẫn HS làm các bài tập 2, 3 trong SGK.

HS suy nghĩ và trả lời.
	 


  	4. Củng cố. 
		- GV đưa ra một bảng dữ liệu.
	
	A
	B
	C
	D

	1
	15
	7
	8
	9

	2
	1000
	5
	6
	7

	3
	8
	25
	8
	7

	4
	9
	12
	7
	9


· Thực hiện tính các phép tính sau:
a) Tính trung bình cộng của cột C, D.
b) Tìm giá trị lớn nhất trong bảng.
c) Tìm giá trị nhỏ nhất trong bảng.
   	5. Hướng dẫn học sinh học ở nhà.
		- Về nhà tự làm thêm một số ví dụ với các số liệ tuỳ ý, bằng cách sử 
		dụng các hàm đã học trong bài học.
		- Về nhà làm học cũ và chuẩn trước bài thực hành 4 “Bảng điểm 
của em”.
	IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
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BẢNG ĐIỂM CỦA LỚP EM

I. Mục tiêu.
	1. Kiến thức.
		- Học sinh biết cách nhập và sử dụng các hàm Sum, Average trên trang 
		tính.
	2. Kỹ năng.
		- Thực hiện được tính tổng và tính trung bình cộng qua việc sử dụng 
		hàm.
	3. Thái độ.
		- Có thái độ nghiêm túc trong giờ thực hành.
II. Chuẩn bị của giáo viên và học sinh
	1. Chuẩn bị của giáo viên.
	    - Giáo án, SGK, máy tính, phòng máy.
	2. Chuẩn bị của học sinh.
	    - Đồ dùng học tập, SGK, vở ghi, chuẩn bị bài trước ở nhà.
     	III. Tiến trình dạy học.
1. Ổn định lớp.
	2. Kiểm tra bài cũ.
	    Câu 1: Nhập dữ liệu vào các ô sau:
	
	
	 A
	B
	C
	D
	E

	1
	 7
	  9
	 10
	6
	

	2
	8
	8
	9
	8
	

	3
	9
	8
	5
	7
	


a) Tính tổng của khối ô từ A1 đến D3.
b) Tìm giá trị nhỏ nhất của khối ô  từ A1 đến D3.
c) Tìm giá trị lớn nhất của khối ô từ A1 đến D3.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	 Hoạt động 1 

GV giới thiệu mục đích yêu cầu của bài thực hành.



GV chia nhóm thực hành.
HS tiến hành chia nhóm để thực hành.

	1. Mục đích, yêu cầu.


	Hoạt động 2 

 
GV yêu cầu học sinh khởi động chương trình bảng tính Excel và mở 
























ảng tính có tên  Danh sach lop em đã thực hành trong tiết trước.
HS mở tệp tin có tên là Danh sach lop em.
a) Nhập điểm thi các môn học của lớp em tương tự như được minh hoạ trong hình 30 SGk trang 34.

 GV yêu cầu HS nhập đúng theo trong SGK.
HS thực hành trên máy tính.

b) Sử dụng công thức thích hợp để tính điểm trung bình của các bạn lớp em trong cột Điểm trung bình.

GV yêu cầu HS sử dụng công thức để tính điểm trung bình của các bạn trong lớp.
=(8+7+8)/3
HS thực hành.

 
c) Tính điểm trung bình của cả lớp và ghi vào ô dưới cùng của cột điểm trung bình.
 GV hướng dẫn cách thực hiện sử dụng hàm để tính điểm trung bình cộng của cả lớp.
= (F3+F4+F5+…+F15)/13
HS thực hành.

d) Lưu bảng tính với tên Bang diem lop em
GV yêu cầu HS lưu tên của bài tập 1 là: Bang diem cua lop em vào thư mục lớp 7 ở ổ D.
Bước 1: Nháy vào bảng chọn File - > Save (hoặc Save as) -> chọn ổ D -> mở thư mục lớp 7.
Bước 2: Gõ tên vào khung File Name chọn Save.
	Bài tập 1: Lập trang tính và sử dụng công thức.






a) Nhập điểm thi các môn học của lớp em tương tự như được minh hoạ trong hình 30 SGk trang 34.





b) Sử dụng công thức thích hợp để tính điểm trung bình của các bạn lớp em trong cột Điểm trung bình.


=(8+7+8)/3




c) Tính điểm trung bình của cả lớp và ghi vào ô dưới cùng của cột điểm trung bình.




= (F3+F4+F5+…+F15)/13

d) Lưu bảng tính với tên Bang diem lop em




	Bảng điểm lớp em

	Stt
	Họ và tên
	Toán
	Vật lý
	Ngữ văn 
	Điểm trung bình

	1
	Đinh Vạn Hoang An
	8
	7
	8
	7.8

	2
	Lê Thị Hoài An
	8
	8
	8
	8.0

	3
	Lê Thái Anh
	8
	8
	7
	7.6

	4
	Phạm Nh Anh
	9
	10
	10
	9.6

	5
	Vũ Việt Anh
	8
	6
	8
	7.6

	6
	Phạm Thanh Bình
	8
	9
	9
	8.6

	7
	Trần Quốc Bình
	8
	8
	9
	8.4

	8
	Nguyễn Linh Chi
	7
	6
	8
	7.2

	9
	Vũ Xuân Cơng
	8
	7
	8
	7.8

	10
	Trần Quốc Đạt
	10
	9
	9
	9.4

	11
	Nguyễn Anh Duy
	8
	7
	8
	7.8

	12
	Nguyễn Trung Dũng
	8
	7
	8
	7.8

	13
	Trần Hoàng Hà
	8
	8
	7
	7.6

	
	
	Điểm TB cả lớp
	8.1



	Hoạt động 3 

Bài tập 2: Mở bảng tính So theo doi the luc đã lưu trong bài tập 4 của bài thực hành 2 và tính chiều cao trung bình, cân nặng trung bình của các bạn trong lớp em. Lưu trang tính sau khi đã thực hiện các tính toán theo yêu cầu.

GV hướng dẫn HS thực hành.
- Tính chiều cao, cân nặng trung bình của các bạn:
  + Tính chiều cao trung bình:
    = Average(D3:D14)
  + Tính cân nặng trung bình:
   = Average(E3:E14)
HS thực hành trên máy tính.

GV giám sát HS thực hành, chỉ những chỗ sai HS sinh mắc phải.
 
GV yêu cầu HS khi thực hành kết thúc lưu dữ liệu vừa sửa vào bảng tính. Nháy chọn nút lệnh Save trên thanh công cụ.
	Bài tập 2:  SGK trang 35. 









  - Tính chiều cao trung bình:
    = Average(D3:D14)
  - Tính cân nặng trung bình:
   = Average(E3:E14)



   	4. Củng cố. 
	- Nhận xét ưu khuyết điểm của HS trong quá trình thực hành.
    	5. Hướng dẫn học sinh học ở nhà.
	- Về nhà thực hành lại toàn bộ nội dung của bài thực hành.
	- Về nhà làm tiếp bài tập 3, 4 SGK trang 35 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
						Kiểm tra, ngày … tháng 10 năm 2019
Tổ chuyên môn
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Lớp 7a: …/10/2019
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BẢNG ĐIỂM CỦA LỚP EM

	I. Mục tiêu.
	1. Kiến thức.
- Học sinh biết cách nhập và sử dụng các hàm Sum, Average, Min, Max trên trang tính.
	2. Kỹ năng.
- Học sinh biết cách nhập và sử dụng các hàm Sum, Average, Min, Max trên trang tính.
	3. Thái độ.
		- Có thái độ nghiêm túc trong giờ thực hành.
   	II. Chuẩn bị của giáo viên và học sinh.
	1. Chuẩn bị của giáo viên.
	    - Giáo án, SGK, máy tính, phòng máy.
	2. Chuẩn bị của học sinh.
	    - Đồ dùng học tập, SGK, vở ghi, chuẩn bị bài trước ở nhà.
     	III. Tiến trình dạy học.
1. Ổn định lớp.
	2. Kiểm tra bài cũ.
   3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1

a) Sử dụng hàm thích hợp để tính lại các kết quả đã tính trong Bài tập 1 và so sánh với cách tính bằng công thức.
 GV yêu cầu HS khởi động chương trình Excel và mở tệp tin có tên là Bang diem lop em.
HS mở tệp tin có tên là Bang diem lop em.

GV hướng dẫn HS cách tính điểm trung bình của từng bạn.
- Tính điểm trung bình của từng bạn.
=Average(C3:D3,C3,D3)
HS thực hành trên máy tính.

GV yêu cầu HS thực hiện gõ đúng tên hàm.
Chú ý: Chúng ta có thể thực hiện việc sao chép công thức nhằm giảm bớt thao tác tiết kiệm thời gian và nhanh hơn.
Di chuyển chuột vào ô công thức vừa tính điểm trung bình bạn đầu tiên, khi xuất hiện một dấu cộng mầu đen nằm ở góc dưới bên phải của ô ta nhấn và kéo chuột đến vị trí cần thực hiện phép tính.
?HS: Em có nhận xét gì về cách thực hiện phép tính trên?

b) Sử dụng hàm Average để tính điểm trung bình của từng môn học của cả lớp trong hàng điểm trung bình môn học.
GV hướng dẫn HS cách thực hiện. Quan sát và chỉ sai (nếu có) của HS.
- Tính điểm trung bình của từng môn học.
 + Điểm TB môn Toán:
=Average(C3:C15)
 + Điểm TB môn Vật lý;
=Average(D3:D15)
+ Điểm TB môn Ngữ văn:
=Average(E3:E15)
HS thực hành trên máy tính.

c) Hãy sử dụng hàm Max, Min để xác định điểm trung bình cao nhất, điểm trung bình thấp nhất.

?HS: Em hãy thực hiện tìm điểm trung bình cao nhất, điểm trung bình thấp nhất.
GV quan sát, nhận xét và sửa sai nếu có.
- Tìm điểm trung bình cao nhất:
=Max(F3:F15)
- Tìm điểm trung bình thấp nhất:
=Min(F3:F15)
	1. Bài tập 3: Sử dụng hàm Average, Max, Min.


a)






- Tính điểm trung bình của từng bạn.
=Average(C3:D3,C3,D3)


















b)


- Tính điểm trung bình của từng môn học.
 + Điểm TB môn Toán:
=Average(C3:C15)
 + Điểm TB môn Vật lý;
=Average(D3:D15)
+ Điểm TB môn Ngữ văn:
=Average(E3:E15)



c)






- Tìm điểm trung bình cao nhất:
=Max(F3:F15)
- Tìm điểm trung bình thấp nhất:
=Min(F3:F15)









	
Bảng điểm lớp em

	Stt
	Họ và tên
	Toán
	Vật lý
	Ngữ văn
	Điểm trung bình

	1
	Đinh Vạn Hoang An
	8
	7
	8
	7.8

	2
	Lê Thị Hoài An
	8
	8
	8
	8.0

	3
	Lê Thái Anh
	8
	8
	7
	7.6

	4
	Phạm Nh Anh
	9
	10
	10
	9.6

	5
	Vũ Việt Anh
	8
	6
	8
	7.6

	6
	Phạm Thanh Bình
	8
	9
	9
	8.6

	7
	Trần Quốc Bình
	8
	8
	9
	8.4

	8
	Nguyễn Linh Chi
	7
	6
	8
	7.2

	9
	Vũ Xuân Cơng
	8
	7
	8
	7.8

	10
	Trần Quốc Đạt
	10
	9
	9
	9.4

	11
	Nguyễn Anh Duy
	8
	7
	8
	7.8

	12
	Nguyễn Trung Dũng
	8
	7
	8
	7.8

	13
	Trần Hoàng Hà
	8
	8
	7
	7.6

	
	
	Điểm TB cả lớp
	8.1

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	Toán
	Vật lý
	Ngữ văn
	

	
	Điểm trung bình môn
	8.2
	7.7
	8.2
	

	
	
	
	
	
	

	
	
	Điểm TB cao nhât
	9.6

	
	
	Điểm TB thấp nhất
	7.2

	
	
	
	
	
	



	 Hoạt động 2 

GV yêu cầu HS lập trang tính theo hình 31 SGK trang 35.
HS lập trang tính theo hình 31.

GV hướng dẫn HS thực hiện tính tổng giá trị sản xuất theo từng năm.

- Tính tổng sản xuất theo năm.
=Sum(B4:D4)
Thực hiện sao chép công thức xuống các ô cần thực hiện phép tính.
HS thực hành trên máy tính.
- Tính giá trị sản xuất trung bình của từng ngành.
 + Giá trị trung bình của ngành Nông nghiệp:
= Average(B4:B9)
 +Giá trị trung bình của ngành Công nghiệp:
= Average(C4:C9)
 + Giá trị trung bình của ngành Dịch vụ:
= Average(D4:D9)
HS thực hành trên máy tính.
GV giám sát HS thực hành, sửa sai (nếu có), chú ý cho HS nhập đúng hàm.
	Bài tập 2:  Lập trang tính và sử dụng hàm Sum. 







- Tính tổng sản xuất theo năm.
=Sum(B4:D4)





- Tính giá trị sản xuất trung bình của từng ngành.
 + Giá trị trung bình của ngành Nông nghiệp:
= Average(B4:B9)
 +Giá trị trung bình của ngành Công nghiệp:
= Average(C4:C9)
 + Giá trị trung bình của ngành Dịch vụ:
= Average(D4:D9)



   	4. Củng cố.
	- Nhận xét ưu khuyết điểm của HS trong quá trình thực hành.
    	5. Hướng dẫn học sinh học ở nhà.
	- Về nhà ôn lại toàn bộ nội dung của bài lý thuyết từ bài 1 đến 
	bài 4.
	- Về nhà làm bài tập trong  sách giáo khoa để tiết sau làm bài tập.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
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 THAO TÁC VỚI BẢNG TÍNH

I. Mục tiêu.
1. Kiến thức.
    - Học sinh biết cách điều chỉnh độ rộng của cột, độ cao của hàng.
    - Biết cách chèn thêm hoặc xóa bớt cột, hàng.
2. Kỹ năng.
    - Thực hiện được một số  thao tác cơ bản đối với hàng và cột.
3. Thái độ.
    - Học sinh biết được các kĩ năng thao tác với bảng tính.
    - Có thái độ nghiêm túc trong công việc.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, máy tính.
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ.
	Câu 1: Em hãy khởi động phần mềm Earth Explorer và đo khoảng 
cách giữa hai vị trí bất kì trên bản đồ, đọc kết quả đo được.
3. Bài mới.
	Các em đã làm quen với bảng tính và đã biết mỗi ô tính như một hộp chứa dữ liệu. Nếu có một cái hộp rộng 5cm, dài 10cm, cao 5cm muốn bỏ vào đó 10 quyển sách biết rằng mỗi quyển sách có độ dày bằng 1,5cm, dài 20cm, rộng 10cm.
?Hộp đó có chứa hết 10 quyển sách không?Vì sao?
HS hộp đó không chứa hết 10 quyển sách vì độ cao, chiều dài vượt quá độ cao, chiều dài cuẩ cái hộp.
?Vậy em làm thế nào để cất hết 10 quyển sách đó?
HS ta cần thay đổi độ rộng, độ cao của cái hộp.
Bảng tính có chứa chức năng ưu việt đó, muốn chứa hết dữ liệu vào ô ta phải điều chỉnh độ rộng, chiều cao của ô.
Vậy ô tính được điều chỉnh như thế nào ta tìm hiểu bài mới.

	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:  

GV đưa ra một số hình ảnh ví dụ ở SGK.
*Ví dụ: Ô G2 thể hiện ##########
?Điều này có nghĩa là gì?
HS độ rộng của ô hẹp không chứa hết dữ liệu kiểu số.
?Làm thế nào để ô chứa hết dữ liệu?
Điều chỉnh độ rộng của ô cho hợp lí?
?Quan sát hình 33, 34 hãy nhận xét độ rộng của các ô?
Ô A1 có độ rộng hẹp nên dữ liệu kí tự đã tràn sang ô bênh cạnh, cột B1 có độ rộng hẹp nên dữ liệu bị che khuất.
?Quan sát hình 35 hãy nhận xét cách hiển thị?
Nội dung của ô B1 che lấp nội dung của ô A1.
=> Để hiện thị hết nội dung trong ô sao cho cách trình đẹp và khoa học ta cần điều chỉnh độ rộng, hẹp của ô sao cho hợp lí.
GV thao tác mẫu.
?Nêu cách điều chỉnh độ rộng, hẹp của cột, hàng?
























Giả sử có bảng dữ liệu như hình 37, muốn thêm thông tin địa chỉ, lớp vào sau cột B.
?Ta cần phải làm gì?
Đưa thêm cột để nhập địa chỉ, nhập lớp và bảng dữ liệu.
?Đưa như thế nào? 
Đó là cách thêm cột, hàng vào bảng dữ liệu.

	1. Điều chỉnh độ rộng và độ cao hàng.




















- Cách 1:
* Điều chỉnh độ rộng của cột: Đưa con trỏ vào bên phải của tên cột cần mở rộng, kéo chuột sang phải hoặc sang trái để mở rộng hoặc thu hẹp độ rộng của cột.
* Điều chỉnh độ cao của hàng: Đưa con trỏ chuột vào tên hàng cần thay đổi độ cao, kéo chuột lên trên hoặc xuống dưới để thu hẹp hoặc mở rộng độ cao của hàng, cột.
- Cách 2: 
* Bước 1: Chọn cột, hàng cần điều chỉnh.
* Bước 2:
- Nháy chuột vào bảng chọn Format – chọn Rows– chọn Height, sau đó nhập độ cao của hàng cần điều chỉnh cuối cùng chọn OK. 
- Nháy chuột vào bảng chọn Format – chọn Columns– chọn  Width, sau đó nhập độ rộng của cột cần điều chỉnh cuối cùng chọn OK.



	Hoạt động 2:  

Cho HS quan sát hình 38a, 38b trên máy tính kết hợp với quan sát hình ở SGK.

*Hoạt động nhóm:
Dựa vào các hình và kiến thức ở SGK:
- Nhóm 1: Tìm hiểu cách chèn thêm hàng.
- Nhóm 2: Tìm hiểu cách chèn thêm cột.
- Nhóm 3: Tìm hiểu cách xóa cột, hàng.
* Đại diện nhóm 1 trình bày-> cả lớp nhận xét, bổ sung.
GV chốt lại bằng thao tác mẫu trên máy.
Gọi 1 – 2 HS lên thực hành.



*Chú ý: Cột mới được chèn vào bên trái ô được chọn.

* Đại diện nhóm 2 trình bày và thực hành trên máy -> Cả lớp nhận xét, bổ sung.
GV nhận xét câu trả lời và thực hành mẫu lại thao tác trên máy.
Giả sử với bảng dữ liệu trên không cần cột địa chỉ nữa ta phải làm gì?



*Lưu ý:  Nếu em chọn nhiều ô của một hàng, nhiều ô của một cột thì khi chèn sẽ được số cột, hàng bằng với số em đã chọn.

*Đại diện nhóm 3 trình bày và thao tác trên máy -> cả lớp  nhận xét, bổ sung.
?Hãy nhận xét bảng dữ liệu vừa được xóa?
Dữ liệu của cột đó được xóa sạch nhưng cột đó vẫn còn.
GV để xóa được cột, hàng ta cần thực hiện lệnh xóa.
GV thao tác mẫu.

	2. Chèn thêm hoặc xóa cột, hàng.
a) Chèn thêm cột hoặc hàng.










* Chèn thêm cột:
- B1: Nháy chuột vào ô của cột cần chèn.
- B2: Nháy chuột vào bảng chọn Insert – chọn Columns.
 







* Chèn thêm hàng:
- B1: Nháy chuột vào ô của hàng cần chèn.
- B2: Chọn Insert – chọn Rows.












* Xóa cột hoặc hàng.
- B1: Chọn cột, hàng cần xóa.
- B2: Nháy chuột vào bảng chọn Edit – chọn Delete.


4. Củng cố.
	- Gọi 1 – 2 HS lên thực hành lại toàn bộ nội dung của bài học.
5.  Hướng dẫn học sinh học ở nhà. 
- Về nhà học bài cũ và chuẩn bị bài mới xem tiếp bài 5, mục 3 và 4 để   tiết sau học.
      - Làm bài tập 1, 2 trong SGK trang 44.
IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
     Ngày ……. tháng ….. năm 201…
Kiểm tra của tổ chuyên môn
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CÁC THAO TÁC VỚI BẢNG TÍNH

I. Mục tiêu.
1. Kiến thức.
    - Học sinh biết cách sao chép và di chuyển dữ liệu trên bảng tính.
    - Biết cách sao chép công thức.
2. Kỹ năng.
    - Biết cách sao chép, di chuyển dữ liệu và công thức trên bảng tính.
3. Thái độ.
    - Học sinh hiểu được sự thay đổi của địa chỉ ô khi sao chép công thức.
    - Có thái độ nghiêm túc trong công việc.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, máy tính.
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ. 
Câu 1: Em hãy khởi động phần mềm Excel và mở bài “TH4” sau đó chèn thêm hai cột vào trước cột B và ba hàng vào trước hàng 4.
      Câu 2: Điều chỉnh độ rộng, hẹp cho cột sao cho hợp lí và đẹp.
3. Bài mới.	
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	 Hoạt động 1:    

GV khi làm việc với máy tinh ta cần sự trợ giúp của máy tính sao cho thao tác được nhanh, chính xác, bảng tính cho phép ta sao chép, di chuyển dữ liệu nhanh chóng lại rất dễ dàng.
*HS hoạt động theo bàn: Trao đổi nhớ lại kiến thức đã học ở lớp 6 về sao chép, di chuyển kết hợp với nội dung ở SGK trang 40, 41.
?Hãy cho biết các nút lệnh dùng để sao chép, di chuyển mà em biết?
*HS thảo luận theo nhóm: Cách sao chép dữ liệu.
- Đại diện các nhóm trình bày- cả lớp nhận xét, góp ý, bổ sung (nếu còn thiều).
GV thao tác mẫu trên máy tính.
Gọi 1 – 2 HS lên thực hành.







*Lưu ý: Nhấn phím Esc để loại bỏ đường viền xung quanh ô sao chép.
GV đưa ra một văn bản dạng Word rồi tiến hành sao chép.
?Cho biết sự khác nhau giữa sao chép ở Word với Excel.
- ở Excel khi sao chép vùng dữ liệu được bao quanh bởi khung có nét đứt, sao chép xong phải gõ phím Esc để kết thúc.

GV đó là sao chép vậy di chuyển thì như thế nào?
- Di chuyển nội dung ô tính có nghĩa là sao chép toàn bộ nội dung của ô đi nơi khác, đồng thời xóa sạch dữ liẹu của ô ban đầu.
GV thao tác mẫu.
?Em hãy nêu cách di chuyển nội dung ô tính?
	1. Sao chép và di chuyển dữ liệu.
a) Sao chép nội dung ô tính.












- B1: Chọn ô hoặc khối ô có dữ liệu cần sao chép.
- B2: Nháy nút Copy trên thanh công cụ hoặc vào bảng chọn Edit chọn Copy
- B3: Nháy chuột vào ô cần sao chép đến.
- B4: Nháy nút Paste trên thanh công cụ hoặc vào bảng chọn Edit chọn lệnh Paste.










b) Di chuyển nội dung ô tính.






-B1: Chọn ô hoặc khối ô chứa dữ liệu cần di chuyển.
-B2: Nháy nút lệnh Cut hoặc nháy chuột vào bảng chọn Edit chon lệnh Cut.
- B3: Nháy chuột vào ô cần di chuyển đến.
- B4: Nháy nút lệnh Paste trên thanh công cụ hoặc nháy chuột vào bảng chọn Edit rồi chọn Paste.

	 Hoạt động 2:  

GV khi tính toán ta nhập công thức để tính toán nếu các ô tiếp theo cũng tính toàn như vậy, ta nhập công thức như trên và thay vào địa chỉ ô khác.
?Nhập như vậy sẽ như thế nào?
Nhập như vậy sẽ rất lâu, tốn thời gian lại dễ sai sót.
?Có cách nào để thao tác được nhanh, ít tốn thời gian, chính xác lại không sai sót? Bảng tính có tính ưu việt cho phép ta sao chép công thức khi tính toán.

HS quan sát ví dụ ở SGK trang 42 kết hợp với ví dụ của GV trên máy.
HS trao đổi theo bàn: Đưa ra nhận xét kết quả khi sao chép nội dung của ô chứa công thức.
* Đại diện cặp trinhg bày – cả lớp nhận xét, góp ý, bổ sung.
GV thao tác mẫu trên máy.
? Nêu các bước thực hiện sao chép.














- Gọi 1 – 2 HS thực hành thao tác sao chép công thức.
- Khi sao chép công thức đến vị trí mới ta thấy công thức đã bị điều chỉnh theo địa chỉ ô, ta gọi là địa chỉ tương đối.
- Địa chỉ tương đối có nghĩa là không cố định có thể thay đổi để phù hợp với điều kiện cần. Ta cũng có thể di chuyển toàn bộ công thức đến vị trí khác.
GV khi ta di chuyển nội dung các ô có chứa công thức cs nghĩa là đem toàn bộ dữ liệu có trong ô đến vị trí khác.
?Hãy nêu cách di chuyển văn bản ở Word?
?Quan sát và cho biết khi ta di chuyển dữ liệu đích có còn không?
- Khi ta di chuyển dữ liệu đích không còn mà nó được đưa đến vị trí mới.
*Hoạt động nhóm: Tìm hiểu cách di chuyển công thức và cho nhận xét.
- Đại diện các nhóm trình bày – cả lớp nhận xét, góp ý, bổ sung.
GV khi di chuyển đến vị trí mới nội dung và công thức được di chuyển  toàn bộ và không thay đổi còn dữ liệu đích không còn.
GV thao tác mẫu.
? Nêu các bước thực hiện di chuyển?


- Gọi 1 – 2 thực hành.
	 4. Sao chép công thức.
a) Sao chép nội dung các ô có công thức.
















* Cách 1: 
- B1: Chọn ô có công thức cần sao chép.
- B2: Nháy chuột chọn lệnh Copy trên thanh bảng chọn Edit.
- B3: Nháy chuột vào ô cần sao chép đến.
- B4: Nháy nút lệnh Paste trong bảng chọn Edit.
* Cách 2:
- B1: Nháy chuột vào ô cần sao chép công thức.
- B2: Đưa chuột vào ô vuông màu đen nằm ở góc dưới bên phải ô sao cho chuột có dấu cộng (+) nhỏ màu đen.
- B3:  Di chuyển chuột đến vị trí cần sao chép công thức.








b) Di chuyển nội dung các ô có công thức.







* Khi di chuyển nội dung cũng như công thức giữa nguyên không thay đổi, còn dữ liệu nguồn (đích) không còn.
- B1: Chọn ô hoặc khối ô có công thức cần di chuyển.
- B2: Nháy chọn nút lệnh Cut trên thanh bảng chọn Edit.
- B3: Nháy chuột vào ô cần sao chép.
- B4: Nháy nút lệnh trên thanh công cụ hoặc trong bảng chọn Edit.


4. Củng cố.
	- Gọi 1 – 2 HS lên thực hành lại toàn bộ nội dung của bài học.
5.  Hướng dẫn về nhà.
      - Về nhà học bài cũ và chuẩn bị bài mới bài thực hành 5, bài tập 1 và 2 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………




















Ngày soạn: 25/10/2019
Ngày dạy:
Lớp 7a:…./11/2019
Lớp 7b: …./11/2019
Tiết: 22

BỐ TRÍ LẠI TRANG TÍNH CỦA EM

I. Mục tiêu.
1. Kiến thức.
- Học sinh  thực hiện được các thao tác điều chỉnh độ rộng của cột và độ cao của hàng.
- Học sinh thực hiện được các thao tác chèn thêm, xóa hàng, cột đúng vị trí  yêu cầu.
2. Kỹ năng.
    - Thực hiện được các thao tác điều chỉnh với cột, hàng.
    - Thực hiện được các thao tác cơ bản như: Thêm, xóa hàng và cột.
2. Thái độ.
    - Học sinh hứng thú thực hành tìm hiểu về bài học.
    - Học sinh có thái độ nghiêm túc trong giờ thực hành, có ý thức bảo vệ 
    tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK Tin 7, máy tính.
2. Chuẩn bị của học sinh.
    - Chuẩn bị nội dung thực hành trước ở nhà, SGK Tin 7.
III. Tiến trình dạy học.
1. Ổ định lớp. 
2. Kiểm tra bài cũ. 
Câu 1: Em hãy thực hiện thao tác thay đổi độ rộng của 1 cột và độ cao của 1 hàng bất kì trên trang tính.
Câu 2: Em hãy thực hiện thao tác chèn thêm, xóa hàng, cột trên trang tính.
3. Bài mới.	
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Giới thiệu mục đích, yêu cầu của bài thực hành. 
GV giới thiệu mục đích, yêu cầu của bài thực hành trong tiết 29.

	1. Mục đích, yêu cầu.
(SGK – trang 45)

	Hoạt động 2:  
2. Nội dung.
a) Bài tập 1:
GV yêu cầu HS khởi động phần mềm Excel trên máy tính, sau đó mở bảng tính có tên là Bang diem lop em.
a) Chèn thêm một cột trống vào trước cột D (Vật lí) để nhập điểm môn Tin học.
GV hướng dẫn HS thực hành.
- B1: Nháy chuột vào một ô của cột D, sau đó vào bảng chọn insert và chọn Columns.
- B2: Nhập thông tin môn Tin hoc vào cột vừa tạo mới.
	Bảng điểm lớp 7A

	Stt
	Họ và tên
	Toán
	Tin học
	Vật lý
	Ngữ văn
	Điểm TB

	1
	Đinh Vạn Hoàng An
	8
	8
	7
	8
	7.8

	2
	Lê Thị Hoài An
	8
	8
	8
	8
	8.0

	3
	Lê Thị Anh
	7
	8
	6
	7
	7.0

	4
	Phạm Như Anh
	9
	10
	10
	10
	9.8




b) Chèn thêm các hàng trống và điều chỉnh độ rộng cột, độ cao hàng để có trang tính tương tự theo hình 48a.

GV hướng dẫn học sinh thực hành, sửa lỗi học sinh mắc phải trong khi thực hành.
-  B1: Chèn thêm hàng mới, nháy chuột vào bảng chọn Insert chọn Rows. Chọn hàng 3 rồi thực hiện thao tác chèn thêm hàng mới.
- B2: Thêm thông tin về học sinh và các hàng vừa tạo mới.
- B3: Điều chỉnh độ rộng của cột.
c) Kiểm tra công thức: Trong các ô của cột G (ĐTB) xem công thức có đúng không?
GV hướng dẫn học sinh thực hành.
- Kiểm tra công thức: 
   + B1: Nháy đúp chuột vào ô G4 khi đó công thức của ô tính sẽ được 
    hiển thị lên.
   + B2: Kiểm tra công thức nếu chưa đúng thì sửa lại, kết thúc gõ phím 
    Enter.
d) Di chuyển dữ liệu.
GV yêu cầu HS thực hiện thao tác di chuyển dữ liệu của các cột theo như hình 48b trong SGK, trang 46.
- Yêu cầu lưu lại bài tập vừa thực hành.
Gv hướng dẫn HS thực hành, sửa sai nếu có.

	Hoạt động 3:
Bài tập 2: 
GV yêu cầu học sinh mở lại bài tập 1.
a) Di chuyển dữ liệu.
   - Di chuyển dữ liệu ở cột D (Vật lí) sang một cột khác và xóa cột D
     + B1: Chọn dữ liệu cột D (Vật lí) -> Edit -> Cut.
     + B2: Nháy chuột vào ô I1 -> Edit -> Paste.
     + B3: Nháy chuột vào ô của cột D -> Edit -> Delete.
     + B4: Nháy chuột vào ô F5 và sử dụng hàm để tính điểm trung bình.
              =Average(C5:E5) – gõ phím Enter.
     + B5: Sao chép công thức để tính giá trị ĐTB cho các ô còn lại.
b) Chèn thêm cột: Chèn thêm một cột vào sau cột C (Toán) và sao chép toàn bộ dữ liệu của cột I (Vật lí) vào cột mới vừa tạo. Sau đó kiểm tra công thức và rút ra kết luận về việc sử dụng hàm.
- B1: Chèn thêm cột mới vào sau cột C. Insert – Columns.
- B2: Di chuyển dữ liệu từ cột I (Vật lí) -> Edit -> Cut.
- B3: Nháy chuột vào cột D (mới tạo) để dán -> Edit -> Paste.
- B4: Kiểm tra công thức ở cột F, công thức không thay đổi.
* Ưu điểm của việc tính toán bằng hàm nếu có thay đổi thì dữ liệu được cập nhật tự động  theo.
b) Chèn thêm cột vào trước cột G (ĐTB) và nhập thêm điểm của môn công nghệ, sau đó kiểm tra tính chính xác của công thức và rút ra kinh nghiệm.
	Bảng điểm lớp 7ª

	Stt
	Họ và tên
	Toán
	Tin học
	Vật lý
	Ngữ văn
	Điể
 TB

	
	Đinh Vạn Hoàng An
	8
	8
	7
	8
	7.8

	2
	Lê Thị Hoài An
	8
	8
	8
	8
	
.0

	3
	Lê Thị Anh
	7
	8
	6
	7
	7.0

	4
	Phạm Như Anh
	9
	10
	10
	10
	9.8


c) 
GV yêu cầu học sinh thực hành theo nhóm. Hướng dẫn học sinh thực hành, sửa sai (nếu có).
d) Đóng bảng tính, không lưu kết quả thay đổi.
GV hướng dẫn học sinh thực hành.
- Nhận xét ưu khuyết điểm trong quá trình thực hành của học sinh.


4. Củng cố.
      - GV nhận xét đánh giá giờ thực hành.
5. Hướng dần học sinh học ở nhà.
     - Về nhà xem lại toàn bộ nội dung thực hành.
     - Xem trước bài tập 3, 4 SGK trang 47, 48 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................
Ngày ...... tháng ....... năm 201…
	        Kiểm tra tổ chuyên môn
		
							


Ngày soạn: 31/10/2019
Ngày dạy:
Lớp 7a: …../11/2019
Lớp 7b: …../11/2019
Tiết: 23


BỐ TRÍ LẠI TRANG TÍNH CỦA EM

I. Mục tiêu.
1. Kiến thức.
- Học sinh  thực hiện được các thao tác điều chỉnh độ rộng của cột và độ cao của hàng.
- Học sinh thực hiện được các thao tác chèn thêm, xóa hàng, cột đúng vị trí  yêu cầu.
- Học sinh thực hiện được các thao tác sao chép và di chuyển dữ liệu, công thức.
2. Kỹ năng.
   - Thực hiện được các thao tác chèn thêm hàng, xóa hàng, cột.
   - Thực hiện được thao tác sao chép và di chuyển dữ liệu, công thức.
3. Tư tưởng, tình cảm.
    - Học sinh hứng thú thực hành tìm hiểu về bài học.
    - Học sinh có thái độ nghiêm túc trong giờ thực hành, có ý thức bảo vệ 
    tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK Tin 7, máy tính.
2. Chuẩn bị của học sinh.
    - Chuẩn bị nội dung thực hành trước ở nhà, SGK Tin 7.
III. Tiến trình dạy học.
1. Ổ định lớp.
2. Kiểm tra bài cũ. 
	Câu 1: Em hãy thực hiện thao tác sao chép nội dung của một ô tính 
          bất kì trên trang tính.
Câu 2: Em hãy thực hiện thao tác di chuyển nội dung của một ô tính điểm môn Tin học ở cột F sang cột H, rồi xóa cột F.
3. Bài mới.	
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: 
Bài tập 3: Thực hành sao chép và di chuyển công thức và dữ liệu.

a) Tạo trang tính mới: 
GV yêu cầu HS khởi động cửa sổ Excel và nhập dữ liệu như sau:



	
	A
	B
	C
	D

	1
	1
	2
	3
	

	2
	4
	
	6
	

	3
	
	
	
	



b) Sử dụng hàm hoặc công thức thích hợp trong ô D1 để tính tổng các số trong các ô A1, B1, C1
GV hướng dẫn HS thực hành.
?Em hãy cho biết để tính tổng ta sửu dụng hàm nào?
- Có hai cách để tính tổng:
  + C1: Sử dụng công thức.
      = A1+B1+C1 gõ Enter để kết thúc.
     Kết quả = 6.
  + C2: Sử dụng hàm.
     = Sum(A1:C1) gõ Enter để kết thúc.
    Kết quả = 15.
c) Sao chép ô D1 vào các ô D2, E1, E2 và E3.
- Sao chép công thức sang ô D2 dữ liệu được cập nhật tự động (tính tổng của khối từ A2 đến C2)
=Sum(A2:C2) -> Kết quả = 15.
- Sao chép sang ô E1 công thức tự động điều chỉnh thành =Sum(A1:D1) -> Kết quả = 11.
- Sao chép sang ô E2 công thức tự động điều chỉnh thành = Sum(B2:D2) -> Kết quả = 26.
- Sao chép ô sang ô E3 công thức tự động điều chỉnh thành = Sum(B3:D3) -> Kết quả = 0 (Kết quả bằng 0 vì chưa có dữ liệu nhập vào, nếu ta nhập dữ liệu vào thì lập tức có kết quả ngay)
*Nhận xét: Bảng tính có ưu việt nếu ta sử dụng hàm và địa chỉ ô để tính toán sao chép hoặc di chuyển dữ liệu được tự động cập nhật theo.

d) Sao chép nội dung.
- Sao chép nội dung ô A1 vào khối ô H1:J4. -> Toàn bộ dữ liệu của ô A1 lần lượt được sao chép vào từng ô của cả khối ô H1 đến J4.
- Sao chép khối A1:A2 vào các khối A5:A7; B5:B8;C5:C9.
  + Sao chép vào khối A5:A7 dữ liệu chí 
  dán hai ô A5, A6.
  + Sao chép vào khối B5:B8 dữ liệu 
  được sao chép lặp lại 1, 4, 1, 4.
  + Sao chép vào khối C5:C9 dữ liệu chỉ dán vào hai ô C5, c6.

GV hướng dẫn HS thực hành, sửa lỗi nếu học sinh mắc phải
	Bài tập 3: Thực hành sao chép và di chuyển công thức và dữ liệu.
a) Tạo trang tính mới.








b) Sử dụng hàm hoặc công thức thích hợp trong ô D1 để tính tổng các số trong các ô A1, B1, C1











c) Sao chép ô D1 vào các ô D2, E1, E2 và E3.




















d) Sao chép nội dung.
















	Hoạt động 2:  
Bài tập 4: Thực hành chèn và điều chỉnh độ rộng cột, độ cao hàng.

	
	A
	B
	C
	D
	E
	F
	G

	1
	Danh sách lớp em

	2
	
	
	
	
	
	
	

	3
	Stt
	Họ và tên
	Địa chỉ
	Điện thoại
	Ngày sinh
	Chiều cao
	Cân nặng

	4
	1
	Đinh Vạn Hoàng An
	
	
	12/5/1994
	
.5
	36

	5
	2
	Lê Thị Hoài A
	
	
	1/2/19
5
	1.48
	35

	6
	3
	Lê Thái Anh
	
	
	4/30/1994
	1.58
	39

	7
	4
	Phạm Như Anh
	
	
	2/3/1995
	1.49
	37

	8
	5
	Vũ Việt Anh
	
	
	9/15/1995
	1.52
	36

	9
	6
	Phạm Thanh Bình
	
	
	3/8/1994
	1.5
	38

	10
	7
	Trần Quốc Bình
	
	
	5/6/1994
	1.52
	38

	11
	8
	Nguyễn Linh Chi
	
	
	3/1
/1993
	1.4
	37

	12
	9
	Vũ Xuân Cương
	
	
	7/5/1994
	1.51
	38

	13
	10
	Nguyễn Anh Duy
	
	
	5/9/1994
	1.51
	39



 GV yêu cầu HS thực hiện chèn và điều chỉnh độ rộng cột, độ cao hàng theo hình 51 SGK trang 48.
- Lưu bài thực hành.
GV:
- Hướng dẫn HS thực hành, sửa lỗi HS mắc phải nếu có.
- Nhận xét ưu khuyết điểm trong quá trình thực hành của học sinh.


4. Củng cố. 
      - GV đánh giá  và nhận xét giờ thực hành.
5. Hướng dần học sinh học ở nhà.
     - Về nhà xem lại toàn bộ nội dung thực hành.
     - Xem lại toàn bộ các bài tập ở SGK trang và sách bài tập để tiết sau 
     làm bài tập
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................








Ngày soạn: 31/10/2019
Ngày dạy:
Lớp 7a: …../11/2019
Lớp 7b: …../11/2019
Tiết: 24

BÀI TẬP
I. Mục tiêu.
1. Kiến thức.
    - Hướng dẫn học sinh làm một số bài tập ở SGK và sách bài tập.
2. kỹ năng.
    - Học sinh biết chỉnh sửa trang tính, biết sử dụng công thức tính toán.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, phấn, bài trình chiếu,....
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập,...
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ
     Câu 1: Thực hiện thao tác điều chỉnh độ rộng của cột, độ cao của hàng.
     Câu 2: Thực hiện thao tác sao chép, di chuyển nội dung ô tính.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:       
GV hướng dẫn HS và cùng giải các bài tập ở SGK.
 
	1. Trả lời câu hỏi ở SGK.


	Hoạt động 2: 
Bài tập 1: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùn
	10
	8
	8
	?


a) Nhập biểu mẫu như trên.
b) Sử dụng hàm tính ĐTB của ba môn trên.


c) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai.

d) Tìm người có ĐTB cao nhất và điểm trung bình thấp nhất.










Bài tập 2: Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Thực hiện điều chỉnh độ rộng của cột và độ cao của hành thật hợp lý và đẹp.
- Chèn thêm 3 dòng và 2 cột.





- Di chuyển nội dung của ô E4 sang ô G3.




- Xóa cột D (môn sử).


- Di chuyển cột ĐTB sang cột F

	2. Bài tập 1.






a) Nhập biểu mẫu như trên.
b) Tính ĐTB.
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
c) Chèn thêm cột ngữ văn.
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.
d)
* Tìm ĐTB cao nhất.
= Max(E2:E5) – gõ Enter.
Hoặc
= Max(E2,E3,E4,E5) -> gõ Enter.
* Tìm ĐTB thấp nhất.
= Min(E2:E5) – gõ Enter.
Hoặc
= Min(E2,E3,E4,E5) -> gõ Enter.

Bài tập 2:









- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows.
- Chèn thêm 2 cột: Chọn số lượng cột cần sau đó vào Insert – chọn Columns.
- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3.

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete.
- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F.


4. Củng cố. 
      - GV hướng dẫn HS thực hành, sửa lỗi cho HS nếu mắc phải.
      - Đánh giá nhận xét ưu khuyết điểm của các nhóm thực hành.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết từ bài 1 đến bài 5 để tiết sau kiểm tra thực hành 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Kiểm tra, ngày ...... tháng ....... năm 201…
		 Tổ  chuyên môn









Ngày soạn: 8/11/2019
Ngày dạy:
Lớp 7a: …../11/2019
Lớp 7b: …../11/2019
Tiết: 25

BÀI TẬP
I. Mục tiêu.
1. Kiến thức.
    - Hướng dẫn học sinh làm một số bài tập ở SGK và sách bài tập.
2. kỹ năng.
    - Học sinh biết chỉnh sửa trang tính, biết sử dụng công thức tính toán.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, phấn, bài trình chiếu,....
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập,...
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ
     Câu 1: Thực hiện thao tác điều chỉnh độ rộng của cột, độ cao của hàng.
     Câu 2: Thực hiện thao tác sao chép, di chuyển nội dung ô tính.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:       
GV hướng dẫn HS và cùng giải các bài tập ở SGK.
 
	1. Trả lời câu hỏi ở SGK.


	Hoạt động 2: 
Bài tập 1: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùn
	10
	8
	8
	?


a) Nhập biểu mẫu như trên.
b) Sử dụng hàm tính ĐTB của ba môn trên.


c) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai.

d) Tìm người có ĐTB cao nhất và điểm trung bình thấp nhất.










Bài tập 2: Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Thực hiện điều chỉnh độ rộng của cột và độ cao của hành thật hợp lý và đẹp.
- Chèn thêm 3 dòng và 2 cột.





- Di chuyển nội dung của ô E4 sang ô G3.




- Xóa cột D (môn sử).


- Di chuyển cột ĐTB sang cột F

	2. Bài tập 1.






a) Nhập biểu mẫu như trên.
b) Tính ĐTB.
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
c) Chèn thêm cột ngữ văn.
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.
d)
* Tìm ĐTB cao nhất.
= Max(E2:E5) – gõ Enter.
Hoặc
= Max(E2,E3,E4,E5) -> gõ Enter.
* Tìm ĐTB thấp nhất.
= Min(E2:E5) – gõ Enter.
Hoặc
= Min(E2,E3,E4,E5) -> gõ Enter.

Bài tập 2:









- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows.
- Chèn thêm 2 cột: Chọn số lượng cột cần sau đó vào Insert – chọn Columns.
- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3.

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete.
- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F.


4. Củng cố. 
      - GV hướng dẫn HS thực hành, sửa lỗi cho HS nếu mắc phải.
      - Đánh giá nhận xét ưu khuyết điểm của các nhóm thực hành.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết từ bài 1 đến bài 5 để tiết sau kiểm tra thực hành 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
 

Ngày soạn: 8/11/2019
Ngày dạy:
Lớp 7a: …../11/2019
Lớp 7b: …../11/2019
Tiết: 26

BÀI TẬP
I. Mục tiêu.
1. Kiến thức.
    - Hướng dẫn học sinh làm một số bài tập ở SGK và sách bài tập.
2. kỹ năng.
    - Học sinh biết chỉnh sửa trang tính, biết sử dụng công thức tính toán.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, phấn, bài trình chiếu,....
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập,...
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ
     Câu 1: Thực hiện thao tác điều chỉnh độ rộng của cột, độ cao của hàng.
     Câu 2: Thực hiện thao tác sao chép, di chuyển nội dung ô tính.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:       
GV hướng dẫn HS và cùng giải các bài tập ở SGK.
 
	1. Trả lời câu hỏi ở SGK.


	Hoạt động 2: 
Bài tập 1: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	

	4
	Tuấ
	9
	7
	8
	?

	5
	Hùn
	10
	8
	8
	?


a) Nhập biểu mẫu như trên.
b) Sử dụng hàm tính ĐTB của ba môn trên.


c) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai.

d) Tìm người có ĐTB cao nhất và điểm trung bình thấp nhất.










Bài tập 2: Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Thực hiện điều chỉnh độ rộng của cột và độ cao của hành thật hợp lý và đẹp.
- Chèn thêm 3 dòng và 2 cột.





- Di chuyển nội dung của ô E4 sang ô G3.




- Xóa cột D (môn sử).


- Di chuyển cột ĐTB sang cột F

	2. Bài tập 1.






a) Nhập biểu mẫu như trên.
b) Tính ĐTB.
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
c) Chèn thêm cột ngữ văn.
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.
d)
* Tìm ĐTB cao nhất.
= Max(E2:E5) – gõ Enter.
Hoặc
= Max(E2,E3,E4,E5) -> gõ Enter.
* Tìm ĐTB thấp nhất.
= Min(E2:E5) – gõ Enter.
Hoặc
= Min(E2,E3,E4,E5) -> gõ Enter.

Bài tập 2:









- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows.
- Chèn thêm 2 cột: Chọn số lượng cột cần sau đó vào Insert – chọn Columns.
- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3.

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete.
- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F.


4. Củng cố. 
      - GV hướng dẫn HS thực hành, sửa lỗi cho HS nếu mắc phải.
      - Đánh giá nhận xét ưu khuyết điểm của các nhóm thực hành.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết từ bài 1 đến bài 5 để tiết sau kiểm tra thực hành 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
Kiểm tra, ngày ...... tháng ....... năm 201…
		 Tổ  chuyên môn
















Ngày soạn: 15/11/2019
Ngày dạy: …./11/2019
Tiết:27


KIỂM TRA THỰC HÀNH 1 TIẾT

I. Mục tiêu.
1. Kiến thức.
    - Kiểm tra lại kiến thức cơ bản đã học.
2. kỹ năng.
    - Vận dụng kiến thức đã học vào để làm các bài kiểm tra.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án. SGK tin 7, đề kiểm tra.
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7.
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ.
3. Bài mới. 
	GV đưa ra 3 đề kiểm tra.
	HS bốc đề lựa chọn để kiểm tra.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Đề 1
Đề 1:Cho bảng dữ liệu như sau:
	
	A
	B
	C
	D

	1
	
	N
m
	Nữ
	Tổng

	2
	Lớp 6
	8
	25
	?

	3
	Lớp 7
	9
	15
	?

	4
	Lớp 8
	10
	19
	?

	
	Lớp 9
	11
	20
	?


Yêu cầu:
- Sử dụng hàm tính tổng số lượng HS của từng lớp (bao gồm cả Nam và Nữ)
(5 điểm)
- Sử dụng hàm tìm lớp có số lượng HS nhiều  nhất.(5 điểm)

	1. Đề số 1.







- Tính tổng số lượng HS:
=Sum(8,25) -> gõ Enter. (5 điểm) hoặc =sum(B2,C2) – gõ Enter các lớp khác thực hiện tương tự

- Tìm lớp có số lượng HS nhiều nhất: (5 điểm)

= Max(D2:D5) -> gõ Enter.
Hoặc
=Max(D2,D3,D4,D5) -> gõ  Enter.

	Hoạt động 2: Đề số 2.
Đề số 2: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?


a) Sử dụng hàm tính ĐTB của ba môn trên. (5 điểm)



b) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai. (5 điểm)
	2. Đề số 2.







a) Tính ĐTB. (5 điểm)
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
b) Chèn thêm cột ngữ văn.
(5 điểm)
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.

	Hoạt động 3: Đề số 3
Đề số 3:Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Chèn thêm 3 dòng và 2 cột. (2,5 điểm)








- Di chuyển nội dung của ô E4 sang ô G3. (2,5 điểm)




- Xóa cột D (môn sử). (2,5 điểm)




- Di chuyển cột ĐTB sang cột F.
(2,5 điểm)


	3. Đề số 3.








- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows. (1,25 điểm)
- Chèn thêm 2 cột: Chọn số lượng cột cần chèn sau đó vào Insert – chọn Columns. 
(1,25 điểm)

- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3. (2,5 điểm)

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete. (2,5 điểm)


- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F. (2,5 điểm)


4. Củng cố. 
      - GV kiểm tra thực hành của HS.
      - Đánh giá nhận xét ưu khuyết điểm của bài thực hành và cho điểm.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết trong học kì I để tiết sau ôn tập.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
				                               



							


Ngày soạn: 15/11/201 9
Ngày dạy: …./11/2019
Tiết: 28

ÔN TẬP

I. Mục tiêu.
1. Kiến thức.
    - Giúp học sinh ôn lại kiến thức đã học ở học kì I, nhằm khắc sâu kiến    
    thức.
2. Kỹ năng.
    - Hình thành cho học sinh kỹ năng và thao tác với chương trình bảng tính.
3. Thái độ.
     - Học sin có thái độ học tập tích cực, hứng thú với môn học
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
     - Giáo án tin 7, SGK tin 7, máy tính.
2. Chuẩn bị của học sinh.
    - Học bài và chuẩn bị bài ở nhà.
III. Tiến trình dạy học.
1. Ổn định tổ chức.(1 phút)
2. Kiểm tra bài cũ.
3. Bài mới. 
	Hoạt động của giáo viên và học sinh
	Nội dung  chính

	Câu 1: Chương trình bảng tính là gì?








Câu 2: Phân biệt cột, ô, hàng?









Câu 3: Hãy cho biêt các thành phần chính trên trang tính?











Câu 4: Nêu cách chọn đối tượng trên trang tính















Câu 5: Phân biệt cách hiển thị dữ liệu trên trang tính.





Câu 6: Nêu cách nhập công thức, nhập hàm.
















Câu 7: Giả sử ta chọn một khối ô A3:D30. Hãy cho biết ô nào được kích hoạt?

 
Câu 8: Cách nhập hàm nào sau đây là đúng?
a) =Sum(A1,B2,C3)
b) = Sum(A1;B2;C3)
c) =Sum(A1.B2.C3)
d) =Sum(A1=B2=C3)

Câu 9: Cho biết ý nghĩa sử dụng của các hàm sau:
a) Sum
b) Average
c) Max
d) Min



Câu 10: Kí tự đầu tiên cần gõ khi nhập công thức là gì?
a) Dấu cộng.
b) Dấu phẩy.
c) Dấu bằng.
d) Dấu chấm phẩy.

Câu 11: Để chèn thêm một cộ vào  trang tính ta thực hiện dãy lệnh?
a) Format – Cells ->Insert Columns.
b) Table – Insert Cells.
c) Table – Insert Columns.
d) Insert – Columns.
Câu 12: Muốn xóa hẳn một hàng ra khỏi trang tính, ta đánh dấu khối chọn hành này và thực hiện.
a) Nhấn phím Delete.
b) Edit – Delete.
c) Table – Delete.
d) Tools – Delete.

Câu 13: Câu 15. Cho bảng dữ liệu sau.
	
	B
	D
	E
	F
	G

	1
	Tên
	Toán
	Lý
	Địa
	ĐTB

	2
	 Anh
	5
	5
	8
	

	3
	Bình
	7
	9
	7
	

	4
	Chin
	5
	7
	6
	


1) Viết hàm tính điểm trung bình của 3 học sinh trên.
2) Viết hàm tìm điểm trung bình cao nhất. 
3) Viết hàm tìm điểm trung bình thấp nhất. 
	Câu 1:
- Chương trình bảng tính là phần mềm giúp ghi lại dữ liệu dưới dạng bảng và thực hiện tính toán cũng như xây dựng các biểu đô biểu diễn một cách trực quan các số liệu có trong bảng.

Câu 2:
- Cột: được đánh thứ tự liên tiếp từ trái sang phải và bắt đầu từ A, B, C, ….
- Hàng được đánh thứ tự liên tiếp từ trên xuống dưới bắt đầu bằng từ 1, 2, 3, …
- Ô tính là vùng giao nhau giữa cột và hành dùng để chứa dữ liệu. Ví dụ như A3, B5, ..
Câu 3:
- Thanh bảng chọn chứa các bảng chọn.
- Thanh công cụ chứa các nút lệnh.
- Thanh công thức hiển thị dữ liệu, công thức tính toán trong ô được chọn.
- Cột, hàng, ô tính.
- Hộp tên: Hiển thị địa chỉ ô được kích hoạt.
- Khối ô: Gồm các ô được chọn

Câu 4:
- Chọn một ô tính: Nháy chuột vào ô cần chọn.
- Chọn một cột: Nháy chuột vào nút tên cột cần chọn.
- Chọn một hàng: Nháy chuột vào nút tên hàng cần chọn
- Chọn 1 khối ô: Di chuyển chuột để chọn.
- Chọn nhiều khối ô không liền kề: Di chuyển chuột để chọn khối đầu tiên + giữ phím Ctrl + lần chọn các khối tiếp theo.
- Chọn cả trang tính: Nháy chuột vào ô giao nhay giữa tên hàng và tên cột.

Câu 5:
- Dữ liệu kiểu số được căn đều lề phải của ô ở chế độ ngầm định.
- Dữ liệu kiểu kí tự được căn đều lề trái của ô ở chế độ ngầm định.
Câu 6:
- Nhập công thức:
 + B1: Nháy chọn ô cần nhập công thức.
 + B2: Gõ dẫu bằng =
 + B3: Nhập biểu thức hoặc các phép toán.
 + B4: Gõ phím Enter để kết thúc.

- Nhập hàm:
 + B1: Nháy chọn ô cần nhập hàm.
 + B2: Gõ dẫu bằng =
 + B3: Nhập hàm.
 + B4: Nhập địa chỉ ô hoặc số -  Gõ phím Enter để kết thúc.

Câu 7:
Ô A3 là ô được kích hoạt


Câu 8:

a)=Sum(A1.B2.C3)




Câu 9:

a) Sum: Hàm tính tổng.
b) Average: Hàm tính trung bình cộng.
c) Max: Hàm tìm giá trị lớn nhất.
d) Min: Hàm tìm giá trị nhỏ nhất.

Câu 10: 

c) Dấu phẩy.




Câu 11.

d)  Insert – Columns.




Câu 12.

b) Edit – Delete.

Câu 13.
1. Viết hàm tìm điểm  trung bình của 3 em học sinh.
G2=average(D2:F2) hoặc =average(D2;E2;F2) hoặc = average(5;5;8)
G3=average(D3:F3) hoặc =average(D3;E3;F3) hoặc = average(7;9;7)
G4=average(D4:F4) hoặc =average(D4;E4;F4) hoặc = average(6;7;6)
2. ĐTB cao nhất là: 
= Max(G3:G4)
3. ĐTB thấp nhất là : =Min(G3 :G4)



4. Củng cố. (2 phút)
       - Thực hành làm một số bài tập thực hiện tính toán sử dụng hàm trên 
       máy tính nếu học sinh còn vướng mắc.
5. Hướng dẫn học sinh học ở nhà. (2 phút)
     - Yêu cầu học sinh về nhà xem lại nội dung của bài thực hành.
     - Xem lại toàn bộ nội dung của bài học từ bài 1 đến bài 5 để chuẩn bị 
     tốt cho kiểm tra học kì
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………                   
Ngày ......... tháng ......... năm 201...
							Kiểm tra của tổ chuyên môn


























Ngày soạn: 21/11/2019
Ngày dạy:
Lớp 7a: …/11/2019
Lớp 7b:…./11/2019
Tiết: 29

BÀI TẬP
I. Mục tiêu.
1. Kiến thức.
    - Hướng dẫn học sinh làm một số bài tập ở SGK và sách bài tập.
2. kỹ năng.
    - Học sinh biết chỉnh sửa trang tính, biết sử dụng công thức tính toán.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, phấn, bài trình chiếu,....
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập,...
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ.
     Câu 1: Thực hiện thao tác điều chỉnh độ rộng của cột, độ cao của hàng.
     Câu 2: Thực hiện thao tác sao chép, di chuyển nội dung ô tính.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:        
GV hướng dẫn HS và cùng giải các bài tập ở SGK.
 
	1. Trả lời câu hỏi ở SGK.


	Hoạt động 2: 
Bài tập 1: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hù

	10
	8
	8
	?


a) Nhập biểu mẫu như trên.
b) Sử dụng hàm tính ĐTB của ba môn trên.


c) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai.

d) Tìm người có ĐTB cao nhất và điểm trung bình thấp nhất.










Bài tập 2: Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Thực hiện điều chỉnh độ rộng của cột và độ cao của hành thật hợp lý và đẹp.
- Chèn thêm 3 dòng và 2 cột.





- Di chuyển nội dung của ô E4 sang ô G3.




- Xóa cột D (môn sử).


- Di chuyển cột ĐTB sang cột F
	2. Bài tập 1.






a) Nhập biểu mẫu như trên.
b) Tính ĐTB.
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
c) Chèn thêm cột ngữ văn.
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.
d)
* Tìm ĐTB cao nhất.
= Max(E2:E5) – gõ Enter.
Hoặc
= Max(E2,E3,E4,E5) -> gõ Enter.
* Tìm ĐTB thấp nhất.
= Min(E2:E5) – gõ Enter.
Hoặc
= Min(E2,E3,E4,E5) -> gõ Enter.

Bài tập 2:









- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows.
- Chèn thêm 2 cột: Chọn số lượng cột cần sau đó vào Insert – chọn Columns.
- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3.

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete.
- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F.



4. Củng cố. 
      - GV hướng dẫn HS thực hành, sửa lỗi cho HS nếu mắc phải.
      - Đánh giá nhận xét ưu khuyết điểm của các nhóm thực hành.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết từ bài 1 đến bài 5 để tiết sau kiểm tra thực hành 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
				                       










Ngày soạn: 21/11/2019
Ngày dạy:
Lớp 7a: …/11/2019
Lớp 7b:…./11/2019
Tiết: 30

BÀI TẬP
I. Mục tiêu.
1. Kiến thức.
    - Hướng dẫn học sinh làm một số bài tập ở SGK và sách bài tập.
2. kỹ năng.
    - Học sinh biết chỉnh sửa trang tính, biết sử dụng công thức tính toán.
3. Thái độ.
    - Nghiêm túc, tích cực trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin 7, phấn, bài trình chiếu,....
2. Chuẩn bị của học sinh.
    - Vở ghi, SGK tin 7, đồ dùng học tập,...
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
     Câu 1: Thực hiện thao tác điều chỉnh độ rộng của cột, độ cao của hàng.
     Câu 2: Thực hiện thao tác sao chép, di chuyển nội dung ô tính.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:       
GV hướng dẫn HS và cùng giải các bài tập ở SGK.
 
	1. Trả lời câu hỏi ở SGK.


	Hoạt động 2:  
Bài tập 1: Cho bảng dữ liệu như sau.
Bảng điểm của em
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	
	9
	?

	4
	Tuấn
	9
	
	8
	?

	5
	Hù

	10
	8
	8
	?


a) Nhập biểu mẫu như trên.
b) Sử dụng hàm tính ĐTB của ba môn trên.


c) Chèn thêm cột môn Ngoại ngữ vào trước cột môn Sử và tính lại ĐTB nếu ĐTB sai.

d) Tìm người có ĐTB cao nhất và điểm trung bình thấp nhất.










Bài tập 2: Cho bảng dữ liệu như trên.
	
	A
	B
	C
	D
	E

	1
	
	Toàn
	Văn
	Sử
	ĐTB

	2
	Anh
	8
	7
	9
	?

	3
	Bình
	8
	8
	9
	?

	4
	Tuấn
	9
	7
	8
	?

	5
	Hùng
	10
	8
	8
	?



Yêu cầu:
- Thực hiện điều chỉnh độ rộng của cột và độ cao của hành thật hợp lý và đẹp.
- Chèn thêm 3 dòng và 2 cột.





- Di chuyển nội dung của ô E4 sang ô G3.




- Xóa cột D (môn sử).


- Di chuyển cột ĐTB sang cột F

	2. Bài tập 1.






a) Nhập biểu mẫu như trên.
b) Tính ĐTB.
=average(8,7,9) -> gõ Enter.
Hoặc
= average(B2:D2) -> gõ Enter.
c) Chèn thêm cột ngữ văn.
- Insert -> Columns.
- Nhập điểm của môn Ngoại ngữ.
d)
* Tìm ĐTB cao nhất.
= Max(E2:E5) – gõ Enter.
Hoặc
= Max(E2,E3,E4,E5) -> gõ Enter.
* Tìm ĐTB thấp nhất.
= Min(E2:E5) – gõ Enter.
Hoặc
= Min(E2,E3,E4,E5) -> gõ Enter.

Bài tập 2:









- Chèn thêm 3 dòng: Chọn số lượng ô cần chèn sau đó vào bảng chọn Insert – chọn Rows.
- Chèn thêm 2 cột: Chọn số lượng cột cần sau đó vào Insert – chọn Columns.
- Di chuyển ô E4 sang ô G3: Chọn ô E4 sử dụng câu lệnh (hoặc nút lệnh Cut) di chuyển để di chuyển nội dung ô E4 sang ô G3.

- Xóa cột D: Chọn cột D sau đó vào bảng chọn Edit – chọn Delete.
- Di chuyển cột ĐTB sang cột F: Chọn cột F sau đó chọn lệnh di chuyển để thực hiện di chuyển sang cột F.


4. Củng cố. 
      - GV hướng dẫn HS thực hành, sửa lỗi cho HS nếu mắc phải.
      - Đánh giá nhận xét ưu khuyết điểm của các nhóm thực hành.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà ôn lại toàn bộ nội dung bài tập và lý thuyết từ bài 1 đến bài 5 để tiết sau kiểm tra thực hành 1 tiết.
IV. Rút kinh nghiệm sau tiết dạy.
............................................................................................................................................................................................................................................................................................................................................................................................................................................................................................
				                             Ngày ...... tháng .........năm 2001....
							Kiểm tra của tổ chuyên môn




`






Ngày soạn:29/11/2019
Ngày dạy :
Lớp 7a :…./12/2019
Lớp 7b :…./12/2019
Tiết: 31
		             		     KIỂM TRA HỌC KÌ I
I. Mục tiêu.
     1. Kiến thức
- Kiểm tra, đánh giá kiến thức, kĩ năng của học sinh về quá trình học tập 
trong học kì I.
      2. Kỹ năng.
- Thực hành được một số thao tác cơ bản với chương trình bảng tính.
      3. Thái độ.
	- Học sinh có thái độ nghiêm túc, tích cực trong bài thi cử.
II. Chuẩn bị của giáo viên và học sinh.
    1. Chuẩn bị của giáo viên.
	- Giáo án, đề kiểm tra.
    2. Chuẩn bị của học sinh.
	- Ôn tập tốt các bài học trong học kì I.
III. Tiến trình dạy học.
     1. Ổn định lớp.
     2. Kiểm tra bài cũ.
- Nhắc nhở học sinh không sử dụng tài liệu.
     3. Bài mới.
	MA TRẬN ĐỀ:
	                         Möùc ñoä
Noäi dung
	Bieát
	Hieåu
	Vaän duïng
	TỔNG

	
	TN
	TL
	TN
	TL
	TN
	TL
	

	Bài 1. Chương trình bảng tính là gì?
	Câu 1
0.5đ

	
	
	
	
	
	1 Câu

0.5đ

	Bài 2: Các thành phần dữ liệu của trang tính
	
	
	Câu 3
0.5đ
	
	
	
	1 Câu

0.5 đ

	Bài 3: Thực hiện tính toán trên trang  tính.
	
	
	Câu 8
1đ
	
	
	
	1 câu
0.5đ

	Bài 4: Sử dụng các hàm để tính toán
	Câu 7
0,5đ
	
	Câu 2,5,6
1,5đ
	
	Câu 11
5đ
	
	5 Câu

7đ

	Bài 5: Thao tác với bảng tính
	Câu 4,9,10
1.5đ
	
	
	
	
	
	3 Câu 

1.5đ

	TỔNG
	5 Câu

2.5đ
	
	5 Câu

2.5đ
	
	1 Câu 

5đ
	 
	11 Câu

10đ



ĐỀ KIỂM TRA HỌC KỲ I
MÔN: TIN HỌC 7
PHẦN I. TRẮC NGHIỆM (5 điểm)
(Hãy đọc kỹ các câu hỏi sau, khoanh tròn vào những câu cho là đúng nhất, mỗi câu đúng được 1 điểm)
Câu 1. Trong các phần mềm có tên sau, phần mềm nào là phàn mềm chương trình bảng tính?
a) MicroSoft Word				b) MicroSoft Excel
	c) MicroSoft Power Point		d) MicroSoft Access
Câu 2.  Hàm tính trung bình cộng của dãy số có tên là:
a) AVERAGE 	      b) MAX                   c) MIN		       d) SUM
Câu 3. Ở chế độ ngầm định, dữ liệu kí tự được ................... trong ô tính
       a) căn thẳng lề phải	                               b) căn giữa 	                                                                      
       c) căn thẳng lề trái	                                	d) căn thẳng hai lề
Câu 4.  Để chèn thêm cột ta thực hiện lệnh:
a) Insert / Rows			b) Insert / Colmns              
c) Format / Colmns                    d) Format / Rows
Câu 5. Để tính giá trị trung bình cộng của ô A1 , B1, C1,  cách tính nào sau đây là đúng? 
a) =(A1+  C1)/3		     		b) =Max(A1,B1,C1)	
c) =Sum(A1+B1+C1)			d) =Average(A1,B1,C1)
Câu 6. Giá trị của hàm =MIN(1, 6, 5) là:
      	a) 6			b) 5     		c) 1			d) 12
Câu 7. Cách nhập công thức để tính giá trị 144 : 6 - 3 x 5 trong Excel là:
a)  =144:6-3x5		b)  =144/6-3*5	
		c)  =144:6-3*5   	           d)  =144/6-3x5
Câu 8. Để xóa cột, chọn cột cần xóa rồi thực hiện:
a) Nhấn phím Delete 			b) Nhấn phím Enter 
c) Chọn Edit Delete 			d) Vào Format Delete
Câu 9. Cho biết kết quả của hàm sau: = SUM (5, 9, 4)
a)  18                               b)  4 
c)  9                                 d)  6
Câu 10. Cho  giá  trị  ô  A1 = 8, B1 = 4.  Hãy  chọn  kết  quả  của  công  thức  =A1*2 + B1*3
a)  24                           b) 34		
c) 13                           d) 28
PHẦN II. TỰ LUẬN. (5 điểm)
 Câu 15. Cho bảng dữ liệu sau.
	
	A
	B
	C
	D
	E
	F
	G

	1
	STT
	Họ và Tên
	Miệng
	15’
	1 tiết
	Thi HK
	Điểm TB

	2
	1
	Lê Vân Anh
	6
	5
	5
	8
	

	3
	2
	Trần Lê Bình
	7
	7
	9
	7
	

	4
	3
	Nguyễn Hoàng Chinh
	6
	5
	7
	6
	


1) Viết hàm tính điểm trung bình của 3 học sinh trên. (3đ)
	.........................................................................................................................
	.........................................................................................................................
	.........................................................................................................................
2) Viết hàm tìm điểm trung bình cao nhất.  (1 đ)
	.........................................................................................................................
	.........................................................................................................................
3) Viết hàm tìm điểm trung bình thấp nhất. (1 đ)
	.........................................................................................................................
	.........................................................................................................................




 ĐÁP ÁN - BIỂU ĐIỂM:
PHẦN I. TRẮC NGHIỆM
	Chọn
         Câu
	A
	B
	C
	D
	Điểm

	Câu 1
	
	X
	
	
	0,5

	Câu 2
	X
	
	
	
	0,5

	Câu 3
	
	
	X
	
	0,5

	Câu 4
	
	X
	
	
	0,5

	Câu 5
	
	
	
	X
	0,5

	Câu 6
	
	
	X
	
	0,5

	Câu 7
	
	
	X
	
	0,5

	Câu 8
	X
	
	
	
	0,5

	Câu 9
	X
	
	
	
	0,5

	Câu 10
	
	
	
	X
	0,5


PHẦN II. TỰ LUẬN.
	Câu 11
a) Viết hàm tính điểm trung bình của 3 học sinh.
= Average(C2:F2)
= Average(C3:F3)
= Average(C4:F4)
b) Viết hàm tìm điểm trung bình lớn nhất của 5 học sinh.
=Max(G3:G7)
c) Viết hàm tìm điểm trung bình thấp nhất của 5 học sinh.
=Min(G3:G7)

4. Củng cố bài học.	
                      - GV thu bài kiểm tra HS và kiểm tra số lượng bài nộp
      	5. Hướng dẫn học sinh học ở nhà.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
.


Ngày soạn: 29/11/2019
Ngày dạy:
Lớp 7a: …./12/2019
Lớp 7b: …./12/2019
Tiết: 32
		             		
LUYỆN GÕ PHÍM BẰNG TYPING TEST
 

I. Mục tiêu.
1. Kiến thức.
  	       - Hiểu công dụng và ý nghĩa của phần mềm.
   	       - Biết cách khởi động và thoát khỏi phần mềm.
2. Kỹ năng.
    	       - Biết cách khởi động và thoát khỏi phần mềm.
                 - Ôn luyện gõ phím.
3. Thái độ.
     - Có  thái độ nghiêm túc trong giờ học.
II. Chuẩn bị của giáo viên và học sinh.
  1. Chuẩn bị của giáo viên.
	       - Giáo án, SGK, máy tính…
 2. Chuẩn bị của học sinh.
	     - Đồ dùng học tập, sách, vở.
III. Tiến trình dạy học.
 1. Ổn định tổ chức.
           2. Kiểm tra bài cũ.
    	 3. Bài mới.
- Ở lớp 6 các em đã được học luyện gõ phím bằng phần mềm Mario. Để 
           gõ phím nhanh ta luyện như thế nào?
HS: Luyện gõ phím bằng mười ngón.
?Có phần mềm nào khác hỗ trợ luyện gõ phím nữa không?
 	- Ở lớp 7 các em sẽ được học phần mềm mới đó là Typing Test đây cũng là một trong các phần mềm hỗ trợ việc luyện gõ phím nhanh. Vậy cách sử dụng phần mềm như thế nào ta tìm hiểu bài mới.

	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Giới thiệu phần mềm. 

GV: Để luyện gõ phím ta cần hiểu đó là phần mềm gì?
- Phần mềm Typing Test là phần mềm hỗ trợ  việc luyện gõ nhanh các phím bằng cách thông qua một số trò chơi đơn giản nhưng hấp dẫn. Bằng cách chơi với máy tính em sẽ luyện được kỹ năng  gõ bàn phím nhanh bằng mười ngón.

?HS: Để luyện gõ được với phần mềm đầu tiên ta phải làm gì?
 
	1. Giới thiệu phần mềm.






- Phần mềm Typing Test là phần mềm hỗ trợ  việc luyện gõ nhanh các phím bằng cách thông qua một số trò chơi đơn giản nhưng hấp dẫn để rèn luyện kỹ năng gõ bàn phím nhanh bằng mười ngón.


	Hoạt động 2: Khởi động phần mềm. 

?HS: Em hãy nêu cách khởi động phần mềm mà em biết?
 
GV: Thao tác – HS quan sát.
Bước 1: Nháy đúp chuột vào biểu tượng Typing Test Trên màn hình nền.
Bước 2: Gõ tên em vào khung  Enter You Name hoặc lựa chọn tên trong danh sách.
Bước 3: Nháy chuột vào nút Next.
Bước 4: Lựa chọn trò chơi.
Clouds: Trò chơi đám mây.
Wordtris: Gõ chữ cái nhanh.
Bubbles: Trò chơi bong bong.
Abc: Gõ theo bảng chữ cái.
- Lựa chọn 1 trong 4 trò chơi từ dễ đến khó: abc,Clouds, Bubbles, Wordtris – nháy nút Next.
Bước 6: Để sang màn hình tiếp theo. Xong mỗi thao tác luyện gõ ta phải gõ phím Space hoặc phím Enter để sang gõ tiếp.
	2. Khởi động phần mềm.





















	Hoạt động 3: Trò chơi Bubbles 
(bong bong)

GV: Hướng dẫn HS thực hiện các thao tác trong trò chơi – GV thực hành mẫu.
Bước 1: Nháy đúp chuột vào biểu tượng Typing Test trên màn hình nền.
Bước 2: Gõ tên vào khung Enter You Name, chọn Next.
Lưu ý:  Nếu chưa có tên thì gõ tên, nếu đã có tên ròi thì chỉ việc chọn tên rồi gõ Enter.
Bước 3: Lựa chọn trò chơi Bubbles (bong bóng) trong phần chọn game.
Bước 4: Gõ phím bất kì để chơi trò chơi.
Bước 5: Luyện gõ phím bằng cách quan sát  nhanh các chữ cái nằm trong bong bóng để gõ,ưu tiên gõ các bọt khí có màu sắc chuyển động nhanh hơn.
Bước 6: Khi kết thúc trò chơi trong mỗi bài sẽ hiển thị danh sách kết quả về điểm và xếp hạng người chơi.
- Để thoát khỏi phần mềm ta nháy chuột vào nút Close trên màn hình trò chơi.
GV: Hướng dẫn HS thực hành sửa sai (nếu có).
HS: Chú ý quan sát – thực hành.
Gọi 1- 2 HS lên thực hành.

	3. Trò chơi Bubbles  (bong bong).
























	?HS: Khi luyện gõ xong ta phải làm gì? 
HS: Thoát khỏi phần mềm.
?HS: Nêu các cách thoát khỏi phần mềm mà em biết.
 
	4. Thoát khỏi phần mềm.
- Các cách thoát khỏi phần mềm là:
+ Nháy chuột vào nút Close.
+ File – Exit.
+ Alt + F4.


     	4. Củng cố. 
		- HS biết cách khởi động và luyện gõ phĩm nhanh với phần mềm.
		-Yêu cầu 1 – 2 HS lên thực hành lại toàn bộ nội dung bài học.
    	5. Hướng dẫn học sinh học ở nhà. 
		- Về nhà xem lại toàn bộ nội dung bài học.
		- Thực hành lại toàn bộ nội dung bài học.
		- Xem trước nội dung phần 4 của bài  để tiết sau học.
	IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
      Kiểm tra, ngày .... tháng .... năm 201..
                        Tổ chuyên môn




























Ngày soạn: 5/12/2019
Ngày giảng:
Lớp 7a:…/12/2019
Lớp 7b:…/12/2019
Tiết: 33

LUYỆN GÕ PHÍM BẰNG TYPING TEST
 

	I. Mục tiêu.
		1. Kiến thức.
	     - Luyện tập gõ phím bằng cách thông qua các trò chơi abc để luyện gõ 
	     phím.
     - HS  rèn luyện được kỹ năng gõ phím nhanh và chính xác.
		2. Kỹ năng.
   	- Luyện tập gõ phím bằng cách thông qua các trò chơi abc để luyện gõ 
	phím.
               - HS  rèn luyện được kỹ năng gõ phím nhanh và chính xác.
		3. Thái độ.
     - Có thái đọ nghiêm túc trong giờ thực hành, yêu thích môn học.
	II. Chuẩn bị của giáo viên và học sinh.
   	1. Chuẩn bị của giáo viên.
	       - Giáo án, SGK, máy tính…
      	2. Chuẩn bị của học sinh.
	       - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
     	1. Ổn định tổ chức. 
  2. Kiểm tra bài cũ. 
  3. Bài mới.
	Hoạt động của thầy và trò
	Nội dung

	Hoạt động 1: Trò chơi ABC.
 

Khởi động phần mềm Typing Test và vào tập gõ phím với trò chơi ABC. (Bảng chữ cái)
Bước 1: Nháy đúp chuột vào biểu tượng Typing Test trên màn hình nên.

Bước 2: Gõ tên em vào khung Enter You Name, chọn Next.
- Nếu chưa có tên thì gõ tên, nếu đã có tên thì chỉ việc chọn tên rồi nhấn Enter.

Bước 3: Lựa chọn trò chơi ABC  phần chọn Game.

Bước 4: Gõ phím bất kỳ để chơi trò chơi.

Bước 5: Luyện gõ phím theo các kí tự ở vòng tròn 
Bước 6: Khi kết thúc mỗi lần gõ sẽ hiển thị thời gian và số điểm đạt được, để kết thúc ta gõ phím Enter. Khi đó sẽ hiển thị danh sách kết quả.
- Để thoát khỏi phần mềm ta nháy chuột vào nút close trên màn hình trò chơi.

GV: Hướng dẫn HS thực hành, gõ đúng, cách đặt tay trên bàn phím, sửa sai cho học sinh (nếu có).



HS: Thực hành.
	4. Trò chơi ABC (bảng chữ cái)



	4. Củng cố. 
	         - Gọi 1 - 2 em HS lên thực hành lại toàn bộ nội dung bài học.
   	5. Hướng dẫn học ở nhà. 
	        - Về nhà tập luyện gõ bàn phím bằng trò chơi ABC (bảng chữ cái).
	        - Xem trước nội dung phần 5, 6 để tiết sau thực hành.
	 IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 


 


 





Ngày soạn: 5/12/2019
Ngày giảng: 
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Tiết: 34

LUYỆN GÕ PHÍM BẰNG TYPING TEST

	I. Mục tiêu.
		1. Kiến thức.
		    - Luyện tập gõ phím bằng cách thông qua các trò chơi Clouds để 
		   luyện gõ phím.
		2. Kỹ năng. 
		    - Luyện tập gõ phím nhanh thông qua các trò chơi Clouds.
                 - HS  rèn luyện được kỹ năng gõ phím nhanh và chính xác.
		3. Thái độ.
      - Có thái độ nghiêm túc trong giờ thực hành.
	II. Chuẩn bị của giáo viên và học sinh.
      	1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
      	2. Chuẩn bị của học sinh.
                - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
    	1. Ổn định tổ chức.
	2. Kiểm tra bài cũ.
- Gọi 1 – 2 học sinh lên thực hiện lạ thao tác luyện gõ phím với trò chơi chữ ABC.
   	  3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: Trò chơi  Clouds (đám mây).
Khởi động phần mềm Typing Test và vào tập gõ phím với trò chơi Clouds. (đám mây)

Bước 1: Nháy đúp chuột vào biểu tượng Typing Test trên màn hình nên.

Bước 2: Gõ tên em vào khung Enter You Name, chọn Next.
- Nếu chưa có tên thì gõ tên, nếu đã có tên thì chỉ việc chọn tên rồi nhấn Enter.

Bước 3: Lựa chọn trò chơi Clouds (đám mây) trong phần chọn Game.

Bước 4: Gõ phím bất kỳ để chơi trò chơi.

Bước 5: Luyện gõ phím theo các chữ cái nằm bên dưới đám mây
Lưu ý: Gõ đúng chữ hoa, chữ thường.

Bước 6:Gõ xong các kí tự ở mỗi đám mây phải gõ phím cách (Space) để chuyển nhanh sang bóng mây khác. 
Bước 7: Khi kết thúc mỗi bài gõ trò chơi sẽ hiển thị danh sách kết quả về điểm số và xếp hạng người chơi.
- Để thoát khỏi phần mềm ta nháy chuột vào nút close trên màn hình trò chơi.

GV: Hướng dẫn HS thực hành, gõ đúng, cách đặt tay trên bàn phím, sửa sai (nếu có).
HS: Thực hành.
	4. Trò chơi Clouds (đám mây).



     	4. Củng cố. 
	     - Gọi 1 - 2 em HS lên thực hành lại toàn bộ nội dung bài học về gõ 
              phím nhanh với trò chơi Clouds (đám mây).
            5. Hướng dẫn học sinh học ở nhà.
	     -  Về nhà tập luyện gõ bàn phím bằng trò chơi Clouds (đám mây).
	     - Xem trước nội dung phần 6 để tiết sau thực hành.
 IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
					Kiểm tra, ngày ….. tháng …. năm 2019
Tổ chuyên môn
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LUYỆN GÕ PHÍM BẰNG TYPING TEST

	I. Mục tiêu.
		1. Kiến thức.
	       - Luyện tập gõ phím bằng cách thông qua các trò chơi Wordtris (gõ từ 
	       nhanh) để luyện gõ phím.
		2. Kỹ năng. 
	      - Luyện tập gõ phím nhanh thông qua các trò chơi Wordtris (gõ từ 
	     nhanh).
                 - HS  rèn luyện được kỹ năng gõ phím nhanh và chính xác.
		3. Thái độ.
      - Có thái độ nghiêm túc trong giờ thực hành.
	II. Chuẩn bị của giáo viên và học sinh.
      	1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
      	2. Chuẩn bị của học sinh.
                - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
    	1. Ổn định tổ chức.
   	  2. Kiểm tra bài cũ.
- Gọi 1 – 2 học sinh lên thực hiện lạ thao tác luyện gõ phím với trò chơi đám mây.
   	  3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung

	Hoạt động 1: Trò chơi Wordtris (gõ từ nhanh).
GV: Hướng dẫn HS cách khởi động phần mềm và các thao tác của trò chơi.
Khởi động phần mềm Typing Test và vào tập gõ phím với trò chơi Wordtris. (gõ từ nhanh)
Bước 1: Nháy đúp chuột vào biểu tượng Typing Test trên màn hình nên.
Bước 2: Gõ tên em vào khung Enter You Name, chọn Next.
Lưu ý: Nếu chưa có tên thì gõ tên, nếu đã có tên thì chỉ việc chọn tên rồi nhấn Enter.
Bước 3: Lựa chọn trò chơi Wordtris (gõ từ nhanh) trong phần chọn Game.
Bước 4: Gõ phím bất kỳ để chơi trò chơi.
Bước 5: Luyện gõ phím theo các chữ cái nằm trong thanh nằm ngang.
Lưu ý: Gõ đúng chữ hoa, chữ thường.
Bước 6: Gõ xong các kí tự ở mỗi thanh thanh nằm ngang ta gõ phím cách (Space) để chuyển nhanh sang thanh ngang khác. 
- Nếu gõ trượt thanh chữ thì sẽ xuất hiện ở dưới đáy khung, khi gõ thành công thì thanh chữ sẽ biến mất.
Bước 7: Khi kết thúc mỗi bài gõ trò chơi sẽ hiển thị danh sách kết quả về điểm số và xếp hạng người chơi.
- Để thoát khỏi phần mềm ta nháy chuột vào nút close trên màn hình trò chơi.
GV: Hướng dẫn HS thực hành, gõ đúng, cách đặt tay trên bàn phím, sửa sai (nếu có).
HS: Thực hành.
	4. Trò chơi Wordtris (gõ từ nhanh).



     	4. Củng cố. 
	      - Gọi 1 - 2 em HS lên thực hành lại toàn bộ nội dung bài học về gõ 
                phím nhanh với trò chơi Wordtris (gõ từ nhanh).
     	5. Hướng dẫn học ở nhà. 
	     -  Về nhà tập luyện gõ bàn phím bằng những trò chơi đã học.
	     - Xem trước nội dung bài 3: “Thực hiện các tính toán trên trang tính”.
	 IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
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LUYỆN GÕ PHÍM BẰNG TYPING TEST

	I. Mục tiêu.
		1. Kiến thức.
	       - Luyện tập gõ phím bằng cách thông qua các trò chơi Wordtris (gõ từ 
	       nhanh) để luyện gõ phím.
		2. Kỹ năng. 
	      - Luyện tập gõ phím nhanh thông qua các trò chơi.
                 - HS  rèn luyện được kỹ năng gõ phím nhanh và chính xác.
		3. Thái độ.
      - Có thái độ nghiêm túc trong giờ thực hành.
	II. Chuẩn bị của giáo viên và học sinh.
      	1. Chuẩn bị của giáo viên.
	      - Giáo án, SGK, máy tính…
      	2. Chuẩn bị của học sinh.
                - Đồ dùng học tập, sách, vở.
	III. Tiến trình dạy học.
    	1. Ổn định tổ chức.
   	  2. Kiểm tra bài cũ.
   	  3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung

	Hoạt động 1: Trò chơi bong bóng.
Gv yêu cầu học sinh thực hiện trò chơi trên phần mềm máy tính.




Hs thực hiện thực hành theo nhóm.




Hoạt động 2: Trò chơi Bảng chữ cái

Gv yêu cầu học sinh thực hiện trò chơi trên phần mềm máy tính.




Hs thực hiện thực hành theo nhóm.




Hoạt động 3: Trò chơi Đám mây
Gv yêu cầu học sinh thực hiện trò chơi trên phần mềm máy tính.




Hs thực hiện thực hành theo nhóm.


Hoạt động 4: Trò chơi gõ từ nhanh.
Gv yêu cầu học sinh thực hiện trò chơi trên phần mềm máy tính.




Hs thực hiện thực hành theo nhóm.

	1. Trò chơi bong bóng.











2. Trò chơi Bảng chữ cái ABC












3. Trò chơi Đám mây









4. Trò chơi gõ từ nhanh.


     	4. Củng cố. 
	      - Gọi 1 - 2 em HS lên thực hành lại toàn bộ nội dung bài học.
     	5. Hướng dẫn học ở nhà. 
	     -  Về nhà tập luyện gõ bàn phím bằng những trò chơi đã học.
	 IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….					Kiểm tra, ngày … tháng …. năm 201..
							        Tổ chuyên môn
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 ĐỊNH DẠNG TRANG TÍNH

I. Mục tiêu.
     	1. Kiến  thức.
                 - Hiểu được mục đích của việc định dạng trang tính.
                 - Biết được các bước thực hiện định dạng phông chữ, cỡ chữ, kiểu 
	       chữ và chọn màu cho chữ.
                 - Biết thực hiện căn lề trong ô tính.
   2. Kỹ năng.
	       - Thực hiện được thao tác định dạng phông chữ, cỡ chữ, kiểu chữ.
	       - Thực hiện được thao tác căn lề trong ô tính
   3. Thái độ.
	      - Có thái độ nghiêm túc trong học tập.
	      - Có ý thức bảo vệ tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
     1. Chuẩn bị của giáo viên.
	- Giáo án, máy tính, SGK tin học 7.
     	   2. Chuẩn bị của học sinh.
	- Chuẩn bị bài trước ở nhà, SGK tin 7, đồ dùng học tập.
	III. Tiến trình dạy học.
	1. Ổn định tổ chức.
	2. Kiểm tra bài cũ. 
Câu 1.  Khởi động phần mềm  Excel và căn chỉnh độ rộng cho cột.
Câu 2: Thực hiện thao tác chèn một cột, hàng bất kì.
Câu 3: Thực hiện thao tác xóa cột, hàng vừa chèn.
      	3. Bài mới.
		Hoạt động 1: Giới thiệu. (2 phút)
Các em đã học và biết cách tạo được dữ liệu trên ô tính.
GV: Chiếu một tệp bảng tính chưa định dạng – HS quan sát
?Hãy nhớ lại những bài đã thực hành và cho  nhận xét về bố cục
của bảng dữ liệu?
HS: Bảng dữ liệu trông chưa đẹp, cách bố trí nội dung chưa rõ ràng dẫn đến người xem khó hiểu.
GV: Để bảng tính có bố cục đẹp, nội dung được nổi bật, người xem dễ hiểu, dễ nhận ra nội dung ta cần định dạng cho bảng dữ liệu.
?Vậy định dạng như thế nào? Để hiểu rõ vấn đề này ta tìm hiểu nội dung bài mới.	
	Hoạt động giáo viên và học sinh
	Nội dung chính

	Hoạt động 2:  * Chú ý: - Để định dạng nội dung của một ô, khối ô tính em cần chọn ô, khối ô tính đó.
  - Định dạng không làm thay đổi nội dung của ô tính.

GV: Chiếu một bài mẫu có định dạng, kết hợp với quan sát ở SGK – HS quan sát.
?Cho nhận xét định dạng ở bài mẫu với định dạng ở Word?
- Việc định dạng phông chữ, cỡ chữ, màu chữ ở bảng tính và ở Word là như nhau.
* Trao đổi theo cặp.
?Cho biết các chức năng định dạng  văn bản ở Word? 
* Đại diện cặp trình bày – cả lớp nhận xét, góp ý bổ sung.
* GV: Định dạng không làm thay đổi nội dung dữ liệu nó chỉ có tác động  làm thay đổi phông, cỡ, màu chữ.

* HS hoạt động theo bàn.
?Liệt kê các nút lệnh dùng để định dạng văn bản?
* Đại diện bàn trình bày – cả lớp nhận xét, góp ý bổ sung.
GV: Nhận xét bổ sung thêm nếu còn thiếu.
Cho HS quan sát hình 53 SGK trang 50 kết hợp với GV thao tác trên máy.
?Hãy nêu cách thay đổi phông chữ? 

?Nêu cách chọn bảng mã – HS trả lời









- Gọi hai HS thao tác – HS thao tác
- Khi lập bảng tính không chỉ có thay đổi phông chữ mà ta còn có thể làm thay đổi cỡ chữ, kiểu chữ tùy ý.


?Hãy cho biết nút lệnh làm thay đổi cỡ chữ? 
- Nút lệnh Font Size
Gọi hai HS thao tác – HS thao tác
?Nêu các bước thay đổi cỡ chữ.




GV: Chiếu một bảng dữ liệu có định dạng kiểu chữ đậm, nghiêng, gạch chân.
?Hãy nhận xét bảng dữ liệu có những kiểu chữ nào?
- Chữ đậm, chữ nghiêng, chữ gạch chân.
GV: Đây là cách làm thay đổi kiểu con chữ.
?Hãy nêu cách làm thay đổi kiểu chữ bằng cách sử dụng nút lệnh ở Word?
- Sử dụng nút lệnh B, I, U
Gọi hai HS thao tác – HS thao tác


GV: Chiếu một bảng dữ liệu có định dạng màu hữ, màu nền – HS quan sát
?Hãy nhận xét cách tô màu của bảng dữ liệu?
- Vùng dữ liệu được tô màu chữ và màu nền.

	



1. Định dạng phông chữ, cỡ chữ và kiểu chữ:




 a) Thay đổi phông chữ:


* Chú ý: Chọn phông chữ phải phù hợp với bảng mã.
B1: Chọn bảng mã.
   B1.1: Khởi động Vietkey
   B1.2: Lựa chọn.  * Kiểu gõ
           -  Telex
           -  Bỏ dấu tự do
           - Tiếng việt
      * Bảng mã. Ví dụ: 15 Tcv ABC
    B1.3 Chọn Tasbar hoặc luôn nổi
B2: Chọn phông chữ.
    B2.1: Chọn cả trang tính (nháy chuột vào ô giao nhau giữa tên cột và tên hàng)
    B2.2: Chọn phông chữ ở nút lệnh Font
 
b) Thay đổi cỡ chữ:



B1: Chọn ô hoặc khối ô cần thay đổi
B2: C1) Nháy chuột vào nút lệnh  Font Size và chọn cỡ chữ.
        C2) Nháy chuột vào nút lệnh  Font Size và gõ cỡ chữ cần – gõ phím Enter để kết thúc.
   






c) Thay đổi kiểu chữ:      
B1:   Chọn ô hoặc khối ôcần thay đổi
B2: Sử dụng nút lệnh: 
- B: Kiểu chữ đậm
- I:  Kiểu chữ nghiêng
- U: Kiểu chữ gạch chân.
 

	Hoạt động 3:
?Hãy cho biết nút lệnh dùng để định dạng  màu cho chữ?
- Nút lệnh Font color
Gọi hai em thao tác.
?Nêu cách chọn màu phông chữ.
	2. Chọn màu chữ.

B1: Chọn ô hoặc khối ô cần tô màu.
B2: Nháy chọn nút lệnh Font color

	Hoạt động 4: Tìm hiểu cách căn lề trong ô tính.
GV: Chiếu bảng tính có căn lề trái (cột A), phải (cột B), giữa cho các ô tính (cột C).
?Hãy nhận xét cách bố trí dữ liệu trên trang tính?
- Cột A được căn đều về bên trái, cột B căn đều về bên phải, cột C căn giữa.
GV: đây là các kiểu căn lề trong ô tính.
?Hãy cho biết các nút lệnh dùng để căn lề ở Word?
?Nêu cách căn lề cho ô tính? 


GV: Thao tác mẫu về nút lệnh trộng ô và căn dữ liệu vào giữa ô tính – HS quan sát.
Gọi hai em thao tác lại – HS thao tác.
	
3. Căn lề trong ô tính:



B1: Chọn ô hoặc khối ô cần định dạng
B2: Nháy chọn nút lệnh.
 - [image: ] (Left): Căn đều lề trái.
 - [image: ] (Right): Căn đều lề phải.
 - [image: ] (Center): Căn giữa
 - [image: ] (Merge and center): Trộn ô và căn dữ liệu vào giữa. 


Hoạt động 5: Câu hỏi và bài tập. 
	Câu 1:  Lợi ích của việc định dạng dữ liệu trên trang tính: Giúp trình 
	bày trang tính hấp dẫn hơn, cách hiển thị nội dung được rõ ràng hơn.
   Câu 5:- Giả sử ô A1 có nền màu vàng, chữ màu đỏ, ô A3 có nền màu 
trắng và chữ màu đen.
?Nếu sao chép ô A1 vào ô A3 thì ô A3 sẽ nhận kiểu định dạng của 
ô A1 là có nền màu vàng, chữ màu đỏ. Vì khi sao chép ô mới sẽ 
nhận được kiểu định dạng và dữ liệu của ô được sao chép đến.
    	4. Củng cố. 
	       - Cần nắm vững cách chọn bảng mã, chọn phông chữ tiếng việt tương 
	       ứng.
    	       - Định dạng phông chữ, kiểu chữ, cỡ chữ, màu chữ, các kiểu căn lề 
	       trong ô tính.
            5. Hướng dẫn học sinh học ở nhà.
	      - Về làm các bài tập còn lại ở SGK.
	      - Xem tiếp bài 6 phần 4 và 5 để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
	……………………………………………………………………………
	……………………………………………………………………………
	……………………………………………………………………………
	............................................................................................………………











Ngày soạn: 06/ 01 /2020
Ngày giảng: …/01/2020
Tiết: 38

 ĐỊNH DẠNG TRANG TÍNH

	I. Mục tiêu.
     	1. Kiến  thức.
       -  Biết tăng hoặc giảm số, chữ số thập phân của dữ liệu số.
       -  Biết kẻ đường biên và tô màu nền cho ô tính.
             2. Kỹ năng.
	       - Thực hiện được thao tác tăng giảm chữ số thập phân của dữ liệu số.
	       - Thực hiện được thao tác kẻ đường biên và tô màu nền cho ô tính.
            3. Thái độ.
	      - Có thái độ nghiêm túc trong học tập.
	      - Có ý thức bảo vệ tài sản chung của nhà trường.
	II. Chuẩn bị của giáo viên  và học sinh.
     	1. Chuẩn bị của giáo viên.
	       - Giáo án, máy tính, SGK tin học 7.
     	2. Chuẩn bị của học sinh.
	       - Chuẩn bị bài trước ở nhà, SGK tin 7, đồ dùng học tập.
	III. Tiến trình dạy học.
   1. Ổn định tổ chức.
             2. Kiểm tra bài cũ. 
Câu 1.  Em hãy thực hiện thao tác thay đổi cỡ chữ, kiểu chữ trên trang tính?
     	   3. Bài mới.
		Hoạt động 1: 
GV: Chiếu một tệp bảng tính trong đó cột C định dạng phần thập phân có 1 chữ số thập phân, cột D phần thập phân có 5 chữ số, sử dụng công thức như nhau  =A1/B1 vào hai ô C1 và D1
?Hãy nhận xét kết quả ở hai ô C1 và D1?
· Kết quả ở ô C1 có phần thập phân là một chữ số, ô D1 có 5 chữ số thập phân.
?Vì sao lại có hiện tượng này? 
GV: Thực ra kết quả của hai ô này là như nhau chẳng qua khác nhau 
kiểu hiển thị về phần chữ số thập phân.
?Tại sao lại có sự khác nhau về cách hiển thị? Do ta định dạng tăng 
hoặc giảm chữ số thập phân, mà lâu nay ta vẫn gọi là làm trong phần 
thập phân đến mấy chữ số.
GV: Để hiểu rõ cách thực hiện làm tăng hoặc giảm chữ số thập phân ta tìm hiểu mục 4 của bài 6.




	Hoạt động giáo viên và học sinh
	Nội dung

	Hoạt động 2: 
?Hãy cho biết nút lệnh làm tăng hoặc giảm chữ số thập phân ở Word?
- Lên máy chỉ ra các nút lệnh.
GV: - Các nút lệnh có chức năng thực hiện qui tắc làm tròn số phần thập phân. Việc làm này chỉ là để hiển thị số trên ô tính, nhưng giá trị số chứa trong ô được giữ nguyên không thay đổi khi thực hiện các phép tính.
  - GV thao tác mẫu
?Nêu cách làm tăng hoặc giảm chữ số phần thập phân? 

Gọi hai em thao tác.
Chú ý: Để hiển thị tách biệt thanh công cụ chuẩn và thanh công cụ định dạng ta thực hiện.
View → Toolbar → Customize → Options → chọn Show Standard and Formatting Toolbar on Two rows

	4. Tăng hoặc giảm chữ số phần
thập phân của dữ liệu số.
 






B1: Chọn ô hoặc khối ô cần định dạng.
B2:  Nháy chuột vào nút lệnh.
 - [image: ] (Increase Decimals): Tăng chữ số thập phân.
 - [image: ] (Decrease Decimals): Giảm chữ số thập phân.

	
Hoạt động 3: 

GV: Chiếu một bảng dữ liệu có tạo khung và tô màu nền cho vùng dữ liệu
?Hãy nhận xét cách tô màu cho vùng dữ liệu?
- Vùng dữ dữ liệu  được tô màu nền và màu khung.
?Việc tô màu có tác dụng gì?
- Việc tô màu giúp dễ dàng nhận ra các vùng dữ liệu khác nhau, nhìn bố cục đẹp, dễ hiểu, dễ quan sát,…

HS hoạt động theo bàn. Tìm hiểu cách tô màu nền và kẻ đường biên cho ô tính?
Đại diện bàn trình bày → cả lớp nhận xét, góp ý bổ sung


Gọi 1 - 2 HS thao tác.
?Hãy cho biết nút lệnh tạo màu nền ở Word?
GV: Thao tác mẫu.
?Nêu các bước tạo màu nền cho ô tính?



Gọi hai HS thao tác – HS thao tác
	5. Tô màu nền và kẻ đường biên của các ô tính.







a) Kẻ đường biên:
B1: Chọn ô hoặc khối ô cần kẻ đường biên
B2: C1) Nháy chuột vào nút lệnh Border → chọn  All Borders 
      C2) B2.1: Format → Cells →                     
       chọn Border
             B2.2: Chọn kiểu nét ở 
          khung Style, chọn màu cho khung ở Color.
             B2.3: Nháy chọn khung Outline → OK.
b) Tạo màu nền:


B1: Chọn ô hoặc khối ô cần tạo màu nền.
B2: C1) Nhýa chọn nút lệnh Fill Color → chọn màu.
     C2) B2.1: Format → Cells → chọn Patemrns
             B2.2: Chọn màu ở  khung Color → OK


	Hoạt động 5: Câu hỏi và bài tập. 
     Câu 6. (SGK trang 56)
 Kết quả = 4 vì ô được làm tròn đến phần nguyên (Số nguyên).
     Câu 4. (SGK trang 56)
 B1: Chọn khối ô từ B3 đến B10.
			 B2: Format  → Cells → chọn mục Number.
		 B3: Chọn phần thập phân = 0 →  OK.
       	4. Củng cố.
		- Cần nắm vững cách làm tròn chữ số phần thập phân.
		- Kẻ đường biên và tô màu nền cho ô tính.
	5. Hướng dẫn học sinh học ở nhà.
- Về nhà tập thao tác thực hành trước với bài thực hành 6 để tiết sau 
học thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
	……………………………………………………………………………
	……………………………………………………………………………
	……………………………………………………………………………
	……………………………………………………………………………
Kiểm tra, ngày …. tháng … năm 201 ..
       Tổ chuyên môn			 
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TRÌNH BÀY BẢNG ĐIỂM LỚP EM

I. Mục tiêu.
1. Kiển thức.
    - Thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang tính. 
2. Kỹ năng.
     - Thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang 
     tính. 
3. Thái độ.
    - Có thái độ nghiêm túc trong giờ thực hành, có ý thức bảo vệ máy tính.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án, SGK tin 7, máy tính, phòng máy, …
2. Chuẩn bị của học sinh.
	- Chuẩn bị bài trước ở nhà, SGK tin 7, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
           2. Kiểm tra bài cũ.
    Câu 1. Làm tròn chữ số thập phân 15,35967
· Làm tròn đến 1 chữ số thập phân, ba chữ số thập phân, làm tròn 
thành số nguyên.
   		   Câu 2. Tô màu nền cho khối ô từ A1 đến A10 màu xanh, Khối B1 đến 
			B10 màu vàng, C1 đến C10 màu đỏ.	
3. Bài mới.
Học sinh thực hành bài tập 1 SGK trang  57
Bài tập 1. Thực hành định dạng văn bản và số, căn chỉnh dữ liệu, tô 
màu văn bản, kẻ đường biên và tô màu nền.
1. Mở tệp “BAITH4” đã lưu trên máy.   Nháy chọn nút lệnh [image: ] (Open) → 
   mở ổ đĩa D → mở thu mục “LOP7” → chọn tệp “BAITH4” → Open.
2. Thực hiện các định dạng để được trang tính như hình 66 SGK trang 57.
	     - Định dạng phông chữ: 
B1: Khởi động Vietkey
	  B2: Lựa chọn. - Kiểu gõ Telex, bỏ dấu tự do, tiếng việt.
		- Chọn bảng mã ví dụ: 15 TCV ABC.
	   B3: Chọn cả trang tính (nháy chuột vào ô giao nhau giữa tên cột và tên 
hàng)
	  B4: Chọn phông chữ ở nút lệnh Font. Ví dụ: .VnTime.
                - Định dạng kiểu chữ, màu chữ, cỡ chữ, căn lề: 
                  - Định dạng cho tiêu đề của bảng dữ liệu.	 
          + B: Chữ đậm.
		+ I: Chữ nghiêng.
		+ U: Chữ gạch chân
		+  [image: ] : Trộn ô và căn dữ liệu vào giữa.
		+ Font color: Chọn màu xanh đậm
		+ Fill color: Chọn màu vàng nhạt
	       - Định dạng cho tên của các cột trong vùng dữ liệu. 
+ [image: ] (Center): Căn giữa
		+ Font color: Chọn màu đỏ
		+ Fill color: Chọn màu xanh dương.
· Định dạng màu nền cho vùng dữ liệu. B1: Chọn từng khối ô  như ở 
SGK.
             B2: Nháy chọn nút lệnh Fill color → chọn màu.
		- Căn lề cho ô tính. + Cột họ và tên để nguyên (căn trái).
	           + Vùng dữ liệu số: Căn giữa
· Kẻ đường biên cho ô tính
. B1: Chọn vùng dữ liệu từ A1 đến G14.
		  B2:  Format → Cells → chọn Border
	            B3: Lựa chọn. + Chọn kiểu ở khung Style, chọn màu tại khung 
Color
	           B4: Nháy chọn nút Outline → OK.
    3. Quan sát cách trình bày của trang tính , một chưa định dạng, một đã 
        định dạng và cho nhận xét.
- Trang tính đã được định dạng có ưu điểm hơn như: Cân đối, dễ nhận biết, dễ quan sát,…
	        - Các yếu tố định dạng khác biệt là phông chữ, màu chữ, hàng tiêu đề 
của dữ liệu được căn giữa, màu nền và đường biên.
4. Củng cố.
     - Hướng dẫn HS thực hành, thao tác đúng – sửa sai (nếu có).
              - Nhận xét ưu khuyết trong quá trình thực hành của HS.
5. Hướng dẫn học sinh học ở nhà.
                - Về nhà tập định dạng phông, màu, cỡ, kiểu chữ cho ô tính.
	     - Làm bài tập 2 SGK trang 57, 58 để tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………………….…………………..………………………………………………………………….……………..………………………………………………………………………………..…………………………………………….……
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TRÌNH BÀY BẢNG ĐIỂM LỚP EM

I. Mục tiêu.
1. Kiển thức.
    - Thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang tính. 
2. Kỹ năng.
     - Thực hiện được các thao tác căn chỉnh dữ liệu và định dạng trang 
    tính. 
3. Thái độ.
    - Có thái độ nghiêm túc trong giờ thực hành, có ý thức bảo vệ máy tính.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án, SGK tin 7, máy tính, phòng máy, …
2. Chuẩn bị của học sinh.
	- Chuẩn bị bài trước ở nhà, SGK tin 7, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
             Câu 1. Định dạng cột C có số phần thập phân là một chữ số, sau đó 
                  gõ 5 ô của cột C có phần thập phân là 3. Nhận xét kết quả hiển thị 
                  của ô tính?
   		   Câu 2. Chọn phông tiếng việt và gõ vào ô A1 với nội dung “Hôm nay 
             lớp 7 đi học môn tin” sau đó căn giữa cho dữ liệu, tô màu chữ xanh 
             đậm cho nội dung của ô A1.	
3. Bài mới.
Học sinh thực hành bài tập 2 SGK trang  57, 58
Bài tập 2. Thực hành lập trang tính, sử dụng công thức, định dạng, 
căn chỉnh dữ liệu và tô màu.
1) Khỏi động Excel: Nháy đúp chuột vào biểu tượng Excel trên màn hình nền.
2) Lập trang tính với dữ liệu hình 67, 68 SGK trang 58.
3) Lập công thức tính mật độ dân số (người / Km2). E6:   =D6/C6*1000
  (Đổi triệu người ra người và nghìn Km2 ra Km2  1.000)
- Sao chép công thức công thức tính cho các nước còn lại. Nháy chuột vào ô F6 → đưa chuột vào ô vuông màu đên nằm ở góc dưới bên phải ô sao cho chuột có dấu + màu đen  → nháy đúp chuột để sao chép công thức.
		4) - Chèn thêm hàng trống để có hình 68. Insert → Rows.
	  	 	 - Điều chỉnh độ rộng của cột như hình 68.
	  		  - Định dạng cho vùng dữ liệu như hình 68. 
+ Tô màu nền: 
B1) Chọn khối ô cần tô màu nền
			B2) Nháy chọn nút lệnh Fill color → chọn màu.
		+ Trộn ô cho hàng “CÁC NƯỚC ĐÔNG NAM Á”. 
B1) Chọn khối ô từ A2 → F2
			B2) Nháy chọn nút lệnh [image: ] Merge and Center để trộn ô.
		+ Cột STT căn giữa.
		+ Tăng phần thập phân cho cột: diện tích, dân số và cột tỉ lệ dân số 
		(lấy một chữ số thập phân)
			B1) Nháy chọn cột c + Shift + chọn cột D, F
			B2) Nháy chọn nút lệnh [image: ] InCrease Decimal.
		+ Căn giữa cho tiêu đrrf cột của bảng dữ liệu.     
B1) Chọn khối ô từ A4 → F5.
			B2) Nháy chọn nút lệnh Fill color.
		+ Kẻ đường biên cho vùng dữ liệu.  
B1) Chọn khối ô từ A4 → F16
B2) Format → Cell → Border → Color → Chọn màu, Style chọn nét kẻ đường biên.
		5) Lưu bảng tính với tên “CAC NUOC DONG NAM A”
			B1: Nháy chọn nút lệnh [image: ] Save →  mở ổ đĩa D →  mở thư 
                              mục “LOP7”
			B2: Gõ tên tệp vào khung File name 			
                      	chọn Save
4. Củng cố.
     - Hướng dẫn HS thực hành, thao tác đúng – sửa sai (nếu có).
              - Nhận xét ưu khuyết trong quá trình thực hành của HS.
5. Hướng dẫn học sinh học ở nhà.
     - Về tập nhập dữ liệu và định dạng  cho trang tính theo ý em sao cho trang  tính có bố cục đẹp, dễ nhìn, dễ hiểu,…
	     - Xem trước bài 7. Mục 1 và 2 SGK trang 59, 60 để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………..………………………………………………………………....…………
						Kiểm tra, ngày … tháng … năm 201..
							       Tổ chuyên môn
								






Ngày soạn: 2/05/2020
Ngày dạy:
Lớp 7a:.…/05/2020
Lớp 7b:.…/05/2020
Tiết: 41
                                          TRÌNH BÀY VÀ IN TRANG TÍNH

	I. Mục tiêu.
		1. Kiến thức
	- Học sinh hiểu được mục đích của việc xem trang tính trước khi in.
		2. Kỹ năng.
     - Biết cách xem trước khi in.
     - Biết điều chỉnh trang in bằng cách ngắt trang, đặt lề và hướng trang                    
     in.
     - Biết cách in trang tính
	    3. Thái độ.
		     - Có thái độ nghiêm túc trong học tập,
	II. Chuẩn bị của giáo viên và học sinh.
		1. Chuẩn bị của giáo viên.
		- Giáo án, SGK tin quyển 2, máy tính.
	2. Chuẩn bị của học sinh.
	- Chuẩn bị nội dung trước ở nhà.
	III. Tiến trình dạy học.
		1. Ổn định tổ chức.
	      2. Kiểm tra bài cũ. 
	      3. Bài mới
	Hoạt động 1: Giới thiệu. 
GV: Ta soạn dữ liệu nhập vào máy khi cần lấy dữ liệu ra.
?Bằng cách nào để lấy dữ liệu từ máy tính ra giấy? – HS ta sử dụng lệnh in văn bản để lấy ra.
?Nếu soạn nội dung để vậy rồi in ra giấy, em hãy dự đoán xem dữ liệu được in ra sẽ như thế nào?
- Dữ liệu soạn song để vậy và in ra chắc chắn sẽ không hoàn chỉnh, nhìn bố cục được in ra sẽ không đẹp,…
?Vì sao lại có hiện tượng này? – HS trả lời
GV: Vậy để tiện việc in dữ liệu ra giấy đạt yêu cầu người sử dụng lại có bố cục đẹp, nhìn vào dễ hiểu, cách trình bày trang giấy khoa học. Ta cần thao tác kiểm tra dữ liệu trước khi in, thao tác đó thực hiện như thế nào ta tìm hiểu bài mới.
	Hoạt động giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:   

GV: Chiếu bảng dữ liệu đã chuẩn bị sẵn.
Sheet 1: Dữ liệu chưa chỉnh sửa, Sheet 2 dữ liệu đã chỉnh sửa
HS: Quan sát, so sánh rút ra nhận xét về cách trình bày của hai bảng dữ liệu đó.
GV: Cho HS quan sát hình 69 SGK trang 59.
?Hãy nhận xét trang tính hình 69 nếu được in ra sẽ như thế nào?
HS: Dữ liệu không được ngắt trang hợp lí do vậy dữ liệu in ra sẽ có bố cục không đẹp, cách trình bày không khoa học, một cột mới đã phải sang một trang riêng, …
GV: - Để tránh lãng phí, tốn thời gian in ta cần phải xem văn bản trước khi in.
- Đây là thao tác rất cần thiết, là hình thức kiểm tra xem mình sẽ in dữ liệu ra như thế nào, những gì sẽ in ra, in ra có đạt yêu cầu không?, …
?Hãy cho biết nút lệnh dùng để xem trước khi in?

HS: lên máy chỉ nút lệnh [image: ] (Print Preview)
Gọi một thao tác.


* Hoạt động nhóm: ?Tìm hiểu chức năng của các nút lệnh trên cửa sổ Print Preview.
* Đại diện nhóm trình bày → cả lớp nhận xét → góp ý bổ sung.

Gọi hai HS thao tác – HS thao tác.



GV: Xem văn bản trước khi in để kịp thời chỉnh sửa những gì còn sai sót.
 Ví dụ: Dữ liệu chưa được đưa gọn vào trang giấy, sang trang chỉ có một hoặc hai hàng, …
GV: Nếu dữ liệu chưa đạt yêu cầu như còn ở ngoài trang giấy ta cần sử dụng phương pháp ngát trang để đưa dữ liệu vào trang giấy hợp lí.


	










1. Xem trước khi in.








B1: Nháy chọn nút lệnh [image: ] (Print Preview)
B2: Xem văn bản
 - Next: Xem trang tiếp theo.
- Zoom: Phóng to, thu nhỏ khung nhìn.
- Print: In văn bản
- Setup: Định dạng lại trang in
- Previous: Xem trang trước
- Close: Đóng xem trước khi in.


	Hoạt động 2:   
HS: Tìm hiểu nội dung ở SGK 
?Cho biết lệnh điều chỉnh ngắt trang? – 

?Vì sao cần phải sử dụng phương pháp ngắt trang?
- Như hình 69 nếu không sử dụng lệnh ngắt trang hợp lí thì khi in văn bản ra giấy dữ liệu không nằm gọn vào trang giấy, … cách trình bày này không đẹp, không khoa học.
GV: Thao tác mẫu.






GV: Xem trước khi in nếu thấy dữ liệu còn nằm ngoài khung có nét đứt bao quanh ta phải sử dụng phương pháp ngắt trang để điều chỉnh dữ liệu theo yêu cầu.
Gọi 1 – 2 HS tháo tác.

 Ta có thể điều chỉnh ngắt trang bằng cách khác.
 Gọi một HS thao tác.

GV: Nếu không muốn ngắt trang nữa ta có thể hủy việc ngắt trang bằng cách.
Gọi hai HS thao tác.
	2. Điều chỉnh ngắt trang.




C1) B1: View → Page Break Preview
B2: Xuất hiện đường ngắt trang có màu xanh bao quanh.
 - Nếu muốn điều chỉnh trang in tại vị trí nào ta đưa chuột vào biên đường màu xanh sao cho chuột có dạng ↔, ↕ → di chuyển chuột kéo đến vị trí cần → thả chuột.



C2) Nháy phải chuột tại vị trí cần ngắt trang chọn Insert Page Break.

* Hủy việc ngắt trang.
Nháy phải chuột trong vùng dữ liệu chọn Reset All Page Break

	Hoạt động 3

?Để lấy dữ liệu từ máy tính ra giấy ta phải làm gì?
HS: Thực hiện thao tác in văn bản.
?Giả sử muốn in bảng dữ liệu ra giấy theo chiều ngang ta làm thế nào?
HS: Ta phải đặt hướng cho trang giấy trước khi in.
GV: Cho HS quan sát bài mẫu trên máy kết hợp với quan sát hình 74 SGK trang 63 – HS quan sát.
Hoạt động theo nhóm.
?Nêu các bước đặt lề và hướng trang in?
Đại diện nhóm trình bày → cả lớp quan sát, bổ sung ý kiến.
GV: Chốt lại bằng cách thao tác trực tiếp trên máy.









Gọi ba HS thao tác .
	3. Đặt lề và hướng trang giấy.

B1: File  →  Page Setup
B2: Thiết đặt thông số cho trang
 * Page: Chọn hướng trang giấy
- Portraint: Giấy dọc
- Landscape: Giấy ngang
 * Margins: Đặt lề trang
- Top: Lề trên
- Bottom: Lề dưới
- Left: Lề trái
- Right: Lề phải
 * Header/Footer: Tạo tiêu đề
- Custom Header: Gõ nội dung tiêu đề trên
- Custom Footer: Gõ nội dung tiêu đề dưới
- Ngoài ra ta có thể chèn thêm. 
[image: ]

      Số trang      Ngày  Giờ
 * Sheet: Thiết đặt hàng tiêu đề bảng tính cho các trang in.
-  Rows to Repeat at top:                           nháy chuột vào khung → nháy chuột ra hàng tiêu đề của bảng tính.
- Columns to Repeat at left:                            nháy chuột vào khung → nháy chuột ra chọn cột đầu tiên (cột A) của bảng tính.
B3: OK

	Hoạt động 4 

Ta đã định dạng xong trang để in.
?Để in ra giấy ta phải làm gì?
HS: Sử dụng máy in và phương pháp in để in ra giấy
GV: Các bước để in trang tính củng như các bước để in văn bản ở Word.
?Hãy cho biết nút lệnh dùng để in văn bản?
HS: Lên máy chỉ nút lệnh.
?Nêu các bước in văn bản? – HS trả lời
GV: Thao tác mẫu.

Gọi hai HS thao tác – HS thao tác
Ngoài cách in thông thường như trên ta còn có thể in vùng dữ liệu theo yêu cầu
GV: Thao tác mẫu.
Gọi một HS thao tác – HS thao tác.
GV: - Nếu không muốn in vùng dữ liệu theo yêu cầu ta phải hủy vùng in
- GV thao tác mẫu – HS quan sát
Gọi một HS thao tác .
	4. In trang tính.

B1: C1) Nháy nút lệnh [image: ] Print
      C2)  File → Print
B2: Lựa chọn
- All: In toàn bộ các trang dữ liệu.
- Pages:  From                   To            
               In từ trang         Đến          Trang
- Number of copies           Chọn số tờ in cho một trang in 
B3: OK

* In vùng dữ liệu theo yêu cầu.
B1: Chọn vùng dữ liệu cần in
B2: File → Print Area → Set Print Area

* Hủy vùng in theo yêu cầu.
File → Print Area → Clear Print Area


	4. Củng cố. 
- Cần hiểu rõ mục đích trước khi in đó là in cài gì? In vấn đề nào? 
In trang có bố cục như thế nào?, … ta cần xem văn bản tước khi in 
để chỉnh sửa trang in bằng phương pháp ngắt trang hợp lí.
	5. Hướng dẫn học sinh học ở nhà. 
          		- Làm bài tập 1, 2 SGK trang 65
- Xem trước “Bài thực hành 7” để tiết sau thực hành.
    	IV. Rút kinh nghiệm sau tiết dạy
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
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IN DANH SÁCH LỚP EM

I. Mục tiêu.
1. Kiến thức.
	- Định dạng và trình bày trang tính trước khi in.
	- Thiết đặt lề và hướng giấy in.
2. Kỹ năng.
	- Biết kiểm tra trang tính trước khi in.
	- Thiết đặt lề và hướng giấy cho trang in.
	- Biết điều chỉnh các dấu ngắt trang phù hợp với yêu cầu in.
3. Thái độ.
	- Biết sử dụng và vận dụng hỗ trợ học tập của mình.
	- Có ý thức bảo vệ  tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án,phòng máy, bảng tính Bangdiemlopem.
2. Chuẩn bị của học sinh.
	- Chuẩn bị bài trước ở nhà.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ. 
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1: 

- Mở bảng tính Bangdiemlopem.

GV Cài đặt trình điều khiển máy in: Start -> Setting – Printings -> Printers and Faxes -> file -> Add Printer.
GV hướng dẫn HS cách thử và nhận biết tác dụng, tự khám phá các nút lệnh.
GV chia nhóm các nhóm khám  phá -> GV tuyên dương các nhóm xuất sắc.
	Bài tập 1. Kiểm tra trang tính trước khi in



- : xem các trang in

- : phóng to/thu nhỏ trang tính

- : Mở hộp thoại Page Setup để thiết đặt trang in

- : Để xem chi tiết các lề của trang in

- : Chuyển sang chế độ xem trang in với các dấu ngắt trang

- : In trang tính

- : Đóng chế độ xem trước khi in, trở về chế độ bình thường

	Hoạt động 2: 
- Các cách mở hộp thoại Page Setup
GV hướng dẫn HS đặt lề theo yêu cầu bài tập





	2. Bài tập 2. Thiết đặt lề trang in, hướng giấy và điều chỉnh các dấu ngắt trang. 
- Tiếp tục sử dụng trang tính Bang diem                                                                                                                                                                                                                                                                                                                                                                                                                            
a. Đặt lề
- Vào File\Page Setup\ chọn trang Margin, ghi lại các thông số ngầm định tại các ô Top, Bottom, Left, Right
- Thay đổi các thông số, nhấn OK -> Kết quả?
- Đặt KC các lề Top=2, Bottom=1.5, Left=1.5, Right=2, nhấn OK
- Chọn ô Horizontally hoặc Vertically -> Kết quả


4. Củng cố. 
                 - Hướng dẫn HS thực hành → sửa sai (nếu có).
	       - Nhận xét ưu khuyết trong quá trình thực hành của HS.
5. Hướng dẫn học sinh học ở nhà. 
      - Về nhà tập định dạng trang in.
	      - Xem tiếp bài thực hành 7: Bài 3 SGK trang 68, 69 để tiết sau thực 
	     hành.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
Kiểm tra, ngày ….. tháng ….. năm 201…
		Tổ chuyên môn   
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 IN DANH SÁCH LỚP EM
I. Mục tiêu.
1. Kiến thức.
	- Định dạng và trình bày trang tính trước khi in.
	- Thiết đặt lề và hướng giấy in.
2. Kỹ năng.
	- Biết kiểm tra trang tính trước khi in.
	- Thiết đặt lề và hướng giấy cho trang in.
	- Biết điều chỉnh các dấu ngắt trang phù hợp với yêu cầu in.
3. Thái độ.
	- Biết sử dụng và vận dụng hỗ trợ học tập của mình.
	- Có ý thức bảo vệ  tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án,phòng máy, bảng tính Bangdiemlopem.
2. Chuẩn bị của học sinh.
	- Chuẩn bị bài trước ở nhà.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ. 
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:  
GV hướng dẫn HS đặt hướng giấy theo yêu cầu bài tập



GV hướng dẫn HS đặt tỉ lệ theo yêu cầu bài tập



GV hướng dẫn HS đặt khổ giấy theo yêu cầu bài tập

	b. Đặt hướng giấy
- Vào File\Page Setup\ chọn trang Page, ghi nhận thiết đặt ngầm định
- Chọn Landscape\OK->Kết quả?
- Chọn Portrait\OK -> Kết quả?
- ô Adjust to: Điều chỉnh = bao nhiêu % kích thước bình thường
- ô Fit to: Điều chỉnh vừa khít trong bao nhiêu trang
- Đặt khổ giấy tại ô Paper Size
c. Đặt trang đứng và không có tỉ lệ.
- Hiển thị chế độ Page Break Preview
- Điều chỉnh các cột được in hết trên một trang, mỗi trang in khoảng 25 dòng (H80)

	Hoạt động 2:  

- Mở trang tính The luc

- Định dạng trang tính như H81
GV quan sát, sửa sai cho HS (nếu có).
- Yêu cầu HS thực hiện bài tập mục b.

 GV hướng dẫn, quan sát, sửa sai cho HS (nếu có).

- Yêu cầu HS thực hiện bài tập mục c.

	Bài tập 3: Định dạng và trình bày trang tính
- Chọn trang tính Theluc
a. Định dạng trang tính
- Thực hiện định dạng để được trang tính như H81
b. Xem các trang in
- Xem các trang trước in
- Kiểm tra các dấu ngắt trang
- Đặt hướng trang ngang
- Đặt lề thích hợp
- Chọn in nội dung giữa trang giấy theo chiều ngang
c. Lưu bảng tính.

- Nhấn nút hoặc vào File\Save.
- In trang tính.


   4. Củng cố. 
                 - Hướng dẫn HS thực hành → sửa sai (nếu có).
	       - Nhận xét ưu khuyết trong quá trình thực hành của HS.
   5. Hướng dẫn học sinh học ở nhà. 
      - Về tập xem trang trước khi in và in văn bản.
	      - Xem trước bài 8 “Sắp xếp và lọc dữ liệu” phần 1 và 2 để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
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             SẮP XẾP VÀ LỌC DỮ LIỆU.
I. Mục tiêu.
1. Kiến thức.
     - Hiểu được nhu cầu sắp xếp và lọc dữ liệu.
     - Hiểu các bước cần thực hiện sắp xếp, lọc dữ liệu.
2. Kỹ năng.
    - Thực hiện được thao tác sắp xếp và lọc dữ liệu
3. Thái độ.
    - Có thái độ nghiêm túc trong học tập.
   - Có ý thức bảo vệ tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin, máy tính.
2. Chuẩn bị của học sinh.
    - Chuẩn bị trước bài ở nhà, SGK tin, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ. 
		     Câu 1. Thực hiện thao tác xem trước khi in và in bảng tính?
         	3. Bài mới.			
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	  Hoạt động 1: 
- Giả sử trường ta có một danh sách HS khoảng 1.100 em được sắp xếp theo từng khối. Để lấy được danh sách HS yếu của khối 7 theo từng môn giúp nhà trường có hướng phụ đạo.
  ?Có cách nào để lấy dữ liệu? 
- Nếu ta mở danh sách rồi lần lượt di chuyển chuột để chọn hoặc tìm kiếm bằng nệnh Find sau đó Copy ra.
?Theo em thao tác như vậy sẽ như thế nào?
- Thao tác như vậy rất lâu lại thiếu độ chính xác, không khoa học.
 GV: Trong công việc hằng ngày nhiều khi ta cần lấy danh sách ở dạng tên được sắp xếp theo thứ tự A, B, C hoặc lấy ĐTB từ cao xuống thấp.
?Có cách nào để lấy dữ liệu ra nhanh chóng lại chính xác? Phần mềm Excel cho phép tính năng sử dụng phương pháp, sắp xếp, lọc để lấy dữ liệu rất tiện lợi.
- Để hiểu rõ vấn đề này ta tìm hiểu bài mới.
	

	Hoạt động 2:  

GV: Cho HS quan sát H82, H83, H84 SGK trang 70, 71 – HS quan sát và rút ra nhạn xét?
- H82 được sắp xếp cột họ tên theo A, B, C
- H83 ĐTB được sắp xếp từ cao xuống thấp
- H84 hiển thị danh sách HS có ĐTB cao nhất
GV: Cho HS quan sát bài mẫu Sheet 1: dữ liệu chưa được sắp xếp. Sheet 2: dữ liệu đã được sắp xếp
?Hãy nhận xét vì sao ta có được dữ liệu như Sheet 2?
GV: Dữ liệu ở Sheet 2 đã được sắp xếp theo yêu cầu của người dùng.
?Sắp xếp dữ liệu là gì?
GV: Sắp xếp dữ liệu nghĩa là chỉ cần sử dụng lệnh sắp xếp của bảng tính lập tức bảng tính tự động sắp xếp bằng cách hoán đổi vị trí các hàng cho nhau theo yêu cầu người dùng.
GV: Cho HS quan sát H85 SGK trang 71.
* Hoạt động nhóm. 
- Nhóm 1 và 2 tìm hiểu các bước sắp xếp dữ liệu.
- Nhóm 3 và 4 tìm hiểu chức năng của nút lệnh dùng cho sắp xếp
* Đại diện nhóm trình bày → cả lớp nhận xét, góp ý
* GV: Chốt lại bằng cách thao tác mẫu – HS quan sát






Gọi 1 - 2 HS thao tác.
GV: Ngoài cách sắp xếp trực tiếp này ta còn có thể sắp xếp theo yêu cầu (nghĩa là sắp xếp theo điều kiện)
GV: Thao tác mẫu.
Ví dụ: Sắp xếp ĐTB từ cao đến thấp, nếu ĐTB trùng nhau thì sắp xếp theo điểm toán từ thấp đến cao, nếu điểm toán trùng nhau thì sắp xếp theo điểm văn từ cao xuống thấp






Gọi 1 - 2 HS thao tác.
GV: Giả sử muốn lấy số HS  có ĐTB >=8 hoặc HS có ĐTB <=5
? Dây có phải là yêu cầu sắp xếp tăng hoặc giản không?
GV: Lấy dữ liệu kiểu này không phải là sắp xếp tăng hoặc giảm mà lấy theo hai yêu cầu.
?Vậy lấy bằng cách nào? – HS sử dụng phương pháp lọc 
GV: Bảng tính cho phép ta sử dụng phương pháp lọc dữ liệu rất đơn giản lại thuận tiện.
	















1. Sắp xếp dữ liệu.
- Hoán đổi vị trí các hàng theo yêu cầu.





Trước khi sắp xếp cần chú ý:
1. Khối dữ liệu cần sắp xếp.
2. Khoá để sắp xếp (điều kiện cần).
3. Thứ tự cần sắp xếp (tăng hoặc giảm)
* Cách sắp xếp:
C1) B1: Nháy chuột vào một ô của cột cần sắp xếp
B2: Nháy chọn nút lệnh 
  - [image: ] Sort Ascending: Tăng dần
  - [image: ] Sort Descending: Giảm dần
C2) B1: Data → Sort
B2: Lựa chọn
- Sort by: Chọn yêu tiên 1 (ĐK1)
                                     AscendingChọn ĐK 1

                                     Descending
- Then by: Chọn yêu tiên 2 (ĐK2)
                                     AscendingChọn ĐK 2

                                     Descending
- Then by: Chọn yêu tiên 3 (ĐK3)
                                     AscendingChọn ĐK 3

                                     Descending
- Trong đó: + Ascending: Tăng dần
                   + Descending: Giảm dần




	Hoạt động 3:
GV: Lọc dữ liệu nghĩa là thao tác chọn ra các hàng thoả mãn điều kiện cần và bảng tính chỉ hiển thị các hàng thoả mãn điều kiện.
Cho HS quan sát hình 87, 88 SGK trang 72, 73 và bài mẫu (Sheet 1: danh sách chưa lọc, Sheet 2: danh sách đã lọc dữ liệu – HS quan sát và rút ra nhận xét.
Ví dụ: Lọc ra danh sách HS có ĐTB =7 hoặc những HS có ĐTB=4
GV: Thao tác mẫu.
Cho hS quan sát hình 90, 91, 92 SGK trang 74, 75.
GV: Hướng dẫn cách thực hiện lọc dữ liệu .










Gọi HS thao tác.
	2. Lọc dữ liệu.

- Lọc dữ liệu là chọn và hiển thị ra các hàng thoả mãn điều kiện nhất định của người sử dụng.

* Cách thực hiện
B1: Chuẩn bị
     B1.1: Nháy chuột vào ô 
     trong vùng dữ liệu.
     B1.2: Data → Filter → chọn 
      Auto Filter (xuất hiện lưới 
     lọc trên tiêu đề cột)
B2: Lọc (chọn tiêu chuẩn lọc)
     B2.1: Nháy vào nút     trên tiêu đề cột cần lọc
      B2.2: Chọn tiêu chuẩn lọc.
        - All: Hiển thị lại danh 
        sách nguồn
· Top 10: Lọc ra giá trị lớn nhất hoặc nhỏ nhất
   Danh sách từng đối tượng, muốn lọc ối tượng nào thì nháy chuột vào đối tượng đó
B3: Hiển thị toàn bộ danh sách
  Data → Filter → Huỷ dấu tích trước Auto Filter 


     4. Củng cố. 
		- Cần nắm vững cách sắp xếp dữ liệu.
		- Tạo được lưới lọc bằng lệnh Data → Filter →  Auto Filter .
		- Lọc được dữ liệu theo điều kiện.
		- Thoát khỏi chế độ lọc.
     5. Hướng dẫn về nhà. 
- Về nhà tập sắp xếp dữ liệu theo hai nút lệnh Ascending và    
Descending.
- Sắp xếp dữ liệu theo hai điều kiện.
- Tạo lưới lọc và lọc dữ liệu
		- Xem tiếp bài 8 phần 3 để tiết sau học.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….……
					Kiểm tra, ngày ……. tháng …… năm 202…..
							Tổ chuyên môn					











Ngày soạn: 14/05/2020
Ngày dạy:		
Lớp 8a:…/5/2020
Lớp 8b:…/5/2020
Tiết: 45
AI LÀ NGƯỜI HỌC GIỎI
I. Mục tiêu.
1. Kiến thức.
     - Hiểu được các bước cần thực hiện để sắp xếp và lọc dữ liệu.
2. Kỹ năng.
    - Thực hiện được thao tác sắp xếp và lọc dữ liệu
3. Thái độ.
    - Có thái độ nghiêm túc trong học tập.
    - Có ý thức bảo vệ tài sản chung của nhà trường.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin, máy tính.
2. Chuẩn bị của học sinh.
    - Chuẩn bị trước bài ở nhà, SGK tin, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ. 
		Câu 1. Lọc dữ liệu là gì? Hãy nêu các bước cần thực hiện khi lọc dữ liệu?
         	3. Bài mới.			
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:  
GV giới thiệu mục đích yêu cầu cần đạt được của bài thực hành.

	1. Mục đích, yêu cầu.

	Hoạt động 2:   

Bài tập 1: Sắp xếp và lọc dữ liệu.
Sử dụng bảng tính “Bang diem lop em”
a) Thực hiện các thao tác sắp xếp theo điểm các môn học và điểm trung bình.

b) Thực hiện các thao tác lọc dữ liệu để chọn các bạn có điểm 10 môn Tin học.
c) Hãy lọc ra các bạn có điểm trung bình cả năm là một trong 3 điểm cao nhất và các bạn có điểm trung bình là một trong hai điểm thấp nhất.

GV hướng dẫn học sinh thực hành.
HS thực hành dưới sự hướng dẫn học của GV.

	2. Nội dung.
Bài tập 1: Sắp xếp và lọc dữ liệu.
a) Sử dụng các nút lệnh trên thanh công cụ để sắp xếp  [image: ]  Tăng dần - [image: ]  Giảm dần








	Hoạt động 3:   
 
a) Sử dụng bảng tính “Các nước đông nam á” để  thực hành.
b) Hãy sắp xếp theo các nước.
 - Diện tích tăng dần hoặc giảm dân.
- Dân số tăng dần hoặc giảm dần.
- Mật độ dân số tăng dần hoặc giảm dần.
- Tỉ lệ dân số thành thị tăng hoặc giảm dần.

GV hướng dẫn học sinh thực hành.
Sửa sai nếu học sinh vướng mắc phải.

b) Hãy chèn thêm ít nhất một hàng trống vào giữa hai nước ma lai xia và mi an ma. Nháy chọn ô C3 và thực hiện một số thao tác sắp xếp và lọc dữ liệu. Quan sát kết quả nhận được và cho nhận xét.

c) Sử dụng lại trang tính của bài tập 2, hãy chèn thêm ít nhất một cột trống vào giữa cột D và E. Thực hiện các thao tác sắp xếp và lọc dữ liệu tương ứng như câu a)Cho nhận xét về kết quả nhận được.


GV hướng dẫn học sinh thực hành. Sửa sai cho học sinh nếu có 

	 Bài tập 2: Sắp xếp và lọc dữ liệu.


     4. Củng cố. 
		-  Giáo viên nhận xét đánh giá kết quả thực hành của học sinh.
		- Tuyên dương các em thực hành tốt và khuyến khích các em học 
		sinh thực hành chưa được tốt.
     5. Hướng dẫn học sinh học ở nhà. 
- Về nhà xem tiếp phần c của bài tập 2 và bài tập 3 còn lại để tiết 
sau học.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
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KIỂM TRA 1 TIẾT
I. Mục tiêu.
1. Kiến thức.
     - Kiểm tra nội dung kiến thức đã học trong học kì II.
2. Kỹ năng.	
    - Vận dụng kiến thức  đã học trả lời các câu hỏi trong đề kiểm tra.
3. Thái độ.
    - Có thái độ nghiêm túc trong giờ thi.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của thầy.
    - Giáo án, SGK tin, đề kiểm tra.
2. Chuẩn bị của trò.
    - Chuẩn bị trước bài ở nhà, SGK tin, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức. 
2. Kiểm tra bài cũ. 
         	3. Bài mới.
MA TRẬN ĐỀ
	                         Möùc ñoä
Noäi dung
	Bieát
	Hieåu
	Vaän duïng
	TỔNG

	
	TN
	TL
	TN
	TL
	TN
	TL
	

	Bài 1. Chương trình bảng tính là gì?
	Câu 1
0,5đ
	
	
	
	
	
	1 Câu

0,5đ

	Bài 4: Sử dụng hàm để tính toán.
	
	
	
	
	
	Câu 17

2 đ
	1 Câu

2 đ

	Bài 5: Thao tác với bảng tính
	Câu 3

0.5đ
	
	
	
	
	
	1 Câu

0.5đ

	Bài 6. Định dạng trang tính
	Câu 2, 16
1đ
	
	Câu 4

0,5 đ
	
	Câu 5, 7
1đ
	
	5 Câu

2,5đ

	Bài 7. Trình bày và  in trang tính
	Câu 8, 9, 15

1.5đ
	
	Câu 11

0,5đ
	
	
	
	4 Câu 

2đ

	Bài 8. Sắp xếp và lọc dữ liệu.
	Câu 10

0,5 đ
	
	Câu 13

0,5 đ
	
	
	
	2 Câu 

1đ

	Bài 9. Trình bày dữ liệu bằng biểu đồ.
	Câu 6, 14
1đ
	
	Câu 12

0,5 đ
	
	
	
	3 Câu
1.5đ

	TỔNG
	10 Câu

5đ
	
	4Câu

2đ
	
	2Câu 

1đ
	1Câu

2đ
	17 Câu

10đ



I. Trắc nghiệm (5 điểm)
 Khoanh tròn  vào những câu trả lời đúng nhất, mỗi câu đúng được 0,5 điểm 
Câu 1: Để định dạng kiểu chữ đậm, ta sử dụng nút lệnh nào trên thanh công cụ? 
A.  [image: ]		    B.  [image: ]		  C.  [image: ]	 	  D. A và  C đúng.
Câu 2: Để gộp nhiều ô của trang tính thành một ô và thực hiện căn giữa dữ liệu, ta sử dụng nút lệnh nào?
A.  [image: ]			    B.   [image: ]	                   C.  [image: ]		             D.  [image: ] 
Câu 3: Nút lện Font Color dùng để:
A. Định dạng phông chữ.                                         B. Định dạng màu chữ.
C. Định dạng kiểu chữ.                                             D. Định dạng cỡ chữ.
Câu 4: Để xem trước khi in, ta sử dụng nút lệnh nào sau đây?
A. Print                                                                    B. Page Break Preview
C. Fill Color                                                            D. Print Preview 

Câu 5: Nút lệnh  dùng để làm gì?
A. Sắp xếp dữ liệu theo thứ tự tăng dần                   B. Lọc dữ liệu
C. Sắp xếp dữ liệu theo thứ tự giảm dần                  D. Tô màu chữ.
Câu 6: Tiêu chuẩn lọc Top 10 là tiêu chuẩn lọc:
A. Hàng có 10 giá trị cao nhất.                   B. Hàng có 10 giá trị nhỏ nhất.
C. Cột có 10 giá trị cao nhất. 	D. Hàng có 10 giá trị cao nhất   hoặc nhỏ nhất.
Câu 7: Lọc dữ liệu là gì?
A. Chọn và chỉ hiển thị các hàng thỏa mãn các tiêu chuẩn nhất định nào đó.
B. Chọn và chỉ hiển thị các hàng không thỏa mãn các tiêu chuẩn nhất định 
nào đó.
C. Hoán đổi vị trí các hàng để giá trị dữ liệu trong các cột được sắp xếp tăng dần.
A. Hoán đổi vị trí các hàng để giá trị dữ liệu trong các cột được sắp xếp giảm dần.
Câu 8: Để lọc dữ liệu, chúng ta thực hiện qua mấy bước?
A.  4                 B.  3                        C.  2                          D.  1
Câu 9: Để lọc dữ liệu, ở bước chuẩn bị ta thực hiện lệnh nào?
A. Data Filter AutoFilter                         B. Data Filter Show All
C. Data Filter Advanced Filter                D. Data  Sort
Câu 10: Nút sắp xếp tăng dần là nút nào?




A. 		B.		C.			D.	
II. Tự luận (5  điểm)
Câu 11: Cho bảng dữ liệu sau.
	
	A
	B
	C
	D
	E
	F
	G

	1
	STT
	Họ và Tên
	Miệng
	15’
	1 tiết
	Thi HK
	Điểm TB

	2
	1
	Lê Vân Anh
	6
	5
	5
	8
	

	3
	2
	Trần Lê Bình
	7
	7
	9
	7
	

	4
	3
	Nguyễn Hoàng chinh
	6
	5
	7
	6
	


		1) Viết hàm tính điểm trung bình của 3 học sinh trên. (3 đ)
2) Viết hàm tìm điểm trung bình cao nhất.  (1 đ)
   3) Viết hàm tìm điểm trung bình thấp nhất. (1 đ)
ĐÁP ÁN – BIỂU ĐIỂM

I. Phần trắc nghiệm.
	Câu hỏi
	Đáp án

	Câu 1
	a
	
	
	

	Câu 2
	
	b
	
	

	Câu 3
	
	b
	
	

	Câu 4
	
	 
	
	d

	Câu 5
	
	
	c
	

	Câu 6
	
	b
	
	

	Câu 7
	a
	
	
	

	Câu 8
	
	b
	
	

	Câu 9
	
	
	
	d

	Câu 10
	
	
	
	d


II. Phần tự luận.
Câu 11.
a) Viết hàm tính điểm trung bình của 3 học sinh.
= Average(C2:F2)
= Average(C3:F3)
= Average(C4:F4)
b) Viết hàm tìm điểm trung bình lớn nhất của 5 học sinh.
=Max(G3:G7)
c) Viết hàm tìm điểm trung bình thấp nhất của 5 học sinh.
=Min(G3:G7)
4. Củng cố. 
      - Giáo viên thu bài và kiểm tra số bài học sinh nộp.
	      -  Giáo viên nhận xét đánh giá tiết kiểm tra của học sinh.
5. Hướng dẫn học sinh học ở nhà.
                - Về nhà xem  trước bài “Học vẽ hình học động với Geogebra” tiết 
                sau học.
IV. Rút kinh nghiệm sau tiết dạy.
…………………………………………………………………………………
…………………………………………………………………………………
........................…………………………………………………………………
				Kiểm tra, ngày ……. tháng …… năm  201…..
						Tổ chuyên môn
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 TRÌNH BÀY DỮ LIỆU BẰNG BIỂU ĐỒ

	I. Mục tiêu.
1. Kiến thức.
    - Biết mục đích của việc sử dụng dữ liệu biểu đồ
    - Biết một số dạng biểu đồ thường dùng
    - Biết các bước cần thực hiện để tạo biểu đồ từ một bảng dữ liệu
    - Biết cách thay đổi dạng biểu đồ đã được tạo, xoá, sao chép biểu đồ vào Word.
2. Kỹ năng.
    - Thực hiện thành thạo các thao tác với biểu đồ.
3. Thái độ.
    - Hình thành thái độ ham mê học hỏi, yêu thích môn học.
     	II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án,, SGK tin học, Máy tính.
2. Chuẩn bị của học sinh.
    - Nghiên cứu trước bài học ở nhà. 
	III. Tiến trình dạy học.
	  1. Ổn định tổ chức. 
 2. Kiểm tra bài cũ. 
   Câu 1: Sắp xếp dữ liệu trên bảng tính theo chiều tăng dần hoặc giảm      
    dần.
   Câu 2: Lọc dữ liệu những bạn học sinh có điểm trung binh thấp nhất.
           3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1.
GV: Theo em tại sao một số loại dữ liệu lại được biểu diễn dưới dạng biểu đồ?
+ Giới thiệu ứng dụng biểu đồ
+ Quan sát hình minh họa Excel,SGK  hình 96 - 97	
? So sánh số lượng học sinh nam, nữ, tổng cộng qua hàng năm?
?Đánh giá xu thế tăng giảm số lượng HS trên?
?Dữ liệu biểu diễn ở dạng nào ưu điểm hơn?
?Biểu đồ là gì?
?Ưu điểm khi dùng biểu đồ minh hoạ dữ liệu?
	1. Minh hoạ số liệu bằng biểu đồ





Biểu đồ là cách minh hoạ dữ liệu trực quan, giúp dễ so sánh số liệu, dự đoán xu thế tăng giảm của các số liệu.


	Hoạt động 2 
? Trong chương trình phổ thông em đã được học các loại biểu đồ nào? Em có biết tác dụng riêng của mỗi loại biểu đồ ấy không?
? Nêu một số dạng biểu đồ thường gặp?
? Quan sát hình 98, mỗi loại biểu đồ thích hợp với biểu diễn dữ liệu gì?

	2. Một số dạng biểu đồ
- Biểu đồ cột
- Biểu đồ đường gấp khúc
- Biểu đồ hình tròn


	Hoạt động 3 
GV:Giới thiệu cách tạo biểu đồ trên chương trình bảng tính Excel.
- Cần vẽ biểu đồ của bảng dữ liệu theo H99, theo em bước 1 làm gì?
- B2: nhấn nút lệnh gì trên TCC, nhận dạng nút lệnh trên tranh MH Excel?
- QS H100, giới thiệu các thành phần trên cửa sổ theo H100
- B3: thực hiện thao tác gì?
- HS quan sát GV thực hiện vẽ biểu đồ Khối 7 ở bảng tính D:\BTH6.xls                                
	3. Tạo biểu đồ 
3.1 Tạo biểu đồ bằng cách chấp nhận tất cả các thuộc tính ngầm định của biểu đồ
B1: Tạo bảng dữ liệu, Chọn một ô trong bảng dữ liệu

B2: Nhấn nút  (Chart Wizard) trên thanh công cụ -> Xuất hiện hộp thoại Chart Wizard đầu tiên (Có 4 hộp thoại Chart Wizard tương ứng với 4 bước)
B3. Nhấn liên tiếp Next trên các hộp thoại và nhấn nút Finish  trên hộp thoại cuối cùng


         	4. Củng cố. 
    - Cần hiểu rõ mục đích của tạo biểu đồ, khi nào thì cần tạo biểu đồ.
    - Nằm vững các bước để tạo biểu đồ.
    	5. Hướng dẫn học sinh học ở nhà. 
       	    - Về tập tạo biểu đồ so sánh lượng mưa, sản lượng (số liệu tuỳ ý)
	   - Xem tiếp bài 9 phần 4. Chỉnh sửa biểu đồ để tiết sau học.
	   - Làm bài tập 1 đến 4 SGK trang 88
       IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………				
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TRÌNH BÀY DỮ LIỆU BẰNG BIỂU ĐỒ

	I. Mục tiêu.
1. Kiến thức.
    - Biết mục đích của việc sử dụng dữ liệu biểu đồ
    - Biết một số dạng biểu đồ thường dùng
    - Biết các bước cần thực hiện để tạo biểu đồ từ một bảng dữ liệu
    - Biết cách thay đổi dạng biểu đồ đã được tạo, xoá, sao chép biểu đồ 
    vào Word.
2. Kỹ năng.
    - Thực hiện thành thạo các thao tác với biểu đồ.
3. Thái độ.
    - Hình thành thái độ ham mê học hỏi, yêu thích môn học.
     	II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
    - Giáo án, SGK tin học, Máy tính.
2. Chuẩn bị của học sinh.
    - Nghiên cứu trước bài học ở nhà. 
    	III. Tiến trình dạy học
	  1. Ổn định tổ chức. 
           2. Kiểm tra bài cũ.
   Câu 1:  Em hãy thực hiện thao tác tạo biểu đồ trên máy tính.
           3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung

	Hoạt động 1:  




- Yêu cầu mở hộp thoại Chart Wizard Step 1 of 4
- Quan sát hộp thoại và  hình 102
- Giới thiệu các thành phần trên hộp thoại



 
- Quan sát hộp thoại Wizard Step 2 of 4 và H105
- Giới thiệu các thành phần trên hộp thoại
 







- Quan sát hộp thoại Wizard Step 3 of 4 và H106
+ Giới thiệu các thành phần trên hộp thoại
 





- Quan sát hộp thoại Wizard Step 4 of 4 và H105
+ Giới thiệu các thành phần trên hộp thoại
L­u ý t¹i mçi hép tho¹i
+ Nót Finish (KÕt thóc)
+ Nót Back (Quay l¹i)
	3. T¹o biÓu ®å 
3.2 T¹o biÓu ®å b»ng c¸ch thªm th«ng tin trong tõng b­íc khi t¹o biÓu ®å
a. Chän d¹ng biÓu ®å
Trªn hép tho¹i Step 1 of 4 (b­íc 1)
+ T¹i Chart Type: CHän nhãm biÓu ®å
+ T¹i Chart sub-type: chän d¹ng biÓu ®å trong nhãm
+ NhÊn Next ®Ó sang b­íc 2
L­u ý: chän kiÓu biÓu ®å phï hîp víi d÷ liÖu cÇn biÓu diÔn
b. X¸c ®Þnh miÒm d÷ liÖu
Trªn hép tho¹i Step 2 of 4
+ T¹i Data range: Chän miÒn d÷ liÖu cÇn vÏ biÓu ®å (kÐo th¶ chuét trªn trang tÝnh chän miÒm dl)
+ T¹i Seris in:
   Row-Chän d·y dliÖu minh ho¹ theo hµng
   Column- Chän d·y dliÖu minh ho¹ theo cét
+ NhÊn Next ®Ó sang b­íc 3
c. C¸c th«ng tin gi¶i thÝch biÓu ®å
Trªn hép tho¹i Step 3 of 4
- Trang Titles (Tiªu ®Ò)
+ T¹i Chart title: Vµo tiªu ®Ò biÓu ®å
+ T¹i Category (X) axis:  Vµo chó gi¶i cho trôc ngang
+ T¹i Value (Y) axis: Vµo chó gi¶i cho trôc ®øng
d. VÞ trÝ ®Æt biÓu ®å
Trªn hép tho¹i Step 4 of 4
+ T¹i As new sheet: §Æt biÓu ®å trªn trang tÝnh míi
+ T¹i  As objject in: §Æt biÓu ®å trªn trang tÝnh cã b¶ng d÷ liÖu.

	Hoạt động 2: (19 phút)
- Giới thiệu các thao tác chỉnh sửa biểu đồ
- Yêu cầu học sinh đọc TT SGK, trả lời câu hỏi, thực hiện trên máy
? Các bước để thay đổi vị trí biểu đồ?



? Cách lấy hộp thoại trên thanh công cụ Chart?

? Cách xoá biểu đồ?


?Các bước để thay đổi sao chép biểu đồ vào văn bản Word?
	4. Chỉnh sửa biểu đồ


a. Thay đổi vị trí của biểu đồ
Nháy chọn biểu đồ, kéo thả đến vị trí mới
 
c. Xoá biểu đồ
Chọn biểu đồ, nhấn phím Delete
d. Sao chép biểu đồ vào văn bản Word.

B1. Nhấn chuột vào biểu đồ, nhấn nút Copy 

B2. Mở văn bản word, nhấn nút Paste 


         4. Củng cố. 
    - Gọi 1 – 2 học sinh lên thực hiện lại toàn bộ nôi dung bài học.
    5. Hướng dẫn học sinh học ở nhà. 
       	    - Về tập tạo biểu đồ so sánh lượng mưa, sản lượng (số liệu tuỳ ý)
   -  Xem trước nội dung bài thực hành 9 “Tạo biểu đồ để minh họa” để tiết sau học.
     IV. Rút kinh nghiệm sau tiết dạy.
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
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 TẠO BIỂU ĐỒ MINH HỌA

I. Mục tiêu.
1. Kiến thức.
	- Biết nhập các công thức và hàm vào ô tính.
	- Thực hiện các thao tác tạo biểu đồ đơn giản.
2. Kỹ năng.
	- Thực hiện được thao tác tạo các dạng biểu đồ đơn giản.
3. Thái độ.
	- Hình thành thái độ ham mê học hỏi, yêu thích môn học.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án, phòng máy,…
2. Chuẩn bị của học sinh.
	- Chuẩn bị trước nội dung của bài thực hành.
III. Tiến trình dạy học.
1. Ổn đinh tổ chức. 
2. Kiểm tra bài cũ.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1
Yêu cầu học sinh
- Khởi động Excel
- Lập trang tính như H113
- Tạo biểu đồ cột cho bảng dữ liệu
(Chú ý tạo biểu đồ bằng cách chấp nhận tất cả các thuộc tính của biểu đồ)
- Quan sát nhận xét biểu đồ vẽ được
- Di chuyển biểu đồ đến vị trí thích hợp
 - Quan sát H114, chỉnh sửa trang tính để được như H114
- Quan sát, nhận xét sự thay đổi biểu đồ khi chỉnh sửa trang tính
- xoá biểu đồ
- Tạo biểu đồ cột cho bảng dl
(chú ý tạo biểu đồ bằng cách chấp nhận tất cả các thuộc tính của biểu đồ)
- Quan sát nhận xét biểu đồ vẽ được
	Bài tập 1. Lập trang tính và tạo biểu đồ
-  Lập trang tính như  H113
          [image: ]

Yêu cầu: Tạo biểu đồ cột trên cơ sở dữ liệu khối A4:D9 (Biểu đồ biểu diễn cột Lớp-Nam-Nữ-Tổng cộng)

- Lập trang tính như H114
                 [image: ]
Yêu cầu: Tạo biểu đồ cột trên cơ sở dữ liệu khối A4:D9 (Biểu đồ biểu diễn cột Lớp-Nữ-Tổng cộng)


	Hoạt động 2 
Yêu cầu học sinh
- Tạo mới biểu đồ đường gấp khúc
- Thay đổi biểu đồ cột thành biểu đồ đường gấp khúc
- Quan sát nhận xét 2 biểu đồ
- Đóng Excel, lưu tệp HSGK7.xls
	Bài tập 2. Tạo và thay đổi dạng biểu đồ
a.  Tạo mới một biểu đồ đường gấp khúc cho khối A4:C9
b.  Thay đổi biểu đồ cột đã tạo tại Bài tập 1 thành Biểu đồ đường gấp khúc
 So sánh nhận xét



4. Củng cố.
     - Giáo viên hướng dẫn học sinh thực hành, sửa sai (nếu có).
5. Hướng dẫn học sinh học ở nhà.
     - Yêu cầu về nhà xem lại nội dung của bài thực hành.
     - Xem trước bài tập 3, để chuẩn bị tiết sau thực hành.
IV. Rút kinh nghiêm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………….…..………………………
Kiểm tra, ngày ……. tháng …… năm  2020.
						Tổ chuyên môn
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TẠO BIỂU ĐỒ MINH HỌA

I. Mục tiêu.
1. Kiến thức.
	- Biết nhập các công thức và hàm vào ô tính.
	- Thực hiện các thao tác tạo biểu đồ đơn giản.
2. Kỹ năng.
	- Thực hiện được thao tác tạo các dạng biểu đồ đơn giản.
3. Thái độ.
	- Hình thành thái độ ham mê học hỏi, yêu thích môn học.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
	- Giáo án, phòng máy,…
2. Chuẩn bị của học sinh.
	- Chuẩn bị trước nội dung của bài thực hành.
III. Tiến trình dạy học.
1. Ổn đinh tổ chức.
2. Kiểm tra bài cũ.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1 



Yêu cầu học sinh:
- Chọn trang tính học sinh giỏi
- Thực hành theo hướng dẫn
- GV quan sát sửa sai cho học sinh.
	c. Tạo biểu đồ cột cho bảng dữ liệu số HSG khối 7
    - Thay đổ biểu đồ cột thành biểu đồ hình tròn=> Nhận xét kết quả
d. Điều chỉnh để có trang tính như H 117=>tạo biểu đồ như H118

[image: ]

e. Tạo biểu đồ hình tròn cho bảng dữ liệu
   - Đổi biểu đồ hình tròn thành biểu đồ đường gấp khúc
   - Đổi biểu đồ đường gấp khúc thành biểu đồ cột
   - Lưu trang tính  ổ D:\HSG Khoi7+Lớp


	Hoạt động 2 
Yêu cầu học sinh
+ Thực hành theo hướng dẫn
+ GV quan sát sửa sai cho học sinh
	Bài tập 3. Xử lí dữ liệu và tạo biểu đồ
+ Mở bảng tính D:\BTH6
+ Chọn trang tính Bang diem
a.  Tính điểm TB cho từng môn học của cả lớp vào hàng cuối cùng của danh sách dl
b. Tạo biểu đồ cột minh hoạ điểm TB các môn học của cả lớp
c. Sao chép biểu đồ vào văn bản Word
+ Lưu tệp
+ Kết thúc Excel
+ Tắt máy tính


4. Củng cố.
     - Giáo viên hướng dẫn học sinh thực hành, sửa sai (nếu có).
5. Hướng dẫn học sinh học ở nhà.
     - Yêu cầu về nhà xem lại nội dung của bài thực hành.
     - Xem trước bài tập 3, để chuẩn bị tiết sau thực hành.
IV. Rút kinh nghiệm sau tiết dạy
…………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 















Ngày soạn: 28/5/2020
Ngày dạy:
Lớp 7a:.../6/2020
Lớp 7b: .../6/2020				
Tiết: 51
BÀI THỰC HÀNH TỔNG HỢP

I. Mục tiêu.
1. Kiến thức.
		- Củng cố lại cho HS cách chỉnh sửa, chèn thêm hàng, định dạng văn 
               bản, sắp xếp và lọc dữ liệu.
     - Củng cố cách tạo biểu đồ, trình bày trang in, sao chép vùng dữ liệu 
    và di chuyển biểu đồ.
2. Kỹ năng.
     - Thực hành thành thạo các thao tác.
3. Thái độ.
     - Hình thành thái độ học tập nghiêm túc, hăng say học hỏi.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
     - Giáo án, phòng máy, SGK tin quyển 2.
2. Chuẩn bị của học sinh.
     - SGK tin quyển 2, đồ dùng học tập.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
3. Bài mới.
	Hoạt động của giáo viên và học sinh
	Nội dung chính

	Hoạt động 1:   

- Yêu cầu HS thực hành theo yêu cầu



























- Quan sát, sửa sai, cho HS
	Bài tập 1. Lập trang tính, định dạng, sử dụng công thức và trình bày trang in

- Khởi động chương trình Excel
a1. Quan sát H119 SGK/92
a2. Nhập dữ liệu vào trang tính như H119
b1. Quan sát H120 SGK/92
b2. Nhập dữ liệu vào cột Số lượng như H120
b3. Điều chỉnh hàng, cột, sau đó định dạng trang tính như H120
c1. Quan sát H121 SGK/93
c2. Thực hiện sao chép và chỉnh sửa số liệu, định dạng để có trang tính như H121
d1. Lập công thức để tính cột Số lượng trong bảng Tổng cộng

e1. Thực hiện xem trước khi in (nhấn nút lệnh )
e2. Đóng chế độ xem trước khi in trở về chế độ bình thường
e3. Lưu tệp D:\BTH10+lop (Vd BTH10 lop7a)
e4. Đóng tệp (Vào File\Close)

	Hoạt động 2:  


 HS thực hành







GV: Quan sát, sửa sai, cho HS


	Bài tập 2. Lập trang tính, định dạng, sử dụng công thức hoặc hàm để thực hiện các tính toán, sắp xếp và lọc dữ liệu.

a1. Mở một tệp mới (Nhấn nút  hoặc vào File\New)
a2. Quan sát H122 SGK/94
a3. Lập trang tính như H122
a4. Lưu trang tính với tên D:\Thong ke + lop
Lập công thức hoặc sử dụng hàm để tính 
b1.Tổng cộng thu nhập bình quân cho xã An Bình tại cột Tổng cộng, sau đó sao chép công thức xuống các xã còn lại
b2.  Thu nhập trung bình theo từng ngành của cả vùng tại dòng Trung bình chung.
b3. Tổng thu nhập trung bình của cả vùng
c1. Quan sát H123
c2. Chỉnh sửa, chèn thêm các hàng, định dạng trang tính như H123
Sắp xếp các xã theo
d1. Tên xã tăng dần
d2. Nụng nghiệp giảm dần
d3. Công nghiệp giảm dần
d4. Tổng cộng tăng dần
d5. Thực hiện đưa trang tính về như ban đầu


Bài tập 2: Lập trang tính, định dạng, sử dụng công thức hoặc hàm để 			thực hiện các tính toán. (36 phút)
* Yêu cầu: - HS Lập được trang tính như hình 122 SGK trang 94
		- Sử dụng công thức hoặc hàm thích hợp để tính toán: tổng cộng, trung 
		bình chung của từng ngành, của cả vùng… và thực hiện sao chép công 
		thức để tính.
[image: ]










 	1. Tính tổng cộng: C1: Sử dụng công thức. tại ô G4 gõ  =C5+D5+E5+F5  		sao chép công thức cho các ô còn lại bằng cách đưa chuột vào góc dưới 
	bên phải ô G4 sao cho chuột có dấu (+) màu đen → di chuyển chuột để sao 		chép.
	C2:  Sử dụng hàm để tính toán: =Sum(C4:F4)
	2. Tính trung bình chung cho từng ngành: 
	Tại ô C12: =Average(C4:C11), sao chép công thức cho các ô D12, E12, 
        F12, G12
	3. Tính trung bình chung  cho cả vùng: =Average(C4:F11)
	4. Chỉnh sửa trang tính để được như hình 123:
	- Kẻ đường biên, tô màu nền.
		B1: Chọn vùng dữ liệu từ A1 đến G12
		B2: Format → Cells → Border
		B3: Thiết lập thông số
    		+ Chọn đường nét ở Style
    		+ Chọn màu khung ở Color
		B4: OK
	5. Trộn ô:
 		- Chọn vùng dữ liệu từ ô A1 	đến G1 → nháy chọn nút lệnh 	[image: ] 		Merge and Center
	6. Tô màu nền:
- Chọn khối ô từ A3 đến G3 → Nháy chọn nút lệnh Fill Color → chọn màu
	7. Chỉnh sửa văn bản:
- Để có được trang tính như hình 123
[image: ]














4. Củng cố.
       - Nhập dữ liệu, điều chỉnh hàng cột. sao chép dữ liệu
       - Định dạng trang tính, xem trước khi in
5. Hướng dẫn học sinh học ở nhà.
     - Yêu cầu về nhà xem lại toàn bộ nội dung bài thực hành.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
Kiểm tra, ngày ... tháng .... năm 201..
		Tổ chuyên môn
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THỰC HÀNH TỔNG HỢP

I. Mục tiêu.
1. Kiến thức.
- Ôn lại kiến thức đã học để thực hiện tính toán: Tính tổng, tính trung 
bình cộng.
- Chỉnh sửa định dạng trang tính.
2. Kỹ năng.
- Sử dụng công thức tính tổng, sử dụng hàm tính trung bình cộng.
- Thực hiện các thao tác để định dạng trang tính.
3. Thái độ.
- Có thái độ nghiêm túc trong học tập.
II. Chuẩn bị của giáo viên và học sinh.
1.  Chuẩn bị của giáo viên.
- Giáo án, SGK tin học 2, máy tính,...
2.  Chuẩn bị của học sinh.
- Chuẩn bị trước nội dung thực hành ở nhà.
III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ. 
Câu 1: Em hãy viết công thức tính tổng, hàm tính trung bình cộng?
Câu 2: Em hãy thực hiện thao tác tô màu nền của trang tính?
3. Bài mới.
		HS thực hành theo nội dung của “Bài thực hành 10” bài 2 SGK trang 93, 		94.
		Bài tập 2: Sắp xếp và lọc dữ liệu.
		1. Sắp xếp dữ liệu: 
  	 	* Tên xã theo vần A, B, c
			B1: Chỉnh để sắp xếp theo tiếng việt B. A. C.
    		B1.1: Tools → Options → Custom lists
    		B1.2: Thiết đặt
		* List entries: nhập chữ cái tiếng việt theo bảng chữ cái tiếng việt.
		* Ví dụ: A,a, à, ạ, á, o, ô, …
     		B1.3: Chọn nút lệnh  Add – OK
		B2: Nháy chọn cột B
[image: ]
	










	B3: Data → Srot → option → chọn cách sắp xếp vừa gõ
		B4: Chọn lệnh [image: ] Ascending
	* Sắp xếp thu nhập bình quân về nông nghiệp, công nghiệp, tổng thu nhập         
       với 	thứ tự giảm dần. Nháy chuột vào một ô của cột C, D, G → nháy 
       chọn nút lệnh 	[image: ] Descending
	
2. Lọc dữ liệu: 
	 * Lọc ra ba số liệu thu nhập bình quân về nông nghiệp cao nhất.
		B1: Tạo chế độ lọc. Data → Filter → AutoFilter
		B2: Nháy chọn nút     ở tiêu đề cột nông nghiệp → chọn Top 10 → chọn 		Top → chọn 3 → OK
		B3: Copy vùng dữ liệu vừa lọc sang Sheet 2
		B4: Quay về bảng nguồn Nháy chọn nút     ở tiêu đề cột nông nghiệp → 		chọn All
	* Lọc ra ba số liệu thu nhập bình quân về thương mại thấp nhất.
		B1: Nháy chọn nút     ở tiêu đề cột thương mại → chọn Top 10 → chọn 		Bottop → chọn 3 → OK
		B3: Copy vùng dữ liệu vừa lọc sang Sheet 2
		B4: Quay về bảng nguồn Nháy chọn nút  ở tiêu đề cột thương mại → 
         chọn 		All
	* Thoát khỏi chế độ lọc.
	 	Data → Filter → huỷ dấu tích trước 		AutoFilter

	Bài tập 3: Tạo biểu đồ và trình bày trang in. (26 phút)
		HS thực hành theo nội dung của bài tập 3 SGK trang 95 (Tạo biểu đồ 	
    	như hình 124) 
		B1: Chọn hai khối dữ liệu (B4:B11) và (G4:G11)
		B2: Nháy chọn nút lệnh [image: ] Chart Wizard → chọn kiểu biểu đồ → Next → 			thêm thông tin cho biểu đồ → chọn Finish
* GV:  - Hướng dẫn HS thực hành →  sửa sai (nếu có)
    - Nhận xét ưu khuyết trong quá trình thực hành của HS.
[image: ]









4. Củng cố.
- Hướng dẫn HS thực hành, sửa sai nếu có.
- Nhận xét ưu khuyết điểm của HS trong tiết thực hành.
5. Hướng dẫn học sinh học ở nhà. 
- Yêu cầu về nhà xem tiếp phần d, e và làm bài tập 3 để tiết sau thực  
hành.
IV. Rút kinh nghiệm sau tiết dạy.
.................................................................................................................................................................................................................................................................................................................................................................................
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KIỂM TRA THỰC HÀNH

I. Mục tiêu.
1. Kiến thức.
- Kiểm tra việc nắm bắt kiến thức thực hành của học sinh về trình bày, định dạng, sử dụng công thức tính toán, vẽ biểu dồ, sắp xếp và lọc dữ liệu.
2. Kỹ năng.
- Có kĩ năng tư duy, vận dụng kiến thức vào bài kiểm tra.
3. Thái độ.
- Hình thành thái độ học tập nghiêm túc, trung thực khi làm bài. 
II. Chuẩn bị của giáo viên và học sinh.
1.  Chuẩn bị của giáo viên.
- Giáo án, SGK tin học 2, máy tính, đề kiểm tra, ...
2.  Chuẩn bị của học sinh.
- Chuẩn bị trước nội dung thực hành ở nhà.
  III. Tiến trình dạy học.
1. Ổn định tổ chức.
2. Kiểm tra bài cũ.
3. Bài mới.
Quan sát trang tính sau

* Yêu cầu:
	1. Tạo trang tính như hình trên
	2. Lưu trang tính với tên +lop (Vd tên lop 7a)
3. Điều chỉnh hàng cột, định dạng trang tính để được trang tính như hình trên
4. Chèn thêm cột Tháng 4,  nhập doanh số bán của Tháng 4 bằng Tháng 2
5. Lập công thức hoặc sử dụng hàm để tính
 				+ Cột Tổng theo người bán
				+ Hàng Tổng theo tháng
6. Sắp xếp cột Tổng theo người bán tăng dần
7. Vẽ biểu đồ cột minh hoạ Tổng doanh số bán hàng của từng người bán hàng với 
+ Tiêu đề biểu đồ: Tổng doanh số bán hàng của từng người 
bán


				Lưu tệp
4. Củng cố.
- Nhận xét tiết kiểm tra.
5. Hướng dẫn học sinh học ở nhà.
- Về nhà ôn lại kiến thức đã học từ bài 6 đến bài 9 để tiết sau ôn 
tập.
IV. Rút kinh nghiệm sau tiết dạy.
.....................................................................................................................................................................................................................................................................................................................................................................					 Kiểm tra, ngày .... tháng 04 năm 201...
							             Tổ chuyên môn
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         ÔN TẬP HỌC KÌ II

I. Mục tiêu.
	1. Kiến thức.
	- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang 
	tính.
	- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh họa 
	dữ liệu.
	2. Kỹ năng.
	- Hình thành kỹ năng tư duy tổng hợp, thành thạo các thao tác.
	3. Thái độ.
	- Hình thành thái độ học tập nghiêm túc, hăng hái phát biểu ý kiến 
	xây dựng bài.
II. Chuẩn bị của giáo viên và học sinh.
1. Chuẩn bị của giáo viên.
- Giáo án, SGK tin học 2, máy tính,..
2. Chuẩn bị của học sinh.
- Ôn lại toàn bộ kiến thức phần lý thuyết trong học kì II.
III Tiến trình dạy học.
	1. Ổn định tổ chức.
	2. Kiểm tra bài cũ.
	3. Bài mới.	
	Hoạt động của giáo viên và học sinh
	Nội dung

	Hoạt động 1
?Để thay đổi phông chữ ta làm như thế nào?


?Để thay đổi cỡ chữ ta làm như thế nào?


?Để thay đổi kiểu chữ ta làm như thế nào?

?Nêu cách chọn màu cho phông?


? Cách căn lề trong ô tính?


?Để tăng, giảm số chữ số thập phân ta làm như thế nào?


?Trình bày cách tô màu nền và kẻ đường biên trong trang tính.

	1. Định dạng trang tính
a) Thay đổi phông chữ
-  Đánh dấu ô.
-  Nháy mũi tên ở ô Font và chọn phông thích hợp.
b) Thay đổi cỡ chữ
-  Đánh dấu ô.
-  Nháy mũi tên ở ô cỡ chữ và chọn cỡ thích hợp.
c) Thay đổi kiểu chữ
-  Đánh dấu ô.
-   Nháy vào B, I, U
d) Chọn màu phông
-  Đánh dấu ô.
-  Nháy mũi tên ở nút chữ A
e) Căn lề trong ô tính
- Đánh dấu ô.
- Nháy chọn các nút lệnh căn lề.
f) Tăng, giảm số chữ số thập phân
- Nháy chọn ô.
- Sử dụng hai nút lệnh tăng, giảm chữ số thập phân.
g) Tô màu nền và kẻ đường biên.
 Tô màu nền.
- Nháy chọn ô.
- Sử dụng nút lệnh Fill Color.
Kẻ đường biên
- Chọn ô.
- Sử dụng nút Border.	

	Hoạt động 2
? Trình bày cách đặt lề hướng giấy in.


 Để in trang tính ta làm như thế nào?

	2. Trình bày và in trang tính
- Đặt lề hướng giấy in
File -> Page Setup. XHHT, lựa chọn hướng giấy và lề giấy -> Ok.
-  In trang tính
File -> Print.

	Hoạt động 3
? Trình bày cách sắp xếp dữ liệu trong trang tính?


? Để lọc dữ liệu trong trang tính ta làm như thế nào?


? Sau khi lọc để hiển thị lại dữ liệu ta làm như thế nào?
? Nêu cách thoát khỏi chế đọ lọc?
	3. Sắp xếp và lọc dữ liệu
a) Sắp xếp dữ liệu
-  Chọn ô trong cột cần sắp xếp.
-  Nháy nút lệnh sắp xếp tăng (hoặc giảm).
b) Lọc dữ liệu
- Chọn ô trong vùng cần lọc.
- Data -> Filter -> AutoFilter
Hiển thị lại dữ liệu
-  Data -> Filter -> Show All
Thoát khỏi chế độ lọc
-  Data -> Filter -> AutoFilter.

	Hoạt động 4
? Em hãy trình bày cách vẽ biểu đồ biểu diễn dữ liệu trên trang tính ?
	4. Trình bày dữ liệu bằng biểu đồ
-  Chọn ô trong vùng dữ liệu
-  Nháy nút Chart Wizard.
-  Nháy Next liên tiếp.
-  Nháy Finish khi Next mờ đi.

	Câu 1: Định dạng trang tính
* Chọn phông chữ tiếng việt





* Chọn  cỡ, kiểu, màu chữ.









Câu 2: Căn lề trong ô tính 







Câu 3:
 - Tăng hoặc giảm chữ số phần thập phân



- Định dạng [image: ]






Câu 4: 
- Tô màu nền và kẻ đường biên















Câu 5:  Giả sử ô A1=1,52; B1=2,61
* Định dạng  ô C1 là số nguyên. Nếu  ô C1 có công thức là =A1+B1 thì kết quả hiển thị sẽ như thế nào?
Câu 6: 
Trình bày và in trang tính













Câu 7:  Đặt lề và hướng trang in.




Câu 8: 
Nêu cách sắp xếp dữ liệu




Câu 9: 
* Tạo chế độ lọc





* Huỷ chế độ lọc

* Hiện lại bảng nguồn

Câu 10: 
Lọc ra 4 hàng có giá trị lớn nhất, nhỏ nhất




Câu 11: 
 Trình bày dữ liệu bằng biểu đồ







Câu 12: 
* Thay đổi dạng biểu đồ



* Xoá biểu đồ
	Câu 1: 
* Chọn phông tiếng việt.
B1: Chọn ô hoặc khối ô cần định dạng.
B2: Nháy chọn nút lệnh Font → Chọn phông tương ứng với bảng mã.
* Thay đổi cỡ chữ, kiểu, màu chữ.
B1: Chọn ô hoặc khối ô cần định dạng.
B2: - Nháy chọn nút lệnh 
    + Font  size → chọn cỡ chữ
    + B: Kiểu chữ đậm
    + I: Kiểu chữ nghiêng
    + U: Kiểu chữ gạch chân
    + Font color → Chọn màu chữ
Câu 2: 
B1: Chọn ô hoặc khối ô cần định dạng.
B2: Sử dụng các nút lệnh.
      - Left: Căn thẳng lề trái
      - Right: Căn thẳng lề phải
      - Center: Căn giữa
      - [image: ] (Merge and center): Trộn ô và căn dữ liệu vào giữa
Câu 3: 	
B1: Chọn ô hoặc khối ô cần định dạng.
B2: Sử dụng các nút lệnh.
     -  [image: ]  (Increase Decimal): Tăng chữ số phần thập phân
     -  [image: ]  (Decrease Decimal): Giảm chữ số phần thập phân
* Định dạng phần trăm ([image: ])
B1: Chọn ô hoặc khối ô cần định dạng.
B2: Nháy chọn nút lệnh [image: ]

Câu 4:  * Tô màu nền.
B1: Chọn ô hoặc khối ô cần tô màu..
B2:  Nháy chọn nút lệnh Fill color → Chọn màu 
* Kẻ đường biên.
B1: Chọn ô hoặc khối ô cần kẻ đường biên..
B2: C1)  Nháy chọn nút lệnh Border → Chọn All Border
       C2) Format → Chọn  Cells → Chọn Border
              - Chọn kiểu nét kẻ ở khung Style
              - Chọn màu ở Color
              - Nháy chọn Outline và Inside → OK
Câu 5: 


Kết quả 1,52+2,61= 4,13  Kết quả hiển thị ở ô C1= 4 vì ô C1 đã được định dang là số nguyên

Câu 6: 
* Xem trang tính trước khi in
Nháy chọn nút lệnh [image: ] Print Preview → xem
 *  Điều chỉnh ngắt trang.
Nháy phải chuột tại vị trí cần ngắt trang → Insert page Break
* Huỷ ngắt trang. Nháy phải chuột trong vùng dữ liệu → chọn Reset All page Break
* In: C1) Nháy chọn nút lệnh  [image: ] Print
         C2: File → Print → OK
Câu 7: 
B1: File → Page Setup 
B2: Thiết đặt 
      - Page: Hướng trang
      - Margins: Đặt lề trang 
B3: OK
Câu 8: 
B1: Nháy chuột vào một ô của cột cần sắp xếp dữ liệu
B2: Nháy chọn nút lệnh.  - [image: ] Sort Ascending: Tăng dần
  - [image: ] Sort Descending: Giảm dần
Câu 9: 
* Tạo chế độ lọc.
B1: Nháy chuột vào một ô trong vùng dữ liệu.
B2: Data → Filter →  Auto Filter
* Huỷ chế độ lọc.
Data → Filter → huỷ dấu tích trước Auto Filter
* Hiện lại bảng nguồn. Data → Filter → chọn Show All
Câu 10:   
B1: Tạo chế độ lọc
B2: Nháy chọn nút    ở tiêu đề cột  cần lọc → chọn Top 10
B3: - Chọn 4 và chọn Top (giá trị lớn nhất), Bottop (giá trị nhỏ nhất) → OK
Câu 11:  
B1: Tạo bảng dữ liệu
B2: Nháy chuột vào một ô trong vùng dữ liệu
B3: Nháy chọn nút lệnh [image: ] Chart wizard → chọn kiểu biểu đồ
B4: Chọn Next → thêm thông tin chú thích cho biểu đồ → chọn Next → chọn Finish
Câu 12: 
* Thay đối dạng biểu đồ
 Nháy chuột chọn biểu đồ cần thay đồi → Chart Type trên thanh công cụ Chart → chọn lại dạng biểu đồ
* Xoá biểu đồ. Nháy chọn biểu đồ cần xoá → gõ phím Delete.


	4. Củng cố.
		- Trả lời những phần HS còn chưa hiểu rõ.	
	5. Hướng dẫn về nhà.
		- Yêu cầu về nhà xem lại toàn bộ những câu hỏi trong SGK.
IV. Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………………………………………………………………………………………………………………………………………………………………………… 
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               KIỂM TRA HỌC KÌ II

I. Mục tiêu
1. Kiến thức.
	- Kiểm tra đánh  giá kiến thức học sinh trong học kì II.
2. Kỹ năng.
	- Kiếm tra đánh giá kiến thức học sinh trong học kì II.
3. Thái độ.
	- Học sinh có thái độ làm bài nghiêm  túc trong giờ kiểm tra.
II. Chuẩn bị của giáo viên và học sinh
1.  Chuẩn bị của giáo viên.
- Giáo án, đề kiểm tra học kì II.
      2.  Chuẩn bị của học sinh.
- Ôn lại toàn bộ kiến thức đã học trong học kì II.
III. Tiến trình dạy học
1. Ổn định lớp học.
2. Kiểm tra bài cũ.
3. Bài mới.
Ma trận đề.
	                         Möùc ñoä
Noäi dung
	Bieát
	Hieåu
	Vaän duïng
	TỔNG

	
	TN
	TL
	TN
	TL
	TN
	TL
	

	Bài 1. Chương trình bảng tính là gì?
	Câu 1
0.5đ
	
	
	
	
	
	1 câu
0.5đ

	Bài 4: Sử dụng hàm để tính toán.
	Câu 2,3
1đ
	
	
	
	
	
	2 câu
1đ

	Bài 5: Thao tác với bảng tính
	
	
	
	
	
	
	

	Bài 6. Định dạng trang tính
	Câu 7,8
1đ
	
	
	
	
	
	2 câu
1đ

	Bài 7. Trình bày và  in trang tính
	Câu 6,9
1đ
	
	
	
	
	
	2 Câu
1đ

	Bài 8. Sắp xếp và lọc dữ liệu.
	Câu 4,5,10
1.5đ
	
	
	Câu 12
3đ
	
	
	4 câu
4.5đ

	Bài 9. Trình bày dữ liệu bằng biểu đồ.
	
	
	
	Câu 11
2đ

	
	
	1 câu
2đ

	TỔNG
	10 câu
5đ
	
	
	2 câu
5đ
	
	
	12 câu
10đ



		ĐỀ KIỂM TRA HỌC KÌ II
Môn: Tin học 7
I. Trắc nghiệm (5,0 điểm) 
(Khoanh tròn đáp án đứng trước câu trả lời đúng)
Câu 1. Em có thể lưu bảng tính trên máy tính bằng cách sử dụng lệnh:
A. File -> Save.	B. File -> Open.	C. File -> Print.   D. File -> Close.
Câu 2. Để tính tổng trong các ô C1 và C2 sau đó chia cho giá trị trong ô B3. Công thức nào là đúng ?
A. =(C1-C2)/B3.	B. =C1-C2/B3. C.=(C1+C2)/B3.   D. =(C1+C2)*B3.
Câu 3. Giả sử cần tính trung bình cộng giá trị của các ô B1, C1 và E1. Công thức nào  sau đây đúng.
A. =SUM(B1,C1,E1)/3.	 		B. =(B1+C1+E1)/3.   		
C. =AVERAGE(B1,C1,E1).		D. Tất cả đúng.
  	  Câu 4.  Để vẽ biểu đồ ta dùng nút lệnh:
              A.   [image: ]              B.   [image: ]                   C.   [image: ]		   D.   [image: ]
Câu 5. Để lọc dữ liệu trong bảng tính, ta cần thực hiện mấy bước?
A. 1			B. 2			C. 3		D. 4
Câu 6. Để xem trước khi in ta sử dụng nút lệnh nào sau đây:
A. Print.	B. Break priview.	C. page setup.	D. page layout.
Câu 7. Nút lệnh nào trong các nút lệnh sau dùng để thay đổi phông chữ?
A. Nút lệnh [image: ].	 B. Nút lệnh [image: ].  C. Nút lệnh [image: ].  D. Nút lệnh  [image: ].
Câu 8. Để gộp nhiều ô thành một ô ta phải thực hiện như thế nào?
A. Chọn vào biểu tượng[image: ].	B. Chọn vào biểu tượng[image: ].
C. Chọn vào biểu tượng[image: ].	D. Chọn vào biểu tượng[image: ].
Câu 9. Những cách nào trong các cách sau đây dùng để in trang tính?
 	A.. Bấm tổ hợp phím (Ctrl + P).   		 B. Nháy chuột File -> Print.  		C. Nháy chuột File -> Exit. 		 D. Cả A và B.
Câu 10. Để sắp xếp danh sách dữ liệu giảm dần, em làm thế nào?
     	A. Nháy nút  [image: ]       B. Nháy nút  [image: ]      C. Nháy nút [image: ]      D. Nháy nút [image: ]
II. Tự luận (5,0 điểm)
Câu 11:  Em hãy kể tên các dạng biểu đồ thường dùng trong chương trình bảng tính Excel, nêu các bước để tạo biểu đồ trong chương trình bảng tính Excel ? (3 điểm)
Câu 12: Em hãy trình bày các bước để thực hiện thao tác sắp xếp dữ liệu ? (2 điểm)



ĐÁP ÁN – BIỂU ĐIỂM
Môn: Tin học 7
I. Trắc nghiệm
Câu 1 : a	Câu 2 : c	Câu 3 : d		Câu 4 : d	Câu 5 : b
Câu 6 : d	Câu 7 : a	Câu 8 : a		Câu 9 : d	Câu 10 : b
II. Tự luận
Câu 11 : Có 3 dạng biểu đồ thường dùng trong chương trình bảng tính Excel: Biểu đồ cột, biểu đồ đường gấp khúc, biểu đồ hình tròn.
· Các bước tạo biểu đồ gồm :
· Bước 1 : Chọn dữ liệu cần tạo biểu đồ.
· Bước 2 : Chọn lệnh Insert chọn lệnh Chart để chọn biểu đồ thích hợp để biểu diễn dữ liệu.
Câu 12 : - Các bước thực hiện sắp xếp dữ liệu trong chương trình bảng tính Excel :	- Bước 1 : Chọn 1 ô trong cột cần sắp xếp dữ liệu.
	          - Bước 2 : Chọn lệnh [image: ] để sắp xếp theo chiều tăng dần. Chọn lệnh [image: ] để sắp xếp theo chiều giảm dần.
4. Củng cố.
	- Giáo viên thu bài kiểm tra.
5. Hướng dẫn về nhà.
IV.  Rút kinh nghiệm sau tiết dạy.
……………………………………………………………………………
……………………………………………………………………………
……………………………………………………………………………
……………………………………………………………………….……
 Kiểm tra, ngày … tháng …. năm 2020
   	   Tổ chuyên môn
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